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END USER LICENSE AGREEMENT

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT. BY SELECTING THE “ACCEPT” OPTION OR COPYING,
DOWNLOADING, INSTALLING, ACCESSING, OR OTHERWISE USING THE SOFTWARE YOU ACCEPT AND AGREE TO
THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, RETURN
ALL MATERIALS TO THE PLACE OF PURCHASE FOR A FULL REFUND.

The enclosed Software (Program and its associated Documentation) is licensed by Canfield Scientific, Inc.
to customers for their use only in the terms set forth below.

1.License: Canfield Scientific, Inc. hereby agrees to grant the original purchaser (Licensee) a non-exclusive
license to use the enclosed Software subject to the terms and restrictions set forth in this License Agreement.

2. Title: Canfield Scientific, Inc. retains all rights, title, and interest in the enclosed Software.

3. Copyright: The Program and its Documentation are copyrighted by Canfield Scientific, Inc.. The Licensee
or other users may not copy or otherwise reproduce any part of the Program or its documentation, except
that the Program may be loaded into a computer as an essential step in executing the Program on the com-
puter and copies made solely for back-up or archival purposes.

4, Restrictions, Use, and Transfer:

(a) The original and any back-up copies of the Program and its Documentation are to be used only in con-
nection with a single computer.

(b) The Program may be physically transferred from one computer to another, provided that the Program
is used in connection with only one computer at a time. This license may be transferred to others together
with the original and all back-up copies of the Program and its Documentation, provided that the transferee
agrees to be bound by the terms of this License Agreement.

(¢) Neither the Program nor its Documentation may be modified or translated without written permission
from Canfield Scientific, Inc..

(d) The Program may not be used, copied, modified, adapted, transferred, or merged in whole—or in part—
into another program except as expressly provided for in the license.

(e) The Program may not be reverse engineered, disassembled, decompiled nor any attempts made to dis-
cover the source code of the Program.

(f) Neither the Program nor any portion of the Software or Documentation may be sub-licensed, rented,
leased, or loaned.

5. Exclusion of Warranty; Limitation Liability; Limited Media Warranty:

(a) The Program and its Documentation is provided “as is” without warranty of any kind, either expressed
or implied, including but not limited to the implied warranties of merchantability and fitness for a particu-
lar purpose. The entire risk as to the results and performance of the program is assumed by the Licensee.

(b) Neither Canfield Scientific, Inc. nor anyone else who has been involved in the creation, production,
or delivery of this Program and its Documentation shall be liable for any direct, indirect, consequential,
or incidental damages arising out of the use of or inability to use such products, even if Canfield has been
advised of the possibility of such damages or claim.

(c) Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or
consequential damages, so the above limitations or exclusions may not apply to the Licensee.

(d) Canfield Scientific, Inc. warrants the enclosed media (but not the Program contained thereon) to be
free of defects in materials and workmanship under normal use for 30 days after purchase. During the
30-day period you may return a defective media to an Authorized Canfield Scientific, Inc. Dealer and it will
be replaced without charge unless the media is damaged by accident or misuse. Replacement of the media
is the sole remedy in the event of a defect. This warranty gives the Licensee specific legal rights, and other
rights which may vary from state to state.

(e) No employee, agent, dealer or distributor of Canfield Scientific, Inc. is authorized to modify this limited
warranty, or to make any additional warranties.



6. Product Improvements: Canfield Scientific, Inc. reserves the right to make corrections or improvements
to the Program and its documentation and to the related media at any time without notice and with no
responsibility to provide these changes to purchasers of earlier versions of such products. All product
upgrades are covered under a separate Support and Upgrade Agreement.

7. Term and Termination: This license is effective upon your use of the software and remains effective
until terminated. The license may be terminated by destroying the Program and its Documentation and all
copies thereof. This license will also terminate if the Licensee fails to comply with any term or Agreement.
The Licensee agrees upon such termination to destroy all copies of the Program and its Documentation.

8. Confidentiality: The Software contains trade secrets and proprietary know-how that belongs to Canfield
Scientific, Inc. and it is being made available to you in strict confidence. Any use or disclosure of the software,
or of its algorithms, protocols, or interfaces, other than in strict accordance with this license agreement, may
be actionable as a violation of Canfield Scientific’s trade secret rights.

9. U.S. Government Restricted Rights: The Program and related Documentation is provided with Restricted
Rights. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subpara-
graphs (¢) (1) (ii) of the Rights In Technical Data and Computer Software clause at DFARS 252.227-7013 or
subparagraphs (¢)(1) and (2) of the Commercial Computer Software—Restricted Rights at 48 CFR 52.227-
19 as applicable. The software manufacturer is Canfield Scientific, Inc. located at 4 Wood Hollow Road,
Parsippany, NJ 07054 USA.

10. ExportRestriction: This Software is subject to U.S. exportjurisdiction and may not be shipped, transferred
or exported into any country or used in any manner prohibited by the United States Export Administration
Act or any other export laws, restrictions or regulations.

11. Governing Law: This license agreement is governed by the laws of the state of New Jersey.

Patent: http://www.canfieldsci.com/patents/

THIRD-PARTY LICENSES USE OF SOME THIRD PARTY MATERIALS AND SERVICES INCLUDED IN OR ACCESSED
THROUGH THE CANFIELD SOFTWARE MAY BE SUBJECT TO OTHER TERMS AND CONDITIONS TYPICALLY
FOUND IN A SEPARATE LICENSE AGREEMENT, TERMS OF USE OR “READ ME” FILE LOCATED WITHIN OR
NEAR SUCH MATERIALS AND SERVICES OR AT http://www.canfieldsci.com/end-user-license-agreements
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http://www.canfieldsci.com/end-user-license-agreements/

VECTRA LIMITED ONE-YEAR WARRANTY

Coverage:

A one-year warranty is provided by Canfield Scientific, Inc. (“Canfield”) on VECTRA 3D capture systems. (For
warranty information on the VECTRA software, please refer to the End User License Agreement in this user
guide.) During the one year period beginning on the date of shipment and/or software activation, whichever
occurs later, Canfield warrants that the VECTRA 3D capture system will be free from defects in material and
workmanship. If the customer discovers a defect, Canfield will, at its option, repair or replace the defective
component(s) at no charge to the customer, provided it is returned during the warranty period. The cost
of shipping the replacement parts both ways (less any applicable custom duties, taxes and any other costs
associated with exporting or importing goods) will be paid by Canfield for all warrantable repairs.

Canfield owns all parts removed from repaired products. If Canfield repairs or replaces a product, its
warranty term is not extended.

After the first year, VECTRA’s Warranty Service and Support can be extended by fee-based yearly service
agreements covering product hardware, technical support, and software upgrades.

State Law Rights:

Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation
of incidental or consequential damages, so the above exclusions or limitations may not apply to you. This
warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

Exclusions:

This Warranty does not cover customer training, instruction, installation, set up adjustments, or LAN-network-
related problems. (For warranty information on the VECTRA software, please refer to the End User License
Agreement in the VECTRA User Guide.)

This Warranty does not cover damage due to external causes, including accident, abuse, misuse, problems
with electrical power, servicing not authorized by Canfield, usage not in accordance with product instruc-
tions, failure to perform required preventive maintenance, and problems caused by use of parts and com-
ponents not supplied by Canfield.

This warranty does not cover computer systems, computer peripherals, or other equipment not manufac-
tured by Canfield. All such third-party equipment is covered by separate manufacturers’ warranties where
applicable.

This warranty is expressly made in lieu of all other warranties, expressed or implied, including without
limitation, warranties of merchantability and fitness for a particular purpose.

Our liability is limited to the repair or replacement, at our option, of any defective product and shall in no
event include incidental or consequential commercial or property damages of any kind.

To request warranty service:
Customers located in the United States, Canada or Mexico, please phone Canfield technical support at 1-800-
815-4330. Other international customers please call 1-973-434-1201.

The e-mail support address is techsupport@canfieldsci.com.

Should it be determined by Canfield technical support that a unit must be returned for service, a Return
Merchandise Authorization (RMA) number will be provided. This RMA number must be clearly marked on
the outside of all packaging. Information on packing and shipping will be included.

Shipping address: RMA # (to be provided by Canfield prior to shipment)
Canfield Scientific, Inc.
4 Wood Hollow Road
Parsippany, NJ 07054 USA
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EXTENDED CANFIELD CARE SERVICE AGREEMENT FOR VECTRA

One year of Canfield Care is included with your new VECTRA purchase. The initial
Canfield Care agreement provides a warranty on the VECTRA 3D capture system,
phone access to technical support!, and free software upgrades for one year from date
of delivery.

The most effective and efficient way to identify issues and upgrade software on your
system is via an internet connection. It is assumed that your VECTRA computer will be
connected to a land-based internet connection with the ability to connect to Canfield
Scientific, Inc. (“Canfield”) via the www. Should this not be the case, additional costs
may apply when providing support for your system.

Beyond this first year, Canfield Scientific, Inc. offers an extended Canfield Care service
agreement for an annual fee. This extended service agreement extends the warranty
for all VECTRA 3D capture system parts. All coverage and exclusion details for this
extended warranty are the same as those described in the VECTRA Limited One-Year
Warranty. In addition, the user continues to receive software upgrades and have phone
access to technical support! for the term of the Canfield Care Agreement.

All renewal fees must be remitted to Canfield (or an authorized distributor where
applicable) at least 30 days prior to the expiration date of the current VECTRA 3D
Capture Service Agreement (initial or extended). Once a Canfield Care Agreement has
expired, the hardware warranty may not be renewed; although system repair, technical
support, and upgrades may still be obtained with individual service charges as noted
below?-.

To enter into an Extended Canfield Care Service Agreement, please contact Canfield
by e-mail at support@canfieldsci.com or by phoning 1-800-815-4330 toll-free in the US,
Canada or Mexico (other international customers phone 1-973-434-1201).

'Note that for international customers (outside of the U.S. and Canada), technical support is provided locally
through an authorized distributor where available.

2Out-of-warranty repairs to the VECTRA 3D capture system: The customer will be charged a fixed diagnostic
fee of $350, plus any parts and labor required for repairs. The customer is responsible for prepaying all
transportation charges including insurance and any associated fees and any applicable custom duties and/
or export taxes. IMPORTANT: A Return Merchandise Authorization (RMA) number must be obtained from
Canfield prior to shipping any equipment.

3For customers without a current Agreement, technical support may be obtained at the rate in effect at the
time of service.

*All pricing subject to change without notice.
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SAFETY AND TECHNICAL INFORMATION

DESCRIPTION OF MARKS

C CAUTION and/or WARNING — Please consult ACCOMPANYING DOCUMENTS and read
carefully to ensure safe use of this equipment.

é DANGER/HIGH VOLTAGE — This symbol indicates “dangerous voltage” inside the product
that presents a risk of electric shock or personal injury.

ENVIRONMENTAL RESTRICTIONS

* Not suitable for use in WET LOCATIONS.

* Not suitable for use in the presence of a FLAMMABLE ANAESTHETIC MIXTURE WITH
OXYGEN or NITROUS OXIDE.

AUTHORIZED STANDARDS

This device complies with the following Standards:

Safety of Information Technology Equipment

F@ Federal Communications Commission (FCC)

Safety European Union

c E Conforms to Low Voltage Directive 2014/35/EU.

€‘"’ United States of America
‘ * Conforms to IEC Standard 62368-1.

Intertek
3107557

Canada
Certified to CSA Standard C22.2 #62368-1.

EMC Standard European Union: Conforms to EMC Directive 2014/30/EU.

VECTRA H2 User Guide I



Safety and Technical Information

United States of America:

FE

A

Canada

Federal Communications Commission (FCC): FCC 47CFR Part 15:2012 Subpart B Class
B. This device complies with FCC CFR 47 Part 15 sub part B. Operation is subject to
the following two conditions: 1) This device may not cause harmful interference, and
2) this device must accept any interference received, including interference that may
cause undesired operation.

WARNING: Changes or modifications to this unit not expressly approved by the party

responsible for compliance could void the user’s authority to operate the equipment.

This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.

Compliance with other EU directives Vectra H2 complies with the following European Union Directives

aimed at environmental protection as well as consumer health and safety.
« Directive 2002/96/EC on Waste Electrical and Electronic Equipment (WEEE Directive)

* Directive 2002/95/EC on the Restriction of the Use of Certain Hazardous Substances
(RoHS Directive)

« Directive on Packaging and Packaging Waste 94/62/EC

RECYCLING AND DISPOSAL INFORMATION

In accordance with these directives, all non-electronic components removed for
replacement, and any related packaging material should be disposed of following your
country’s or local area’s legislation for recycling.

Any electronic components or modules removed for replacement should be returned to
Canfield or its local agent, using the packaging material supplied with the replacement
component or module received.

Shipping address: Canfield Scientific, Inc., 4 Wood Hollow Road, Parsippany, NJ 07054 USA

SAFETY PRECAUTIONS

Do not make conversions and/or changes to Do not place food or liquid on the VECTRA
the equipment without express authorization imaging system. If the VECTRA system gets wet,
from the manufacturer. Unauthorized con- contact Canfield Technical Support.

versions and/or changes could jeopardize the
safety of the system and will void the warranty.

Using flammable substances near the unit’s
high-voltage areas may result in a fire or elec-

Operate the system only with original and/or trical shock.
manufacturer authorized parts. . .

p If smoke or excessive heat is detected, turn
Always ensure that this device and any relevant the equipment off, unplug the power cord
accessory equipment are placed on a dry, sta- and contact Technical Support. Do not resume

ble surface.

Keep cables free and clear from traffic areas to

use unless authorized by Canfield Technical
Support to do so.

prevent trip hazards.
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Overview of the VECTRA 3D Imaging System

1.1 VECTRA SYSTEM OVERVIEW

The VECTRA H2 system enables high quality 3D image
capture of small- to medium-field subjects. The 3D
images appear in the designated VECTRA® patient chart
and may be viewed and analyzed using the included
VECTRA Analysis Module (VAM) software and optional
Sculptor® software.

The H2 camera is shipped completely configured
and ready to use. If you purchased a computer
from Canfield, the Mirror and VECTRA software is
pre-installed. Otherwise, install Mirror, VECTRA and
Calibration software according to the instructions in
Appendix A.

Chapter 3: Preparing for Capture and Finishing 3D
Capture and Chapter 4: Capturing 3D Images with
VECTRA H?2 take you through the image capture
process for face, breast, or body. You can begin

using the system within a few minutes. If you should
encounter any problems, please contact our Technical
Support Department.

VECTRA H2 User Guide
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1.2 VECTRA H2 TECHNICAL SPECIFICATIONS & REQUIREMENTS

System components
Soft carrying case containing

- VECTRA H2 3D camera with stereo optics,
ranging lights for easy patient positioning, and
on-board modular, intelligent flash unit

- USB cable for connecting camera to computer
- 4 rechargeable batteries

- 2 battery chargers

- SD memory card

- camera strap

- quick reference cards

VECTRA H2 flash unit folds
down for safe transport

camera
strap

SD memory battery
card chargers

Custom H2 patient posing mat

Getting Started kit, including

- Mirror® and VECTRA application software, User
Guide, and Marketing Kit flash drive

- Calibration files flash drive

- USB hardware key (contains your VECTRA and
Mirror software licenses)
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Options

Face Sculptor® 3D aesthetic simulation software
with RBX® image processing

Facial Skin Analysis module
Body Sculptor® 3D aesthetic simulation software
Breast Sculptor® 3D aesthetic simulation software

laptop computer with pre-installed software

Specifications
0.9 mm geometry resolution (triangle edge length)
2.0 milliseconds capture time
Stereophotogrammetry technology

weight: 1.54 Kg (3.4 1bs.)

Power requirements

voltage: 7.2VDC 1A max
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The VECTRA Patient Chart

2.1 CREATING A NEW PATIENT CHART

1 Double-click the \J§ VECTRA icon on the Windows
desktop to open the software.

new patient on the VECTRA home screen,
or click the create new patient tab from the Look Up
Patient window.

look up patients look up images

Clear fields

{4 NOTE: To avoid creating a duplicate chart, start by
looking up the patient (see 2.2 Finding a Patient Chart).

create new patient look up patients ook up es 3 Clle 11’1 a ﬁeld to enter
patient information. Press
the “Tab” key to move

last name (required)

N T g } among fields. The more
o information you enter, the
| easier it will be to find

the patient next time.

£4 Once you click in the date of birth field, the field will
remain pink until a valid date is entered.

4 Click @ H2 capture in the upper right corner of the
screen to create the patient chart and take a picture

(see Chapter 3 and Chapter 4), or click open chart
to view the new patient chart.
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2.2 FINDING A PATIENT CHART

1 Double-click the \y VECTRA icon on the Windows
desktop to open the software.

04 1f VECTRA software is already open, click the VECTRA
logo in the upper left corner of the screen to return to
the patient chart, then click the VECTRA logo from the
chart to return to the home screen.

2 Click g4 look up patient on the VECTRA home
screen.

If you wish to hide names while displaying search
Y playing
results, select the patient privacy checkbox.

create new patient look up patients

first name

patient privacy

3 Enter search criteria such as the patient’s name, date
of birth, and/or ID number. Press the “Tab” key to move
among fields, or click in a field and type.

create new patient look up patients

patient ID

patient privacy show 4 matches (B

As you enter more information, show matches updates
to display the number of records found that match the
search criteria. Continue adding criteria if you wish to
show fewer matches.

£4 Leave all fields blank to view all records.
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4 Click ) show matches (or press the “Enter” key)
to display matching records.

£4 1f the correct chart is not found, click the
create new patient tab to create a new patient
chart (see 2.1 Creating a New Patient Chart).

look up patients

In this example, 4 records
with a first name starting st namo
with the letter “L” were

patient ID date of birth

located. The first record is ;
automatically selected
(indicated by white type

patient privacy hide 4 matches ([

on a blue background).

last name first name patient ID date t gender items
{ |
Moore Lara |
I Roberts Laura /8/1972 Female

e
=

Y4

Scortel Lupe Female

Vector Lamy Male

5 Click once on a row to select the patient.

17801972

To open the selected To take a picture of
chart, click & open chart the selected patient,
(or double-click a row or click H2 capture (see
press the “Enter” key). Chapter 3 and Chapter 4).
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2.3 FINDING IMAGES

To locate images that fit certain criteria:

1 Click the look up images tab from the Create New
Patient or Look Up Patient window:.

2 Enter desired search criteria.

3 Click the search button.

look up images

Clear fields

patient privacy

4 Click @) show matches to display matching images.

Matches may be further filtered to show only 2D,
only 3D, or all images.

\N=cta

To export images, click to select one or more
thumbnails, then click g export.
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2.4 USING THE PATIENT CHART

Top bar buttons

The buttons in the top bar are always available when a
patient chart is open:

sy import file to add an existing file (avi, bmp, doc,
docx, gif, jpg, jpeg, pdf, png, ppt, pptx, tif, tiff, tom,
txt, or wmv) to the patient chart

H2 capture to take a picture that will be
automatically added to the current chart

[5/p OPEN PATIENT DATA

open patient data click to toggle selecttogroup  quantity specify number of  quantity
sort by newest or images by of items columns displayed  of items
oldest items first capturedate inthechart (fewer columns=  selected

larger thumbnails)

Side bar buttons

The buttons in the side bar on the right of the patient
chart vary according to the type of item(s) selected.

If no thumbnail is selected, there are no buttons in the
side bar.

open in Sculptor to open a 3D image in the
appropriate Sculptor software

open in Analysis to open a 3D image in the
s VECTRA Analysis Module (VAM)

markerless tracking to automatically register
and track 3D face images (see 5.13 Reviewing
Previously Captured Images and Simulations)

,4' open in Comparison to compare two images in
5
Sculptor
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Thumbnails

unselected

ﬂ open to view a 2D image, movie, PowerPoint,
PDF, or other type of document

ﬂ process to finish processing a 3D capture

. stitch images to automatically stitch multiple
il Captures into one image

move to move or copy a file to a different chart

- print to print 2D image(s) directly from the chart

E export to make a file available outside of VECTRA

export to PowerPoint to export 2D image(s)
directly to a Microsoft PowerPoint presentation

extract 2D originals to extract 2-dimensional
BB images from the original 3D capture

delete to delete selected file(s)

LA upload to 3D printing to obtain a 3D model of
Ul an image from MirrorMe3D (see Appendix D)

» Click on a thumbnail to select it.
» Ctrl-click on a selected thumbnail to deselect it.

« Shift-click to select a range of thumbnails;
Ctrl-click to select discontiguous thumbnails.

« If a thumbnail is selected, its frame reverses
to light gray with dark type.

+ Image type is noted in the corners of the
thumbnail. For example, (] in the upper left

and 3D in the lower left denotes a 3D image.
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Viewing and editing patient data

To open the patient data drawer, click
B orPeN PATIENT DATA.

Patient information that was entered in the New Patient
fields is displayed in the top bar.

Click in a field to add or change information.

To close the patient data drawer and apply changes,
click 48l cLoSE PATIENT DATA.

Changing the profile picture

Each patient’s profile picture is displayed in the
Look Up Patient search results.* The first captured or
imported image is the default “profile picture”.

*NOTE: Profile pictures may be displayed or hidden in the
Look Up Patient search results.

To change the show/hide profile pictures setting:

il set up in the lower right corner of the
VECTRA home screen, then click the Database tab.

2 Check or uncheck show profile picture in the
/o prfie pee lower left corner or the dialog.
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1 To change the profile
picture, open the patient
data drawer [El".

2 Click to select the
desired thumbnail in
the patient chart.

3 Click use selected for
profile picture to replace
the current picture with
the selected thumbnail.

£4 Individual images and files may be deleted from a
patient chart by selecting the image(s) and clicking
delete in the bar on the right side of the screen.

1 To permanently remove a patient and all of the
associated data and images from your VECTRA
database, open the patient data drawer [El".

2 Click delete patient.
3 Click Yes in the confirmation dialog to permanently

remove the patient and all associated data and images.

A Delete patient cannot be undone.

VECTRA H2 User Guide



2.5 PRINTING AND EXPORTING 2D IMAGES

Printing 2D images directly from the patient chart

1 Click to select the image(s) you wish to print.
Shift-click to select multiple thumbnails, or Ctrl-click to
select multiple discontiguous thumbnails.

\=cta

2 Click g print. (The print button is only available if a
2D image is selected.)

close print screen

page orientation:
landscape (horizontal)
portrait (vertical)

number of columns
number of rows
duplicate images per page

increase or decrease size
of the on-screen preview

reset preview size to fit screen

step through multiple
document pages

header & footer See Adding or editing the header and/or

footer in next section.

3 Select desired layout parameters, then click g5 print
(to print) or M save (to save as a PDF).
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Adding or editing the header and/or footer
1 Click J, header & footer.

2 Click in the Header or Footer field to select.

/ /
\J Header & Footer Editor X
Header Font D.0.B.
First Name
' / |

Gender

Last Name
MRM
Footer Font
|4

oo\ e ]

« Type desired information directly, or add a patient
identifier by double-clicking its name in the list.

* You may combine direct entry, such as “Date of
Birth:” with a patient identifier, such as “%D.0O.B.%".

+ Click Font to change type style and/or size.

7} Header & Footer Editor x

Header Font D.0.B.
First Name
Gender
Last Name
MRM

[ 24First Name % %uLast Name . N\

3 Click OK to apply.

The print preview displays the entered and/or selected
information in the header and/or footer.
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Exporting images to a PowerPoint presentation from the patient chart

1 Click to select the image(s) you wish to include.
Shift-click to select multiple thumbnails, or Ctrl-click to
select multiple discontiguous thumbnails.

2 Click export to PowerPoint. (The export to
PowerPoint button is only available if a 2D image is
selected.)

close export screen

save presentation
number of columns
number of rows”|

increase or decrease size
of the on-screen preview

reset preview size to fit screen

step through multiple
document pages

header & footer See Adding or editing the header and/or

footer in previous section.

3 Select desired layout parameters, then click B save.
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2.6 VIEWING A PAIR OF IMAGES IN COMPARISON MODE

1 Click to select an image to compare. Ctrl-click to
select a second image.

2 Click g compare to display the images full screen,
side by side. The first image selected appears on the left.

The g4 Lock Images button in the lower right corner
controls whether pan/zoom actions affect only one
image or both.

Click g Close to close the images and return to the
patient chart.
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Preparing for Capture and Finishing 3D Capture

3D images may be captured directly into the patient chart with the VECTRA H2
camera tethered to the computer (section 3.1), or saved to an SD card during
capture for later transfer to the computer (sections 3.2 and 3.3).

3.1 PREPARING FOR TETHERED CAPTURE

Start the VECTRA system and software
1 Turn on the computer.

2 Double-click the {J) VECTRA icon on the Windows
desktop to open the software.

3 Connect the VECTRA H2 camera to the computer
with the supplied USB cable.

4 Rotate the power switch
(top of the camera) to ON.

5 The mode dial should
be set to M when the
camera is on.

The first time you use VECTRA software, check to
make sure H2 is selected as the capture system:

1 Click the g setup button in the lower right
corner of the VECTRA home screen.

— 2 Select the Capture tab and make sure

<

~ VECTRA H2 is displayed in the drop-down menu.

-3 Click close.
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Find or Create a Patient Chart (see Chapter 2 for more details)

First determine whether a VECTRA chart exists for this patient.

1 Click @ look up patient on the VECTRA home
screen.

2 Enter search criteria such as the patient’s name, date
of birth, and/or ID number.

3 Click &) show matches (or press the “Enter” key)

to display matching records.

4 Click @ H2 capture. i
(If more than one matching
record is displayed, first click

to select the correct patient,
then click [@ H2 capture.)

L4 1f the correct chart is not found, click the
create new patient tab to create a new patient chart.
Creating a new VECTRA patient chart

1 Click [ new patient on the VECTRA home screen,
or click the create new patient tab from the Look Up
Patient window.

2 Enter patient information.

3 Click @ H2 capture.

If the [ H2 capture button is not available
(upper right corner of the screen), make sure:

* the H2 camera is turned on

 a patient chart has been selected

 the USB cable is firmly connected to
both the computer and the H2 camera

« VECTRA H2 is selected as the capture system in [ setup (see previous page).
If g H2 capture is still unavailable, turn the H2 camera off, then on.

If @ H2 capture is still unavailable, restart the VECTRA software and try again.
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Using VECTRA capture software

The [BJ H2 capture
button opens the VECTRA
capture screen with a live
preview in the middle and
positioning guides on the
left.

Select the appropriate tab:
3D FACE CAPTURE,

3D BREAST CAPTURE
(180° breast image),

360 BREAST CAPTURE
(5-capture 360° breast
image), 360 TORSO CAPTURE (4-capture 360° torso),
or GENERAL 3D CAPTURE. The positioning guides
correspond to the selected capture type.

To display live preview on the camera’s LCD screen,
press the @) live view button to the right of the
viewfinder.

84 The camera will automatically suspend operation
after about a minute of inactivity. Press e again to
resume.

Continue to Chapter 4 Capturing 3D Images with H2.
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3.2 PREPARING FOR CAPTURE TO SD CARD

1 Make sure the SD card

is properly inserted into its
slot on the VECTRA H2
camera. The angled corner
should be on the top lead
edge of the SD card, as
illustrated on the door.

3 Make sure the settings
displayed on the back of
the camera are as follows: M - 1200« F10 200

M (manual mode)

1/200 (shutter speed)
ISO 200
RAW (image file format)

4 press the &) live view button to the right of the
viewfinder.

84 The camera will automatically suspend operation
after about a minute of inactivity. Press @ again to
resume.

Continue to Chapter 4 Capturing 3D Images with H2.
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3.3 TRANSFERRING IMAGES FROM SD CARD TO VECTRA PATIENT CHART

Retrieve images

1 After the desired H2 images have been captured and
reviewed (see Reviewing images immediately after
capture in Chapter 4), rotate the power switch on the
top of the camera to OFF.

2 Remove the SD card from the camera: Open the cover
and press on the edge of the SD card until it pops up.

3 Insert the SD card into the appropriate slot on the
computer or connected card reader.

Open a patient chart (sece Chapier 2 for more details)
1 Turn on the computer.
2 Double-click the {J§ VECTRA icon on the Windows
desktop to open the software.

First determine whether a VECTRA chart exists for this
patient:

1 Click 4 look up patient on the VECTRA home

2 Enter search criteria such as the patient’s name, date
of birth, and/or ID number.

3 Click {g) show matches (or press the “Enter” key)
to display matching records.

4 Click i} open chart (or double-click a row or press
the “Enter” key) to open the selected chart.

L4 1f the correct chart is not found, click the
create new patient tab to create a new patient chart.
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Chapter 3

Preparing for Capture and Finishing 3D Capture

Creating a new VECTRA patient chart:
1 Click [ new patient on the VECTRA home screen.
2 Enter patient information.

3 Click i open chart.

Import images

1 Click @@ import file.

2 Navigate to the CR2 files on the SD card (Removable
Disk).

3 Click on the first file to select, then hold down the
shift key and click on the last file so that all captures are
selected.

Removble Disk ) » DCIM s 3CANON

TMG_ODAT.CR?

TMG_ODAG.CR?

TMG_OD45.CR?

4 Click Open. The CR2 files are imported into the open
VECTRA patient chart and the software processes the
images.
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Chapter 3 Preparing for Capture and Finishing 3D Capture

processing in

\=ctra progress

processing
complete

3.4 STITCHING MULTIPLE CAPTURES INTO A SINGLE 3D IMAGE

Tethered capture

After the last image is captured, VECTRA software
automatically processes the images and stitches them
together into a single 3D image. The individual captures
are displayed while they are being processed.

£4 1f you wish to interrupt the processing and retake
the images (if, for example, the subject blinked or was
in the wrong position) click [ discard & retake in the
upper right corner of the screen.

The completed image is displayed in its corresponding
Sculptor software.

VECTRA H2 User Guide



Chapter 3 Preparing for Capture and Finishing 3D Capture

SD card capture

1 Select captures for stitching: Click on the first
thumbnail to select it, then Ctrl-click to select the other
thumbnails in order. (See Chapter 2 for more about
using the VECTRA patient chart.)

& The thumbnails must be selected in the correct order:

1 2 3
=3F= =Yl =
=0 . A
L.A

(Only 1, 2, and 3 for 180° breast capture.)
\=ckra

VECTRA patient chart with
3 Face captures selected.
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Chapter 3 Preparing for Capture and Finishing 3D Capture

2 Click [ stitch images. VECTRA software
automatically stitches the captures into a single 3D
image. The individual captures are displayed while they
are being stitched.

The completed image is displayed in its corresponding
Sculptor software.

If auto-stitch fails

If VECTRA software

is unable to locate the
required features, it will
display an error message
over the captured images.

Click OK in the error
message.

First check to see whether
all three images are in

the correct order. If not,
click and drag to move the
images into the correct
order: right front, straight on front (Face and Breast
only), left front, and, for 360° Breast or Body captures,
left rear, then right rear view.

If the order is correct, check to see whether the poses
are correct, eyes are open and mouth is closed for all
three face images, for example. If not, click g§ cancel
stitch in the upper right corner of the screen and
recapture the images.
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Chapter 3 Preparing for Capture and Finishing 3D Capture

Placing manual landmarks

If images appear to be properly captured, click OK in
the error message to manually identify the landmarks.

1 The location for the first landmark is displayed in
the icon below the first image. Position the tip of the
cursor arrow over the appropriate anatomical location
in the first image as shown, and click once to place the
landmark.

* Aseach location is clicked, the icon updates to
highlight the next landmark to be placed.

» FEach of the 3 captures requires its own set of
landmarks.

2 Repeat until each of the requested landmarks has
been placed.

{4 1f you wish to change the position of a landmark,
position the tip of the cursor arrow over it. The
cursor changes to an Q“'D open hand when it’s close
enough to the landmark. Click and drag (the cursor
changes to a §™ grabbing hand). Release the mouse
button when the landmark is in the correct position.

3 When you are satisfied with the manual landmarks,
click [ retry stitch. VECTRA software completes the
automatic stitching process and displays the completed
image in its corresponding Sculptor software.
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Capturing 3D Images with VECTRA H2

4.1 GENERAL GUIDELINES FOR CAPTURING 3D IMAGES

Consistent patient positioning is the most important aspect of capturing medical
images. Follow consistent methods to ensure consistent patient positioning.

Capture the images in the specified order.

For follow-up images: Review the baseline image before initiating image capture
to ensure consistent patient positioning.

For tethered capture: Make sure the correct tab is selected in VECTRA software.

Reviewing images immediately after capture
while the patient is present for retakes, if necessary

For tethered capture

After the last image is
captured, the individual
images are displayed on
screen while they are
being processed.

If an image needs to be
retaken, click [ discard
& retake in the upper

right corner of the screen.

For SD card capture

1 Press [» ] to display the SD card
images on the camera’s LCD screen.

2 Press &Iy to view the previous
image or AF to view the next image.
display images on LCD screen

If an image needs to be retaken (if, for example, the
subject blinked or was in the wrong position, or the
image is dark because a flash didn’t fire), retake the
whole session to ensure consistent patient positioning.
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Chapter 4 Capturing 3D Images with VECTRA H2

Patient preparation: instruct the patient to
1 Remove all jewelry and clothing near the area of interest
2 Remove oils, sweat, or anything shiny from the skin
3 Remove all make-up for facial imaging
4 Secure hair away from the face, ears and neck.

4.2 USING THE VECTRA H2 CAMERA

1 Turn on the camera and ranging lights by rotating the
power switch (top of the camera) to ON.

The ranging lights will sleep after about 1 minute of
inactivity. Press the shutter release halfway to wake.

2 The VECTRA H2 ranging lights are designed to assure
accurate focus and camera distance.

Optimal distance is different for the face

and other parts of the body, so there are °

two sets of ranging lights: red lights for Q
face capture and green lights for body or

breast capture. }

Slide the Face/Body switch on the

side of the lens assembly to select the
appropriate ranging lights for the capture
type: up for Face capture, down
for Breast or Body capture.

)

£4 The green light above the Face icon indicates that
the ranging lights are on, not that Face is selected.

3 When the ranging lights are converged and the
target area is centered in the left side of the split screen
preview, press the shutter release to capture the image.

£4 The ranging lights blink on and off while the flashes
are recharging. When the ranging lights stop
blinking the camera is ready for the next picture.
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4.3 FACE CAPTURE

o {4 slide the Face/Body ranging lights switch up.
{4 For tethered capture make sure the tab

T is selected in VECTRA software.

{4 Have the patient stand on the positioning mat with feet
ﬂ covering the red marks.
A

{4 The patient should remain completely still throughout
the 3 face captures; the photographer moves.

{4 The patient’s eyes should be open, gaze fixed straight ahead,
not looking up or down, mouth closed, relaxed facial expression.

£4 For the right and left views of the face, the camera should be angled
upward toward the patient’s head to optimize chin and neck detail.

THE PATIENT SHOULD REMAIN COMPLETELY STILL THROUGHOUT THE 3 FACE CAPTURES

Face capture 1: RIGHT side

Position camera at a 45° angle from the front
toward the RIGHT side of the face.

1 Stand at 45 degrees from the direction the patient is
facing (photographer moves left of patient).

2 Hold the camera

at patient’s chest
level, about 12 inches
(30cm) below
mid-face, and
angled upward.

3 Aim thered dots at
the middle of the patient’s cheek

(intersection of imaginary lines from
the lateral canthus and the upper lip).

4 Converge the red dots to a single point by adjusting
camera distance from the patient.

5 Capture image.
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THE PATIENT SHOULD REMAIN COMPLETELY STILL THROUGHOUT THE 3 FACE CAPTURES

Face capture 2: FRONT

Position camera directly in FRONT of the face.
1 Stand directly in front of the patient.

2 Raise the camera to level with the patient’s face.
Ensure the camera is straight, not angled.

3 Keeping the camera level, aim the red dots
between the upper lip and nose, at the mid-line
of the patient’s face.

4 Converge the red dots to a single point by adjusting
camera distance from the patient.

5 Capture image.
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Capturing 3D Images with VECTRA H2

THE PATIENT SHOULD REMAIN COMPLETELY STILL THROUGHOUT THE 3 FACE CAPTURES

Face capture 3: LEFT side

Position camera at a 45° angle from the front
toward the LEFT side of the face.

1 Stand at 45 degrees from the direction the patient
is facing (photographer moves right of patient).

2 Hold the camera at patient’s chest level, about 12
inches (30cm) below mid-face, and angled upward.

3 Aim the red dots at the middle of the patient’s cheek
(intersection of imaginary lines from the lateral canthus
and the upper lip).

4 Converge the red dots to a single point by adjusting
camera distance from the patient.

5 Capture image.

If using tethered capture, continue to 3.4 Stitching
Multiple Captures into a Single 3D Image.

If using an SD card, continue to 3.3 Transferring
Images from SD Card to VECTRA Patient Chart and
then proceed with 3.4 Stitching Multiple Captures into
a Single 3D Image.
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4.4 GENERAL GUIDELINES FOR UPPER OR LOWER TORSO 3D IMAGES

° £4 slide the Face/Body ranging lights switch down.
{4 Explain proper positioning to the patient:

l * straight body posture

A o feet parallel and

}/\\ shoulder width apart

* insides of feet aligned
on the outside of the
gray octagon on the
patient positioning
mat, covering the
appropriate pair of
color bars for the pose.

L4 Photographer will instruct the patient which direction
to turn and which colors to stand on for each view.

{4 Patient should maintain consistent posture, same
distance between feet, and consistent arm position
for all captures.

m Just prior to capture, have the
patient hold arms straight out
to the sides, at a 45° angle
from the body with
palms facing down.

{4 Photographer
remains stationary
with the camera
aligned on
the center line of the
patient positioning mat.
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4.5 BREAST CAPTURE

Breast images may show the front and sides of the upper torso with three captures,
or include two rear view images for a complete 360° 3D image. All five views are
covered in this section. Stop after the first three for a 180° breast capture.

{4 For tethered capture make sure the ELNAITMIRGNINUAS tab (3-capture 180°

breast image) or the E{LATNZRE AL LT tab (5-capture 360° breast image) is
selected in VECTRA software.

Breast capture 1: RIGHT side of front

1 Instruct the patient to stand with feet covering the
GREEN bars on the mat, insides of feet aligned on the
outside of the octagon.

2 Hold the camera level with the top of the patient’s
hip, then angle the camera upward toward the bottom
of the right breast.

3 Aim the green dots at the middle of the patient’s
inframammary fold (the lowest point of the right breast

° \O/ where it meets the chest wall).
\l/ 4 Converge the green dots to a single point by

adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.
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Breast capture 2: direct FRONT view

1 Instruct the patient to turn clockwise, facing the
camera, and stand with feet covering the RED bars on
the mat, insides of feet aligned on the outside of the
octagon.

2 Hold the camera level with the patient’s nose, then
angle the camera down toward the center of the chest.

3 Aim the green dots between the breasts in the middle
of the chest.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.
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Breast capture 3: LEFT side of front

1 Instruct the patient to turn clockwise and stand with
feet covering the BLUE bars on the mat, insides of feet
aligned on the outside of the octagon.

2 Hold the camera level with the top of the patient’s
hip, then angle the camera upward toward the bottom
of the left breast.

3 Aim the green dots at the middle of the patient’s
inframammary fold (the lowest point of the left breast

adjusting camera distance from the patient.

Q/ \:/ where it meets the chest wall).
4 Converge the green dots to a single point by

5 Instruct the patient to gently exhale and hold,
then capture the image.

Continue to Breast capture 4 for remaining 360° views.

The three front views needed for 180° breast image are complete.

If using tethered capture, continue to 3.4 Stitching Multiple
Captures into a Single 3D Image.

If using an SD card, continue to 3.3 Transferring Images from
SD Card to VECTRA Patient Chart and then proceed with
3.4 Stitching Multiple Captures into a Single 3D Image.
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Breast capture 4: LEFT side of back

1 Instruct the patient to turn clockwise and stand with
feet covering the GREEN bars on the mat, facing away
from the camera, insides of feet aligned on the outside
of the octagon.

2 Hold the camera level with the patient’s waist, then
angle the camera upward slightly.

3 Aim the green dots at the left side of the back, a few
inches above the patient’s waist.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.
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Capturing 3D Images with VECTRA H2

Breast capture 5: RIGHT side of back

1 Instruct the patient to turn clockwise and stand with
feet covering the BLUE bars on the mat, facing away
from the camera, insides of feet aligned on the outside
of the octagon.

2 Hold the camera level with the patient’s waist, then
angle the camera upward slightly.

3 Aim the green dots at the right side of the back, a few
inches above the patient’s waist.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.

If using tethered capture, continue to 3.4 Stitching
Multiple Captures into a Single 3D Image.

If using an SD card, continue to 3.3 Transferring
Images from SD Card to VECTRA Patient Chart and
then proceed with 3.4 Stitching Multiple Captures into
a Single 3D Image.
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4.6 BODY CAPTURE (LOWER TORSO)

{4 For tethered capture make sure the EILBMELHHINILIHT tab is selected in
VECTRA software.

Body capture 1: RIGHT side of front

1 Instruct the patient to stand with feet covering the
GREEN bars on the mat, insides of feet aligned on the
outside of the octagon.

2 Hold the camera level with the patient’s hip.

~— 3 Aim the green dots at the right front iliac crest (top
of hip bone), closer to the side than the center of the
patient’s body.

¢ 4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.
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Capturing 3D Images with VECTRA H2

Body capture 2: LEFT side of front

1 Instruct the patient to stand with feet covering the
BLUE bars on the mat, insides of feet aligned on the
outside of the octagon.

2 Hold the camera level with the patient’s hip.

3 Aim the green dots at the left front iliac crest (top
of hip bone), closer to the side than the center of the
patient’s body.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.

VECTRA H2 User Guide TN



Chapter 4

Capturing 3D Images with VECTRA H2

Body capture 3: LEFT side of back

1 Instruct the patient to turn clockwise and stand with
feet covering the GREEN bars on the mat, facing away
from the camera, insides of feet aligned on the outside
of the octagon.

2 Hold the camera level with the patient’s hip.

3 Aim the green dots at the top of hip bone, closer to
the side than the center of the patient’s body.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.
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Capturing 3D Images with VECTRA H2

Body capture 4: RIGHT side of back

1 Instruct the patient to turn clockwise and stand with
feet covering the BLUE bars on the mat, facing away
from the camera, insides of feet aligned on the outside
of the octagon.

2 Hold the camera level with the patient’s hip.

3 Aim the green dots at the top of hip bone, closer to
the side than the center of the patient’s body.

4 Converge the green dots to a single point by
adjusting camera distance from the patient.

5 Instruct the patient to gently exhale and hold,
then capture the image.

If using tethered capture, continue to 3.4 Stitching
Multiple Captures into a Single 3D Image.

If using an SD card, continue to 3.3 Transferring
Images from SD Card to VECTRA Patient Chart and
then proceed with 3.4 Stitching Multiple Captures into
a Single 3D Image.
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CHAPTER 5
Face Sculptor®

5.1 GETTING STARTED

Face Sculptor 3D aesthetic simulation software

assists the surgeon during consultations enabling
prospective patients to visualize the possibilities of
their anticipated facial aesthetic procedures. This
software module provides tools to assess the patient’s
face and enables the user to quickly make realistic
surface and three-dimensional changes to the facial
features of the patient’s own 3D image. The results can
then be reviewed with the patient to ensure mutually
understood expectations between the surgeon and the
patient. The pre-op and post-simulated images can also
be used as references during surgery.

Open a 3D image in Face Sculptor

A newly captured 3D image of your patient’s face is
automatically displayed in Face Sculptor software after
processing is complete (see Chapter 3: Preparing for
Capture and Finishing 3D Capture).

To open a previously captured image, open the patient
chart and double-click a 3D face image (see Chapter 2:
The VECTRA Patient Chart).
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Chapter 5 Face Sculptor

Face Sculptor overview
To get started, select the Rhinoplasty, Chin Augmentation,
or Contouring module by clicking the corresponding
tab at the top of the screen. You may select a different
module by clicking its tab at any time.

e &Y Ly ) RHINOPLASTY  CHIN AUGMENTATION ~ CONTOURING  SKIN ANALYSIS PRINT UPLOAD

FACE sculptor

undo redo
view in VECTRA adjust viewpoint buttons
Analysis Module 20| @O keyboard shortcuts
preferences FACE sculptor in brackets []
save 2D image [z] zoom
save 3D [r] roll
an

exit to VECTRA L . .

Patient Chart [yl spin on Y-axis

[s] spin

To automatically rotate an image
to a preset viewpoint, click one of
the rotate-to-view buttons.

Click one of the navigation buttons
on the left side of the screen to
select what you wish to do next.

To see the image(s) from any viewpoint at any
magnification, select one of the adjust viewpoint buttons

CEEEENGIES . hen click within the image and drag.

* Change the magnification by rotating the scroll wheel
on your mouse.

* Temporarily change to the Spin tool by holding
down the Alt key on the keyboard.

* Press Ctrl-Z on your keyboard to undo the most
recent action.

* Right-click in a viewport to open the rotate-to-view
button set.

m See Appendix E: Sculptor Software Tips for more
keyboard and mouse shortcuts.
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5.2 TRIM IMAGE

If you wish to remove unwanted parts of the image,
click the ja§f trim image navigation button on the left
side of the screen.

ﬁ o ron e The box crop tool enables you to draw a
25 select |

rectangular boundary box, adjust it, and delete
everything outside of the box.

o
. select by points

* The [gg select by lasso tool enables you to circle
B iovert sotection unwanted parts of the image and delete them.

+ The [ select by points tool enables you to define
the area you wish to keep by clicking multiple points
on the image, then delete the unwanted areas leaving
a clean, smooth perimeter.

e Click @] invert selection to reverse what is and
is not selected.

* Click to clear your selection without applying
or to undo crop.

* Click to apply the cropping or delete the
selected area.

* To remove all cropping/trimming, click reset.

Using the Select By Points tool
1 Click [ select by points.

2 Place the W} cursor over the edge of the area you wish
to preserve, then click to place a point.

3 Continue to place points in a clockwise order around
the perimeter of the area you wish to preserve.

{4 To temporarily enable the Spin tool, hold down the
Alt key on the keyboard while you rotate the image.

4 Right-click the mouse after placing the last point.
The area outside of the perimeter is painted green.
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ks e 48 - ‘-:/"' :
5 Click delete to remove the highlighted area.

Using the Box Crop tool
1 Click [ box crop.

2 Click and drag out a rectangle to define the area you
wish to keep. The boundary box you have drawn is
projected onto the three-dimensional surface.

£4 To adjust the size or position of the boundary box, click
an edge or corner of the box and drag to the desired
location.

3 Click crop (or right-click the mouse) to delete
everything outside of the box. If you wish to cancel this
operation, you may click [i{Silj cancel.

Using the Select By Lasso tool
1 Click (g select by lasso.

2 Place the %p cursor over the edge of an area you wish
to define, then click and drag around its perimeter.

3 Click delete (or right-click) to remove the
highlighted area.

L To delete everything outside of the highlighted area,
first click @] invert selection, then click delete.

You may click [i§Siif deselect if you wish to start over.
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53 ASSESSMENT

Click the P&l assessment navigation button on the
left side of the screen to access the Face Sculptor
assessments that are relevant for the current module
(Rhinoplasty [Rh], Chin Augmentation [Ch], or
Contouring [Co]).

To display another assessment, click its name on the left
side of the screen.

£4 To view assessments for a different module, click its tab
at the top of the screen, then click the &l assessment
navigation button.

Symmetry [Rh, Ch, Co] helps to visualize asymmetries
in the face.

The first viewport shows two right sides:
The right side of the face is flipped and
joined to the normal right side.

The center viewport shows the normal face.

The third viewport shows two left sides: The
left side of the face is flipped and joined to
the normal left side.

Reflection [Rh, Ch, Co] displays the view one sees in
the mirror: The image is flipped (reflected) to further
help visualize asymmetry.

Oblique [Co] displays three viewing perspectives of the
same image: right oblique, front, and left oblique.
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Horizontal proportions [Rh, Ch] displays both
straight-line distance measurements and proportions

o (%) for the lower segment of the face (menton to

subnasale) and the middle segment of the face
(subnasale to radix).

Vertical proportions [Rh] displays both straight-line
distance measurements and proportions (%) for the
right and left segments of the face (lateral to medial
canthi) and the middle segment of the face (right to left
medial canthi). The alar width (right alar rim to left alar
rim) is also measured and compared.

Tip projection [Rh] displays the ratio of the tip
projection divided by the dorsal length. Tip projection
is measured by drawing a perpendicular line to the
nasal tip from a second line drawn from the radix to the
alar rim. The dorsal length is measured from the nasal
tip to the radix.

Columella-labial angle [Rh] displays the angle
formed by lines drawn from the labrale superius to the
subnasale and the subnasale to the columellar point.

Nasofrontal angle [Rh] displays the angle formed by
lines drawn from the nasal tip to the radix and the radix
to the glabella.

Nasofacial angle [Rh, Ch] displays the angle formed
by lines drawn from the pogonion to the glabella and
the nasal tip to the radix.
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Nasomental angle [Rh, Ch] displays the angle formed
by lines drawn from the pogonion to the nasal tip and
the nasal tip to the radix. The horizontal distances from
the labrale superius and inferius to the line drawn from
the pogonion to the nasal tip is also provided.

Facial angle [Rh, Ch] displays the angle formed by
lines drawn from the glabella to the subnasale and the
subnasale to the pogonion.

Tip deviation [Rh] displays the angle formed by the
facial midline to the line drawn from the radix to the
nasal tip. The horizontal distance from the nasal tip to
the midline is also provided.

Dorsal height [Rh] displays the maximum point of
projection from the line drawn from the nasal tip to the
radix.

Color [Rh, Ch, Co] displays normal skin tone and
texture.

Gray [Co] removes the distraction of complexion
details for superior visualization of facial contours.
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Click Brown Spots [Co] for enhanced visualization of
pigmentation.

Click Red Areas [Co] for enhanced visualization of
vascularity.

Red | Brown [Co] shows Red Areas and
Brown Spots side by side. To view the
image(s) in an alternative lighting mode
click . Click again to toggle off.

Notes

To record your notes and recommendations, click
in the marker palette (upper right corner of screen).

Type in the box, then click OK. Content that you enter
in the notes box will appear on notes-enabled versions
of the printed report (see 5.711 Printing Reports).

[’ Notes are not saved to the patient chart. If you wish
to save your notes, save a notes-enabled report as a
PDF: Click the Print tab at the top of the screen,
select desired template(s), and click & save PDF.
The PDF with notes is saved to the patient chart.
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5.4

MODELING FACIAL CONTOURING OUTCOMES

Click the Contouring tab at the top of the screen,
then make sure the [ contouring navigation button
on the left side of the screen is selected (blue).

Sculptor’s facial
contouring
module opens
with its array ofé
tools displayed .
on the left side of
the screen.

Toolspecific options appear only when the relevant tool
is selected.:

The brush size selector is displayed when
@ resurface, @ clone, & wrinkle or

When @@ fill, @ lipo, or

@ smooth is selected (blue)
and a region of the face has
been circled, the slider bar is
displayed.

Help text for the current tool
appears at the bottom of the
screen.
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Alternate view modes

Click one of the shading mode buttons CHIEED
(located at the top of the screen) to view the image
with alternate shading modes.

a Natural photo mode (the default view). The
image retains all of its photographic detail for a
pleasing visual representation. Use to show skin
resurfacing procedures.

ﬂ Dynamic photo mode. The image is skin colored,
but with reduced detail. This helps to show
shape and anatomical features under raked
lighting.

Shape (gray) mode. This solid colored image
helps to visualize shape and volume changes
without the distraction of skin tones.

N=ctra

Click the 2-viewports
button in the navigation
sidebar to see two
independent views of
the same image.

To automatically rotate the image on the left to a
preset viewpoint, click on the left side of one of the
rotate-to-view buttons.

Click on the right side of
one of the rotate-to-view
buttons to automatically
rotate the image on the right to a preset viewpoint.
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About the brush tools

The cursor changes to & A when you mouse over the
viewport and is surrounded by a translucent round
shape when it’s over the image. The translucent
shape indicates the area affected by the tool.

Brushing over a region twice doubles the effect.

Selecting a different brush size does not affect the
changes you have already made.

It's okay to stop and start again.

Using the Resurface tool

The Resurface tool smooths the skin’s texture and
is ideal for showing the effects of skin resurfacing
procedures such as fractional laser and IPL treatments.

1 Click @ Resurface.
2 Optional: Select 2 QN ERERD brush size.

3 Click and drag over the region to be treated.

Using the Clone tool

With the Clone tool, you can select the desired skin
appearance and apply it to areas that you wish to
change, such as brown spots, blemishes and tattoos.

1 Click @ Clone.
2 Optional: Select 2 (QYRGE®D brush size.

oz 3 Click the /# eyedropper cursor in the section
@, of skin you wish to replicate.
| N4 Click and drag where you wish to apply
! the selected sample. The characteristics of the
\(\ sampled skin are copied to the brushed area in a
context-sensitive manner.

L4 To select a different source, click @ Clone again and
then click the # eyedropper cursor in the desired area.
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Using the Wrinkle tool

The Wrinkle tool is used for removing or softening
wrinkles and demonstrating the results of procedures
such as toxin and dermatfiller injections.

1 Click & Wrinkle.

2 Optional: Select 2 (G ERERD brush size.

3 Click the £ eyedropper cursor in the section of skin
you wish to replicate.

4 Click and drag over the region to be treated. The
texture of the sampled skin is copied to the brushed
area.

Using the Sculpt tool

The Sculpt tool is ideal for changing the shape of small,
irregular-shaped regions of the face, such as pre-jowls
and nasolabial folds.

maximum g 1 Click a section of the (NERENESEY Sculpt button to

U LCEU N EIEE  sclcct volume increase, decrease, or smooth and degree
decrease Increase
of change.

moderate | moderate

volume volume 2 Optional: Select 2 QYD brush size.

decrease increase

p et it e EER 3 Click and drag or use a series of clicks over the region
i to be treated. The color of the translucent round shape
indicates your tool selection: red for decrease, green for
increase, and yellow for smoothing.
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Using the Warp tool

The versatile free hand Warp tool can be used for shape
adjustments to almost any part of the face.

1 Orient the image(s) so that the area you wish to warp
is visible. Usually frontal view is best, but lateral view is

better for defining some warp areas, such as the bridge

of the nose.

2 Click @ Warp.

3 Place the cursor (--) over the image, then click
and drag to define the region to be adjusted. Release
the mouse button when you are satisfied with the
boundary.

4 Position the cursor near the part that you wish to
warp (the cursor changes to an f{m) open hand), then
click and drag in the desired direction (the cursor
changes to a §™ grabbing hand). Release the mouse
button when you are satisfied with the adjustment.

L4 For a stronger effect, click inside the defined area and
drag. For a more subtle effect, click outside the defined
area and drag.
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Using the Fill, Lipo, and Smooth tools

The Fill, Lipo, and Smooth tools are ideal for reshaping
larger regions of the face, such as cheeks, or regions
that are not easy to correct using the Warp tool, such as
nasolabial folds.

1 Orient the image(s) so that the area you wish to treat
is visible for circling (for example, oblique view for the
cheeks).

2 Click @ Fill to add volume, @ Lipo to remove
volume, or @ Smooth to flatten unwanted contours.

3 Place the cursor (--) over the image, then click and
drag to define the region to be adjusted. Release the
mouse button when you are :

satisfied with the boundary.

4 Position the cursor within
the circled region; the cursor
changes to an arrow (»).
Click once to automatically
apply a calculated adjustment.
The change in volume added/
removed is displayed below
the slider bar.

£ 1f you wish to change
the amount of adjustment,
click and drag the bubble
in the slider bar. To reset,
click the triangle near the
base of the slider bar.

N=ctra
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5.5 MODELING RHINOPLASTY OR CHIN AUGMENTATION OUTCOMES

With the patient’s image open in Face Sculptor, click the

Rhinoplasty or Chin Augmentation tab at the top of
ﬂthe screen.

RHINOPLASTY CHIN AUGMENTATION CONTOURING PRINT

Auto landmarking

Face Sculptor software automatically identifies and
places the landmarks needed for modeling outcomes
in the selected module. The identified landmarks are
displayed as green dots for review and adjustment, if
needed. The landmark adjustment tool is selected.

Adjusting landmarks (optional)

1 Position the tip of the cursor arrow over a landmark.

The cursor changes to an Qm) open hand when it’s close
enough to the landmark.

- 2 Click and drag (the cursor changes to a ™ grabbing
«—hand). Release the mouse button when the landmark is
in the correct position.

If you make a mistake, click (@] undo to move the
landmark to its previous position.
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04 1n some cases the anatomy may be more distinct in
Shape (gray) mode. To see the image in Shape mode,
click B (located at the top of the screen). To see the
image in Natural photo mode (with normal skin color),

click a

—

Rotating the image to inspect landmarks

* To automatically rotate an image to a preset viewpoint,
click one of the rotate-to-view buttons on the left side
of the screen.

* To see the image from any viewpoint at any
magnification, select one of the adjust viewpoint
buttons at the top of the screen,
then click within the image and drag. Click the
landmark adjustment button to resume moving
landmarks.

» With the adjustment tool selected, press and hold
the Alt key (on your keyboard) to temporarily switch
to Spin, then click within the image and drag
to rotate. Release the Alt key to resume using the
adjustment tool.

Resetting auto landmarks

To delete all of the previously set landmarks and have
Face Sculptor software automatically identify and place
landmarks, click [Eal auto landmarks on the left side
of the screen.
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Placing user-identified landmarks (optional)

1 Click [ delete landmarks (on the left side of the
screen) if you wish to delete all of the previously set
landmarks and have the software guide you through
each landmark location with instructions (words and
picture) on the left side of the screen.

G O

sculptor

\=ctra

A green dot'shows that
the landmark is placed.

Updated instructions
show the next
location to place a
landmark.

2 Position the tip of the cursor arrow over the
appropriate anatomical location as described on the left
side of the screen. Click once to place the landmark. As
each location is clicked, the image rotates automatically
to facilitate placement of the next landmark.

3 Repeat until each of the requested landmarks has
been placed. When the final landmark has been placed,
the image automatically rotates to frontal view.

4 Review landmark placement. If you wish to change
the position of a landmark, see Adjusting Landmarks
(previous pages).
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Adjusting the horizontal plane

1 Click g8 alignment (on the left side of the screen) if
you wish to adjust a face image to the horizontal plane.
A grid is displayed to guide the adjustment.

sculptor

\=cka

2 Position the @l cursor over the image, then click and
drag clockwise or counter-clockwise to align the image
to the horizontal or vertical grid lines.

3 Once set, click auto landmarks to reset the
landmarks to the corrected alignment.
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Adjustment tools for rhinoplasty and chin augmentation

Click the :_ rhinoplasty ¥ chin augmentation
navigation button on the left side of the screen to
access the appropriate actions (tools) for the selected
procedure.

The caption below the tool palette identifies the
currently selected tool.

The diagram next to the slider bar illustrates the
function of the currently selected tool.

dorsal height

Help text for the current tool appears at the bottom
of the screen.

Click the show
diagram check box
to display the
assessment diagram.

When you hover over an
unselected button in the
palette, the caption and

diagram update to show
the function of that tool.

Click on a button
to select the action
described. tip width

Tools that have been
applied are highlighted
with a blue box.
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Overview of constrained adjustment tools for rhinoplasty

Move the slider up to add or increase; move the slider down to subtract or decrease.

Skt s
(s 3| Q)

dorsal height radix height nasal spine

DA% L || e P
T PR

I (s $[.0) BRI

columella-labial angle dorsal width upper cartilage width

.. . ﬁ& Ab Lodbe

S | R | SR

alar width nasal wall columella length alar rim height

Overview of constrained adjustment tools for chin augmentation

Move the slider up to add or increase; move the slider down to subtract or decrease.

chin width

chin projection chin length

Using constrained adjusting tools

Constrained, single adjusting tools are for bidirectional
adjustment to a single aspect of the face, such as the
sults bridge of the nose or the tip of the chin.

rhinoplasty

1 (Optional) Click the two viewports button to see two
views of the 3D image as you’re working on it.
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2 Click an adjusting tool in the palette, for example,
“dorsal height”. The caption, diagram and help text
update to reflect the currently selected tool. The image
in the left viewport automatically rotates to the optimal
orientation for monitoring the selected adjustment.

{4 1f you wish, you may change the orientation
and/or magnification in one or both viewports
(see Face Sculptor overview).

3 Position the cursor on the bubble at the center of the
slider bar. Click and drag the slider up or down to make
the adjustment.

5 rhinoplasty TN 5 rhinoplasty

. 4 o
o) view results gon @ view results

| > b |

iR - - J % > iR -

= e e | >

PIFEID) 2 sl 5| @)

L4 Move the slider up to add or increase; move the slider
down to subtract or decrease. q

£4 1f you wish to reset a particular
adjustment, click the small triangle
to the right of the slider bar.

4 Click to select additional tools as needed.
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Using unconstrained adjusting tools

The profile warp tool is for fine
tuning, or non-standard
adjustment.

{4 Recommended: Use the
constrained tools first.

profile line

1 Click the profile line tool.
The image in the left viewport
automatically rotates to profile
view and a green line outlines the
nose and upper lip (rhinoplasty)
or the chin and neck (chin
augmentation).

2 Mark the outermost boundaries
of the area you wish to warp:

Position the cursor over the green line at the
uppermost point of the area to be warped. (The
green line brightens when the cursor is over it.)

Click once to place a marker (a blue dot which turns
yellow when you release the mouse button).

Position the cursor over the green line at the
lowermost point of the area to be warped. Click once
to place a marker.

3 Position the cursor at
roughly the midpoint
between the two edge
markers. Click and drag
the green line to move
the edge of the face to the
desired point.

Repeat steps 2 and 3 to make additional adjustments,
if necessary.

{4 To remove a marker, right-click on it.
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The free hand warp tool can be used for shape
adjustments to almost any part of the face. Unlike the
profile warp tool, a profile view is not required for free
hand warp.

1 Orient the image(s) so that the
area you wish to warp is visible.

2 Click the free hand warp tool.

3 Place the cm—l—) over the image, then click
and drag to define the region to be adjusted. Release
the mouse button when you are satisfied with the
boundary.

4 Position the cursor near the part that you wish to
warp (the cursor changes to an 4™ open hand), then
click and drag in the desired direction (the cursor
changes to a §™ grabbing hand). Release the mouse
button when you are satisfied with the adjustment.

L4 For a stronger effect, click inside the defined area
and drag. For a more subtle effect, click outside the
defined area and drag.

VIEWING THE SIMULATED OUTCOME

Click the [ view results navigation button on the left
side of the screen to review the simulated outcome in
various view modes.

* The initial viewing option displays a side-by-side
comparison of the pre-op image (on the left) and
the simulated outcome (on the right.) To view in 3
viewports click |JllilJ[§. Click |fiiJl} to return to two.

e To change the image in one of the viewports, click its
“w________name in the bottom bar and select the desired image
from the pop-up menu.

To return to this side-by-side view at any time,
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{4 To quickly toggle
between the original
image and the simulated
outcome, click the

e toggle button to the
right of the slider, or
click @) to auto-animate
the morph.

A scale along the left edge
of the viewport shows
the amount of change

associated with each color.

Chapter 5 Face Sculptor

* To display a single image with a slider for morphing

between pre-op and simulated outcome, click @

Drag the slider bubble to display the original image,
the simulated outcome, or any point in between:

Click @ to view the

pre-op image overlaid
with a semi-transparent
simulated outcome.
Click e to toggle
between showing the
pre-op or simulated
image opaque.

Click @ to generate a color-coded view of the
volume differences between the original image and
the simulated image. Gray represents unchanged
areas, blue represents the greatest increased volume,
and yellow represents the greatest decreased volume
in the simulated image. Intermediate values are
represented by corresponding intermediate colors.

Click and hover the
cursor over modified
areas to display the
volume difference
between the pre-op
image and the simulated
outcome.
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Click e texture to show
normal skin tone and
texture; click again to
toggle off.

Click . contours
to reveal contour lines;
click again to toggle off.

.‘m%

* To automatically rotate an image to a preset viewpoint,
click one of the rotate-to-view buttons on the left side
of the screen.

* To see the image from any viewpoint at any
magnification, select one of the adjust viewpoint
buttons at the top of the screen,
then click within the image and drag.

* To toggle automatic rotation on or off click at the
top of the screen.

5.7 USING MARKERS AND ADDING NOTES

Sculptor’s color markers enable you draw colored lines
on the 3D image, useful for communicating with your
patient or adding treatment planning notes for future
reference. The marker palette is displayed in the upper
right corner of the screen.

1 Click a marker button ( ) to

select its color (pink, red, purple, blue, green, or black).
The button becomes highlighted ( [[ll]) and the cursor
changes to the selected color marker ().

2 Position the cursor over the desired start point for the
line, click and drag to draw a line on the surface of the
3D image, then release the mouse button.

* To draw with a different color, select one of the other
marker buttons.

 To erase the most recent stroke, click (g] undo or
press Ctrl-Z on your keyboard.
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* To clear all recently drawn marker lines at once, click
& (1o toggle visibility, click @ then @)

A Erase all mark-ups before applying Sculptor’s
texture tools (resurface, clone or wrinkle).

The marked up image may be saved as a 3D or 2D
image and/or printed or saved in a Sculptor report.

To record your notes and recommendations, click
in the marker palette (upper right corner of screen).

Type in the box, then click OK. Content that you enter
in the notes box will appear on notes-enabled versions
of the printed report (see 5.71 Printing Reports).

{74 Notes are only saved to the patient chart if you save
a notes-enabled report as a PDF.

5.8 CREATING A 3D ANIMATION

1 Click @ (bottom of the screen) to open Animator.

£%4 Click the Animator title bar and drag to reposition
the floating dialog box as needed.

2 Use adjust viewpoint buttons to

orient the image to the rotation and zoom desired for
the first frame of the animation.

3 Click & CAPTURE New Key Frame to save this view
as Key Frame 1.

animator

* A thumbnail of the key frame appears in the
CAPTURE CERraTE Animator dialog. If you wish to return the image to
new key frame T this orientation and zoom, click the thumbnail.

 Click the trash icon if you wish to delete this key
frame.

» Optional: Adjust the amount of time the animation
should pause at this key frame.
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4 Rotate and/or zoom the image to the next position,
and then click § CAPTURE New Key Frame to save
this view as Key Frame 2.

animator

B ¢ A second thumbnail appears in the Animator dialog.

animation

» Optional: Adjust the interval between key frames.

* Notice that the @ GENERATE animation button is
no longer disabled. A minimum of two key frames
must be specified to generate an animation.

Repeat step 4 until you have specified all the key frames
you wish to include in your animation. Animator will
automatically insert the in between frames (“tweens”)
to make smooth transitions between the key frames.

£4 1f you would like the animation to loop back to
Key Frame 1 at the end, click the first thumbnail,
then click ) CAPTURE New Key Frame.

Saving key frames (optional)

If you plan to reuse a particular sequence, click save
after you have specified all the key frames you wish

to include in the template. Click clear if you wish to
delete all of the key frames and start over. Click load to
automatically generate a saved sequence.

Changing the pixel dimensions (optional)

Pixel dimensions determine how large the animation
appears on screen during playback. Increasing the pixel
dimensions also increases the size of the file. Smaller file
sizes are recommended for web or e-mail.

To change the pixel dimensions, select a preset size
by clicking the radio button next to small, medium

Output Settings or large (see table on following page), or modify the
== width eSS~ values in the width and/or height fields.

medium

(B9

i i {4 When E link is selected, changing one dimension
will automatically change the other dimension

to maintain the aspect ratio. When i link is
unselected, the aspect ratio may be modified.
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Preset output pixel dimensions:

1 viewport 2 viewports*
small 180 x 240 pixels 360 x 240 pixels
Output Settings - " ;
f‘_”f'a'_' i s medium 360 x 480 pixels 720 x 480 pixels
[‘_‘:'::J"' B large 720 x 960 pixels 1440 x 960 pixels
cstom  Pesht s “The preset pixel width is doubled for 2 viewports.

frames eC, v loop

5 Select type of animation file to be generated: GIF or
MP4 video.

Changing the number of frames per second (optional)
To define the number of frames Animator will insert
for each second of playback, modify the value in the
frames per sec. field. More frames per second will
result in smoother transitions, but increase the file size.
* The recommended value for GIF is 8 to 10 FPS (more
than 12 is not recommended).
» The recommended value for video is 24 FPS.

EBE rames per sec - — Changing the looping option (optional)
_ _ — If the loop check box is selected (E), the animation
e will loop continuously. If the loop check box is

unselected, the animation will play once and then stop.
This only applies to GIF animation.

i 6 Make sure a minimum of two key frames have been
AR -_ specified and desired output settings are selected, then
click @ GENERATE animation.

CAPTURE GEMERATE
new key frame animation
{4 The Animator dialog box retains your specified
key frames and settings until you close the image.
You may change, for example, the number of open
viewports or the view mode from color (textured) to

gray (untextured), then generate a new animation.

zs zg I 4 Pre-op and simulated images in

synchronized 2-viewport animation
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Review and save a GIF animation

The GIF animation is displayed in a a floating Preview
dialog box.

Clicking the X in the upper right corner of the Preview
or Animator dialog closes the box.

Click @ to pause playback. The icon changes to .
Click @ to resume playback.

Click @ to stop playback. The animation starts at the
first frame when resumed.

Click @b to save the animation into the patient chart as
an Animated GIF Image with the file extension, “.gif”.

Review and save a video animation

The video animation is displayed ina a
floating window.

Click Il to pause playback. The icon
changes to .

Click P> to resume playback.

Click X in the upper right ey
corner to close animation Open Animation
and display Preview _

dialog box.

Click @ to save the animation into the
patient chart as a video.

Would you like to save this animation? {4 1f you close the Preview dialog box (GIF or video)
before saving, you will be prompted to save. To retain
the generated animation, click save.

save don't save
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5.9 SAVING THE SIMULATED OUTCOME

1 Click B save (top left corner of the screen) or press
Ctrl-S on your keyboard.

Save 2 The Save dialog opens with automatically generated
U names for the pre-op image with trimming and/or

[ e M landmarksand the simulated outcome image.

To preserve trimming and/or landmarks that have

Current simulation surface

T been applied to the pre-op image, make sure the
first checkbox is checked.

To preserve the simulated outcome as a 3D image
(.tom file), make sure the second checkbox is
checked.

If you wish to change a file name, highlight the
name and type a new name in the field.

3 Click save to save the pre-op (if checked) and
simulated 3D images into the patient chart.

{4 You will be prompted to save or discard the simulated
outcome before you exit Face Sculptor.
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Saving 2D images

Sculptor enables you to save a 2D version of any
image that appears on the screen into the patient
chart. When the patient chart is opened in Mirror
software, 2D images may be exported into PowerPoint
presentations or be printed for use during surgery.

1 Make sure the orientation, zoom, and framing of the
images(s) on screen reflect the desired 2D image(s).

m 2D (top left corner of the screen).

3 Select desired image parameters:

Constrain aspect ratio is recommended to avoid

Roberts, Laura

image distortion.

Lossless image compression:

Unchecked will produce a compressed
JPEG image with smaller file size and loss
of quality.

Checked will produce a PNG with larger

g . 1108
constrain aspect ratio
use lossless image compression
B single image
solid blue background color

file size and sharper edges.

Single image: If two or three views are displayed
on screen, and single image is unchecked, a

2D image of each view will be saved. If checked, a
single image of all views will be saved.

Solid blue background color: Check to save

2D image with blue background; uncheck to save
with the viewport background color selected in
Settings (dark gray/light gray/gradient/solid).

4 Click OK.
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5.10 SKIN ANALYSIS

Click the skin analysis tab at the top of the screen to
open Sculptor’s Facial Skin Analysis module.

Adjust mask

Sculptor automatically identifies the areas of interest for
Wrinkles, Spots, and Pores analysis. Each boundary, or
“analysis mask”, delineates the area in which Sculptor
will perform Facial Skin Analysis for that feature. Each
automatically generated analysis mask may be manually
adjusted, if necessary.

1 Hover over a section of the mask you would like to
adjust. That section becomes brighter and the mask
points ( » ) are made visible.

2 Click a mask point and drag to adjust the mask.

To automatically rotate
the images to a preset
viewpoint, click one of

the rotate-to-view
buttons, ———

To see the images from
any viewpoint at any
magnification, select one of the adjust viewpoint

buttons in the top bar, then click

within the image and drag.

Click to continue mask adjustments.

3 Click jggif analysis in the navigation bar to perform
analysis and view the Facial Skin Analysis results.
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Analysis

1 While analysis is performed, the patient’s image is
displayed in “color” mode (no analysis) and a progress
bar in the lower right corner of the screen shows that
analysis is underway.

2 After analysis is complete, click each
feature in the navigation bar on the
left side of the screen to display results.

Graphs depict the calculated score for each feature
on a color-coded scale from 0 to 100. The top/green
end of the graph is the highest possible score for
the feature being analyzed: 100/excellent skin. The
bottom/red end of the graph is the lowest possible
score: O/needs attention.

Average Score provides a comprehensive
measurement of the impact that the feature has on
the client’s complexion. Score factors in the total size
and area as well as intensity of detected instances of
the feature being analyzed. Score can be used to track
treatment progress when the size and intensity of
instances of a feature are the most relevant indicators
of treatment effectiveness.

NOTE: If “hide analysis Feature Count provides a count of the number of
scores” was selected in discrete instances of the feature being evaluated,
Setup, Average Score and without regard to the size or intensity of each
Feature Count will not be instance. Feature Count can be used to track
displayed. treatment progress when a reduction in the number

of discrete instances of a particular feature is desired.
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To view Brown Spots or Red Areas in an alternative
lighting mode, click . Click again to toggle off.

Texture, Spots, Pores and Wrinkles are displayed
with an analysis mask overlay to show where each
instance of the feature has been identified. The mask
overlay controls are available as a set of buttons in
the lower left corner of the screen.

The analysis mask is on o
by default, may be turned
off Q (color image only
without analysis) or set to
blinking 6B (alternating
between on and off).

To display a feature definition, hover over its name in
the navigation bar on the left side of the screen.

. -
analysis

color

Raised bumps and depressed ridges on the skin's surfac

Click overview to display all Skin
Analysis features and their scores
together on one screen.
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Recommendations

The Product Selector facilitates your recommendations
for the specific products and treatments appropriate to
skin conditions detected in your client. The products
and treatments offered at your location and their
attributes are defined during setup.

{4 1f the Product Recommendations Library has not
been configured, no products will appear in the
Recommendations screen (see A.2 Configuring the
Product Recommendations Library).

Click recommendations in the navigation bar to
select products and treatments.

The Recommendations screen displays the Product
Selector alongside an image from the current session.

S SNENTATION | CONTOURING PSRN

Use the radio buttons above the suggested products
list to organize and filter products.

Products and treatments may be grouped by brand
(organized by brand name with individual products
listed under their respective brands) or grouped by
category (organized according to category, such as
“Moisturize”, with

y individual products listed
O brand under their respective
@ category @® wrinkles @ texture ® pores @ spots Categories).

To display only the products which are designated to
treat a particular skin feature, select the radio button
next to Wrinkles, Texture, Pores, or Spots.
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m See A.2 Configuring the Product Recommendations
Library to change the default manufacturer-determined
product designations.

To locate a particular
product, click in

the search field and
type its name or
description, then
RegFractional XC/ click 0 to view each
instance that matches
the search criteria.

type product name or description to search

t up to 9 prod

Sciton

Click a brand or
category to display its
products. Click again
to hide.

Click a product to
display its picture
and description. Click
again to hide.

Double-click a
product to add it
to the Selected
Products pane at the
bottom of the Product
Selector. Up to nine
products may be
Tri-Retinol Comp ! selected.
Ceratopic Replenishing Lotiefi

Retinol Copat To remove a product
from Selected
Products, double-

click its thumbnail in

=
E%E%)nﬁm the Selected Products
SetwCR pane at the bottom of

TNS Regeneration the Product Selector.

System®
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Saving a record of your selected recommendations

1 Click the tab at the top of the screen

Plastic ¢ to open Sculptor’s print dialog.

4 Wood Hollow Rox
Personal | Face Scul

2 Make sure the Product Recommendations template
is selected (¥ check mark in the upper right corner of
the thumbnail).

3 Click # save PDF to save an electronic version of
the selected report(s) in the patient chart.

PRINTING REPORTS

1 Click the print tab at the top of the screen to open
Sculptor’s print dialog.

* Thumbnail representations of Face Sculptor’s report
templates are displayed in the left column. Click on a
thumbnail to view a full size preview of that report.

o Ifthe m single print
button is selected when
& print or & save
PDF is clicked, only
the “current” report

_ template—the one that is

s shown in the full size

preview—is printed/

saved. It doesn’t matter
whether the thumbnail
is checked or not.

o If the @ multiple print button is selected when
& print or M@ save PDF is clicked, only the
checked thumbnails are printed/saved. It doesn’t
matter which report is being currently previewed.

£4 The single/multiple selectors enable you to
identify certain report templates as your standard
set for Face Sculptor consultations while keeping
the standard set intact if a different template, or
only one of the templates, is occasionally used.
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* Click the checkbox () in the upper right corner of a
thumbnail to add that template to the report set. Click
a selected checkbox () to remove that template
from the report set.

* The most recently viewed simulated outcome is
represented in the print reports by default. To print/
save a different simulation or post-op image, click the
arrow next to the image name at the top of the screen
and select the desired image from the drop down
menu.

* If you wish your notes and recommendations to
appear on the printed report, select a notes-enabled
report template (e.g., 2 images, preop & sim, oblique,
notes). Click @) notes to add or edit your notes and
personalized recommendations for treatment.

clickzoom in clickzoom out
to see a magnified to reduce the magnification
view of the preview of the preview

* If you wish to print Skin Analysis images and/or
product recommendations, make sure the specialized
Skin Analysis templates are selected.

2 Click gg print to open the OS Print dialog and
print a paper report, or click & save PDF to save
an electronic version of the selected report(s).

3 To exit Sculptor’s print dialog and return to the
review screen, click (%) close (top right of screen).
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5.12 UPLOADING TO VIEWMYCONSULT.COM*

Facial simulations and/or Skin Analysis can be uploaded
to Canfield’s secure patient portal, ViewMyConsult.com.
Licensed educational materials can also be made
available for your patient to review while logged onto
the portal.

You may upload current scenarios (up to two) at the
end of the consultation, or select a previously saved
simulation from a patient chart.

To upload current simulation(s)

1 Click the
the screen.

UPLOAD upload tab at the top of

2 Complete the steps in Uploading simulations to
ViewMyConsult.com below.

To upload previously saved simulations

1 Open the patient chart that includes the images you
wish to upload to ViewMyConsult.com (see 2.2 Finding
a Patient Chart).

*Not available in every country. Only available to users with current
Support & Upgrade contract.
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2 Click to select the thumbnail for the first time point,
then Shift-click to select the corresponding simulation
(or Ctrl-click to select a discontiguous thumbnail).

4 Click the
the screen.

5 Complete the steps in Uploading simulations to
ViewMyConsull.com below.
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Uploading simulations to ViewMyConsult.com

1 Verify practitioner name and patient email address

Make sure the correct practitioner is selected.
(Click C' to refresh list, if needed.)

Make sure the patient’s email address is correct.

Re-enter the patient’s email address.

Patient Details Select Images (The pre-op image is automatically included)

Frocttoner | Hicholas Rivicra MD = [ simutation

Patent Emal | Jane.Doettemall. com

Confim Emal | Jane. Doz@enmall.com -«

Select availability of patient education materials

B¥; Bret Augmentaton B Breasc e

B et Rehcim

B¥4 Abdommnoplasty B¥: Loosuctan

¥4 Momemy Makeaver [l estetc Vopnal surgery
E Enhancements For Men B¥s Ao and Thigh LA

¥ Buteodis Enhancement [ ramatic weight Loss:
¥4 Brow 1t ¥ Eveld

¥ raceitc ¥ tose

The “Select availability of

patient education materials” 2 Select availability of patient education materials
pane appears only if you are i ]

licensed to use Electronic If you are licensed to use Electronic Procedural
Procedural Brochures from Brochures from ASAPS, a selection form appears

The American Society of

Aesthetic Plastic Surgery. beneath the Patient Details pane. Check the

materials you wish to make available to this patient
while logged into ViewMyConsult.com.

3 Select images to upload (if 2 scenarios are available)

Both scenarios are selected by default. Uncheck a
simulation if you do not wish to make it available.

Select the simulation to be displayed when the
portal is first opened. Simulation 1 is selected
by default.

4 Click [@ Next (upper right corner of screen).

VECTRA H2 User Guide [JEER



Chapter 5 Face Sculptor

5 Authenticate

Make sure the correct Username is selected.
(Click C' to refresh list, if needed.)

Enter the password for the selected Username,
if requested.

Uploader Authentication

Username [Nicholas.Riviera@practice.com /
_/
»

password |

Upload Summary

Practitioner Nicholas Riviera MD
Patient Name Jane Doe

Patient Emall Jane.Doe@emal.com
Selected Images  pre-op, Simulation
Display Options

Assessment Options

™9 Consent form has been signed by patient

6 Review upload summary

Review the upload summary information. If a
change is needed, click [ back (upper right
corner of screen), make adjustments as needed,
then click u next.

7 Obtain patient consent

After the patient has signed the patient consent
form, click the check box next to Consent form
has been signed by patient.

8 Click [®] upload (upper right corner
of screen).

Consultation session submitted

The patient will be notified by e-mail when ready for viewin

9 Click OK in the confirmation
message. The previous consultation
screen is displayed.
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5.13 REVIEWING PREVIOUSLY CAPTURED IMAGES AND SIMULATIONS

Markerless Tracking provides a dynamic assessment of skin surface changes.
After automatically aligning a pair of 3D images, the skin surfaces are tracked and
mapped. Colored vector arrows provide a precise indication of the direction and
magnitude of skin movement, which is ideal for encouraging future treatments

by showing patients their personal improvement results, confirming patient
improvements with detailed evidence of treatment results, and educating

through the review of outcomes and technique refinement.

Performing Markerless Tracking

1 Open the patient chart that includes the images you
wish to review (see 2.2 Finding a Patient Chart).

2 Click to select two thumbnails for automated
markerless tracking. Select the earlier time point first,
then Shift-click to select the second thumbnail (or
Ctrl-click to select a discontiguous thumbnail).

3 Click g markerless tracking.

A progress bar is displayed as VECTRA performs
automated markerless tracking on the selected images.

A new thumbnail representing the tracked images is
created in the patient chart.
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Reviewing tracked images in Comparison Mode

1 Click to select the tracked images thumbnail.

2 Click g8 open in Comparison.

The initial viewing option displays a side-by-side
comparison of the tracked images. To return to this
side-by-side view at any time, click 0

See 5.6 Viewing the Simulated Outcome for Face
Sculptor view modes. This section covers viewing
options that are only available with tracked images.

To display the tracked
images superimposed with
a slider for morphing

\I=ckra

To display the colored vector arrows, click
@ vector analysis. To select analysis zone(s),
click icon for desired zone; click again to deselect.

G O o aes
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\N=cka | ™=

B \=cta ™

Drag the slider bubble to display the image and vector arrows for the earlier time
point, later time point, or any point in between.

A scale along the left edge
of the viewport shows
the amount of change

associated with each color.

Click @ to auto-animate the morph.
Click € to quickly switch between time points.

Click one of the @@ buttons to decrease or increase the
size of the vector arrows.

Click @ to generate a color-coded view of the volume
differences between the images. Blue represents the
greatest increased volume and yellow represents the
greatest decreased volume between the two images.
Intermediate values are represented by corresponding
intermediate colors.

To select analysis zone(s), click icon(s)
in the lower left corner of the screen;
click again to deselect.

Click e texture to show
normal skin tone and
texture; click again to
toggle off.

Click . contours

to reveal contour lines;
click again to toggle off.
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Measuring the volume difference

1 Click in the top bar.

2 Click in the image area and drag the O brush to
define the area you wish to measure.

3 Release the mouse button to view the measurement.

N=cka '™

£4 Click and drag again to add to the defined area.
Each time the mouse button is released the
measurement is updated.

£4 Right-click within the defined area to select
- Reset (remove defined areas) or

+ Surface Area (display change in surface area,
instead of volume difference).
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5.14 CUSTOMIZING FACE SCULPTOR

Click preferences (top left corner of the screen) to
open the preferences dialog box or click i setup from
the VECTRA home screen.

1 GENERAL tab
» Enter your name or the name of your practice as you

wish for it to appear at the top of every printed report.

* Enter your contact information, such as address,
phone number, website. This will appear at the top of
every printed report, below your practice name.

f4 The Practice Name field and the Contact Information
field can each contain one line of text. Print a test to
make sure your information fits the template.

L« To add your logo to

General

The text and logo pntered here will appear at the top of every printed report. the tOp Of eVerY printed

'our practice name .

\V e o o ‘ report, click select logo,
your contact information (all in one line) | browse to the .png, ]pg or

\ 4 Wood Hollow Road / Parsippany, NJ 07054 USA / +1.973.434.1200 \ . . .
Background color for 3D images in printreport [l NN selectlogo  cearlogo ]peg you WISh to Use, Cth
The text entered here will be superimposed over simulation images \ (0] pen. A thumbnail of your
‘simulation only: actual surgical results will vary \ m lOgO appears il’l the bOX
Language
. .

- . e Click to select a different
Select desired appearance of the viewport background in Sculptor.

background color for 3D

images in printed reports
(default color is blue).

@ dark gray (defauk)

O light gray

@ gradient (defauk)

O sold

N

o If desired, modify or
[ Show patent name ncxport e s delete the disclaimer

[ Show look up buttRr in patient chart: (This optidhcould expose private patient information.) that iS dlSplayed over
U TG G WD (U0 — simulations.

[ sound notification

If desired, change the viewport background.
» If desired, click to turn off sound notification.

 If desired, select checkbox to show patient name in
export file name.

* If desired, select checkbox to make the “look up”
button available in patient chart. /A\ This option
could expose private patient information.
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2 DATABASE tab

* Click on the Database tab if you wish to switch to a
/ different database.

|l - Each patient’s profile picture is
R | displayed in the Look Up Patient search
results. To hide profile pictures in search
results uncheck show profile picture
oo 301 s o 20011 = in the lower left corner or the dialog.

3 CAPTURE tab
* Click on the Capture tab if you wish

connected captuse system

o to change the connected capture system.

4 FACE tab—workflow sequence

Sl B vk i s o i — ¢ Select or deselect the modules you
e e ‘ | wish to be displayed. These changes

|| take effect afier you close and reopen
v S A assessment || +

i [ O I Sculptor.

| ¢ < . < (9 recomemendatin

v | v :

5 FACE tab—features & assessments

* Uncheck “place landmarks” if you
o wish to turn off automatic placement
of landmarks.

Checked tasks will be perfon Fomatically Checked items are Shown; Uncheck 1o hide.
[ piace landmarks. 2

@ symmeny

Uncheck “rotate to optimal . . .”

to disable automatic rotation to
optimal orientation when you select
a constrained rhinoplasty or chin
augmentation adjustment tool.

show/hide Uncheck to disable
some or all of Face Sculptor’s
assessment diagrams and modes
O R (see 5.3 Assessment).

[ Fot3te £ eptmal snentaton for
% each constraned adustment toal
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6 FACE tab—analysis & product library

* Click the update product
recommendations button to edit the
Product Recommendations Library.
See Appendix A, A.2 Configuring the
Product Recommendations Library.

;;;;;;;;;;
recommendatons

i

— ¢ If desired, select “hide analysis scores’
checkbox to hide all Skin Analysis
numeric scores.

Version 6.10.1 bullt jul 07 2020 1119

After you have made your selections, click the close button to apply.

5.15 EXITING FACE SCULPTOR

* To close Face Sculptor and display the VECTRA
patient chart, click the VECTRA logo in the upper left
corner of the screen or click the | in the upper
right corner of the screen.

* To close Face Sculptor and display the current image
in VECTRA Analysis Module, click “ in the upper
left corner of the screen.

* To exit VECTRA software completely, click the
VECTRA logo from a patient chart to return to the
home screen, then
click gl exit in the
lower right corner
of the screen.
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CHAPTER 6

Body Sculptor®

6.1 GETTING STARTED

Body Sculptor 3D aesthetic simulation software assists
the surgeon during consultations enabling prospective
patients to visualize the possibilities of their anticipated
aesthetic procedures. This software module enables
the user to quickly make realistic surface and three-
dimensional changes to the patient’s own 3D image.
The results can then be reviewed with the patient to
ensure mutually understood expectations between the
surgeon and the patient. The pre-op and post-simulated
images can also be used as references during surgery.

Open a 3D image in Body Sculptor

A newly captured 3D image of your patient’s body is
automatically displayed in Body Sculptor software after
processing is complete (see Chapter 3: Preparing for
Capture and Finishing 3D Capture).

To open a previously captured image, open the patient
chart and double-click a 3D body image (see Chapter 2:
The VECTRA Patient Chart).
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Body Sculptor overview
Open the Body Contouring module by clicking the
Body tab at the top of the screen. You may select a
different module or Print by clicking its tab at any time.

¥ 50[g ) Iy ) BREAST EDUCATION UPLOAD

BoDY sculptor

undo redo
L adjust viewpoint buttons
v:ew:p VECTRA T o D = G Y T O
Analysis Module (F2 keyboard shortcuts
PR Ore 5007 sculptor In brackets []
save 2D image [ T— [z] zoom
save 3D \I—Ctra [r] roll
an
exit to VECTRA = [p] pa: '
Patient Chart [yl spin on Y-axis

Joanna Samuels [s] spin

To automatically rotate an image
to a preset viewpoint, click one of
the rotate-to-view buttons.

" contouring Click one of the navigation buttons
on the left side of the screen to
select what you wish to do next.

view results

[

To see the image(s) from any viewpoint at any
magnification, select one of the adjust viewpoint buttons

CEEEENCEEY - then click within the image and drag.

Rotating to the back of a 360°image Right-click a

front or front-oblique icon to rotate the torso to rear or
rear-oblique view. Alternatively, right-click in a viewport
to open the rotate-to-view button set with left-click
rear-view buttons.

m See Appendix E: Sculptor
Software Tips for keyboard

and mouse shortcuts.
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TRIM IMAGE

If you wish to remove unwanted parts of the image,
click the @l trim image navigation button on the left
side of the screen.

* The @ box crop tool enables you to draw a
rectangular boundary box, adjust it, and delete
everything outside of the box.

* The (&g select by lasso tool enables you to circle
unwanted parts of the image and delete them.

+ The [ select by points tool enables you to define
the area you wish to keep by clicking multiple points
on the image, then delete the unwanted areas leaving
a clean, smooth perimeter.

+ Click @] invert selection to reverse what is and
is not selected.

* Click to clear your selection without applying
or to undo crop.

* Click to apply the cropping or delete the
selected area.

* To remove all cropping/trimming, click reset.

Using the Select By Points tool
1 Click [ select by points.

2 Place the W cursor over the edge of the area you wish
to preserve, then click to place a point.

3 Continue to place points in a clockwise order around
the perimeter of the area you wish to preserve.

{4 To temporarily enable the Spin tool, hold down the
Alt key on the keyboard while you rotate the image.

4 Right-click the mouse after placing the last point.
The area outside of the perimeter is painted green.
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5 Click delete to remove the highlighted area.

Using the Box Crop tool
1 Click [ box crop.

2 Click and drag out a rectangle to define the area you
wish to keep. The boundary box you have drawn is
projected onto the three-dimensional surface.

£4 To adjust the size or position of the boundary box, click
an edge or corner of the box and drag to the desired
location.

3 Click crop (or right-click the mouse) to delete
everything outside of the box. If you wish to cancel this
operation, you may click [i§Siif cancel.

Using the Select By Lasso tool
1 Click (g select by lasso.

2 Place the %p cursor over the edge of an area you wish
to define, then click and drag around its perimeter.

3 Click delete (or rightclick) to remove the
highlighted area.

L4 To delete everything outside of the highlighted area,
first click @ invert selection, then click delete.

You may click Sl deselect if you wish to start over.
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6.3 ASSESSMENT

Click the Bl assessment navigation button on the
left side of the screen to access the circumference
assessment mode.

\N=ckeAa

A green ring is added at approximately the

vertical midpoint of the body. The circumferential
measurement of a horizontal slice of the body at this
height is displayed to the left of the ring.

{4 Click and drag the green ring to the desired height if
you wish to change the location of the circumferential
measurement.
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{4 Right-click on the center ring to add or remove rings
and select measurement system.

erase the selected ring

add more rings spaced 20mm apart

uncheck to display metric measurements

5168 cc

circumference measurements of slices volumetric measurement of cylinder created
by the uppermost and lowermost slices
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6.4

MODELING BODY CONTOURING OUTCOMES

If it's not already selected, click the Body tab at the
top of the screen, then make sure the 8 contouring
navigation button on the left side of the screen is
selected (blue).

Sculptor’s body
contouring
module opens
with its array of
tools displayed
on the left side of
the screen.

Tool-specific options appear only when the relevant tool
is selected.:

The brush size selector is displayed when
@ resurface, @ clone, @ wrinkle or

sculpt is selected.

When @@ fill, @ lipo, or

@ smooth is selected (blue)
and a region of the body has
been circled, the slider bar is
displayed.

Help text for the current tool
appears at the bottom of the
screen.
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Alternate view modes

Click one of the shading mode buttons CIEIED
- (located at the top of the screen) to view the image
L -— with alternate shading modes.

K’\‘Q a Natural photo mode (the default view). The
image retains all of its photographic detail for a
pleasing visual representation. Use to show skin
resurfacing procedures.

ﬂ Dynamic photo mode. The image is skin colored,
but with reduced detail. This helps to show
shape and anatomical features under raked
lighting.

Shape (gray) mode. This solid colored image
helps to visualize shape and volume changes
without the distraction of skin tones.

N=ctra

Click the 2-viewports
button in the navigation
sidebar to see two
independent views of
the same image.

To automatically rotate the image on the left to a
preset viewpoint, click on the left side of one of the
rotate-to-view buttons.

Click on the right side of
one of the rotate-to-view
buttons to automatically
rotate the image on the right to a preset viewpoint.
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About the brush tools

+ The cursor changes to’ A when you mouse over the
viewport and is surrounded by a translucent round
shape when it’s over the image. The translucent
shape indicates the area affected by the tool.

+ Brushing over a region twice doubles the effect.

+ Selecting a different brush size does not affect the
changes you have already made.

 It’s okay to stop and start again.

Using the Resurface tool

The Resurface tool smooths the skin’s texture and
is ideal for showing the effects of skin resurfacing
procedures.

1 Click @ Resurface.

2 Optional: Select 2 QN ERERD brush size.
3 Click and drag over the region to be treated.

Using the Clone tool

With the Clone tool, you can select the desired skin
appearance and apply it to areas that you wish to
change, such as brown spots, blemishes and tattoos.

1 Click @ Clone.

2 Optional: Select 2 QYD brush size.

3 Click the /#* eyedropper cursor in the section
of skin you wish to replicate.

4 Click and drag where you wish to apply

the selected sample. The characteristics of the
sampled skin are copied to the brushed area in a
context-sensitive manner.

£4 To select a different source, click @ Clone again and
then click the /#® eyedropper cursor in the desired area.
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Using the Wrinkle tool

The Wrinkle tool is used for removing or softening
wrinkles.

1 Click & Wrinkle.

2 Optional: Select 2 QSRR brush size.

3 Click the /# eyedropper cursor in the section of skin
you wish to replicate.

4 Click and drag over the region to be treated. The
texture of the sampled skin is copied to the brushed
area.

Using the Sculpt tool

The Sculpt tool is ideal for changing the shape of
irregular-shaped regions of the body.

maximum g 1 Click a section of the RERENESEY Sculpt button to

I UCCLUCITE  sclect volume increase, decrease, or smooth and degree
decrease Iincrease
of change.

moderate | moderate

volume volume 2 Optional: Select 2 QYRGE®D brush size.

decrease increase

3 Click and drag or use a series of clicks over the region
to be treated. The color of the translucent round shape
indicates your tool selection: red for decrease, green for
increase, and yellow for smoothing.
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Using the Warp tool

The versatile free hand Warp tool can be used for shape
adjustments to almost any part of the body.

1 Orient the image(s) so that the area you wish to warp
is visible.

2 Click @ Warp.

3 Place the cursor () over the image, then click
and drag to define the region to be adjusted. Release
the mouse button when you are satisfied with the
boundary.

4 Position the cursor near the part that you wish to
warp (the cursor changes to an f{m) open hand), then
click and drag in the desired direction (the cursor
changes to a §™ grabbing hand). Release the mouse
button when you are satisfied with the adjustment.

{4 For a stronger effect, click inside the defined area and
drag. For a more subtle effect, click outside the defined
area and drag.
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Using the Fill, Lipo, and Smooth tools

The Fill, Lipo, and Smooth tools are ideal for
reshaping larger regions of the body such as buttock
augmentation.

1 Orient the image(s) so that the area you wish to treat
is visible for circling.

2 Click @ Fill to add volume, @ Lipo to remove
volume, or @ Smooth to flatten unwanted contours.

3 Place the cursor (--) over the image, then click and
drag to define the region to be adjusted. Release the
mouse button when you are

satisfied with the boundary.

4 Position the cursor within
the circled region; the cursor
changes to an arrow ().
Click once to automatically
apply a calculated adjustment.
The change in volume added/
removed is displayed below
the slider bar.

e

£4 1f you wish to change
the amount of adjustment, — , ’
click and drag the bubble '
in the slider bar. To reset,
click the triangle near the
base of the slider bar.
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6.5 VIEWING THE SIMULATED OUTCOME

Click the [ view results navigation button on the left
side of the screen to review the simulated outcome in
various view modes.

Body Sculptor

. re-op and simulated
view modes pre-op and sim

side-by-side
(default view)

single image morph
pre-op to simulation

circumference and
volume measurements

simulated superimposed
over pre-op

color surface by distance

« Side-by-side

The initial viewing option displays a side-by-side
comparison of the pre-op image (on the left) and
the simulated outcome (on the right.) To view in 3
viewports click |JJilllj. Click |iill} to return to two.

To change the image in one of the viewports, click its
name in the bottom bar and select the desired image
from the pop-up menu.

To return to this side-by-side view at any time,

To display a single image with a slider for morphing
between pre-op and simulated outcome, click “

Drag the slider bubble to display the original image, the
simulated outcome, or any point in between:

VECTRA H2 User Guide KLY

{4 To quickly toggle
between the original
image and the simulated
outcome, click the

& toggle button to the
right of the slider, or ) J‘ :
click o to auto-animate . i =

the morph.




» Superimposed

=

« Color surface by distance

A scale along the left edge
of the viewport shows
the amount of change
associated with each color.

Chapter 6 Body Sculptor

Click » to view the

pre-op image overlaid with
a semi-transparent
simulated outcome.

Click ) to toggle between
showing the pre-op or
simulated image opaque.

Click 0 to generate a color-coded view of the
volume differences between the original image and
the simulated image. Gray represents unchanged areas,
blue represents the greatest increased volume, and
yellow represents the greatest decreased volume in the
simulated image. Intermediate values are represented
by corresponding intermediate colors.

Click i} and hover the
cursor over modified areas
to display the volume
difference between the
pre-op image and the
simulated outcome.

Click e texture to show
normal skin tone and
texture; click again to
toggle off.

Click . contours

to reveal contour lines;
click again to toggle off.
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» Circumference

Click @ to compare circumference and volume
difference between pre-op and simulated images.

Drag the green rings to move the location of the
circumferential measurement to the desired height.

Right-click on a center ring to add or remove
rings, or change measurement system.

Comparing circumference and volume measurements
between pre-op and post-op images Open a pair of
images in comparison mode (see 0.11 Reviewing
Previously Captured Images and Simulations), or:

1 Open a pre-op image in Body Sculptor.

2 Click the - view results navigation button on the
left side of the screen.

3 With the pre-op image
in the left viewport, click
the arrow under the right
viewport and select the
corresponding post-op
image.

4 Click to display Circumference view mode.
A green ring is added at approximately the vertical
midpoint of each image.

8 saved : Post-op k‘

sim.0

5 Click and drag the ring on the pre-op image to the
center of the region you wish to measure, then drag the
ring on the post-op image to match the pre-op location.

6 Right-click on the ring on the post-op
image and select align from the

drop-down menu to automatically align
the images according to the green rings.

7 Right-click on the center ring in either
image to add or remove slices (rings).
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¢ To automatically rotate an image to a preset viewpoint,

click one of the rotate-to-view buttons on the left side

of the screen. Right-click a front or front-oblique icon
to rotate the torso to rear view (if available).

* To see the image from any viewpoint at any
magnification, select one of the adjust viewpoint
buttons at the top of the screen,
then click within the image and drag.

* To toggle automatic rotation on or off click at the
top of the screen.

6.6 USING MARKERS AND ADDING NOTES

Sculptor’s color markers enable you draw colored lines
on the 3D image, useful for communicating with your
patient or adding treatment planning notes for future
reference. The marker palette is displayed in the upper
right corner of the screen.

1 Click a marker button ( ) to

select its color (pink, red, purple, blue, green, or black).
The button becomes highlighted ( [l ) and the cursor
changes to the selected color marker ().

2 Position the cursor over the desired start point for the
line, click and drag to draw a line on the surface of the
3D image, then release the mouse button.

¢ To draw with a different color, select one of the other
marker buttons.

» To erase the most recent stroke, click g undo or
press Ctrl-Z on your keyboard.

* To clear all recently drawn marker lines at once, click
&3 (1o toggle visibility, click @ then @)

Erase all mark-ups before applying Sculptor’s
texture tools (resurface, clone or wrinkle).

The marked up image may be saved as a 3D or 2D
image and/or printed or saved in a Sculptor report.
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To record your notes and recommendations, click
in the marker palette (upper right corner of screen).

Type in the box, then click OK. Content that you enter
in the notes box will appear on notes-enabled versions
of the printed report (see 0.9 Printing Reports).

{”4 Notes are only saved to the patient chart if you save
a notes-enabled report as a PDF.

6.7 CREATING A 3D ANIMATION

1 Click @ (bottom of the screen) to open Animator.

04 Click the Animator title bar and drag to reposition
the floating dialog box as needed.

2 Use adjust viewpoint buttons to

orient the image to the rotation and zoom desired for
the first frame of the animation.

3 Click § CAPTURE New Key Frame to save this view
as Key Frame 1.

animator

* A thumbnail of the key frame appears in the
CAPTURE Tk Animator dialog. If you wish to return the image to
new key frame animzifon this orientation and zoom, click the thumbnail.

: * Click the trash icon if you wish to delete this key
] frame.

10 <40 » Optional: Adjust the amount of time the animation
PesE should pause at this key frame.
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4 Rotate and/or zoom the image to the next position,
and then click § CAPTURE New Key Frame to save
this view as Key Frame 2.

animator

B ¢ A second thumbnail appears in the Animator dialog.

animation

» Optional: Adjust the interval between key frames.

* Notice that the @ GENERATE animation button is
no longer disabled. A minimum of two key frames
must be specified to generate an animation.

Repeat step 4 until you have specified all the key frames
you wish to include in your animation. Animator will
automatically insert the in between frames (“tweens”)
to make smooth transitions between the key frames.

£4 1f you would like the animation to loop back to
Key Frame 1 at the end, click the first thumbnail,
then click ) CAPTURE New Key Frame.

Saving key frames (optional)

If you plan to reuse a particular sequence, click save
after you have specified all the key frames you wish

to include in the template. Click clear if you wish to
delete all of the key frames and start over. Click load to
automatically generate a saved sequence.

Changing the pixel dimensions (optional)

Pixel dimensions determine how large the animation
appears on screen during playback. Increasing the pixel
dimensions also increases the size of the file. Smaller file
sizes are recommended for web or e-mail.

To change the pixel dimensions, select a preset size
by clicking the radio button next to small, medium

Output Settings or large (see table on following page), or modify the
== width eSS~ values in the width and/or height fields.

medium

(B9

i i {4 When E link is selected, changing one dimension
will automatically change the other dimension

to maintain the aspect ratio. When i link is

unselected, the aspect ratio may be modified.
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Output Settings

small width pixels

medium

(R0 9]

large

custom height pixels

frames eC, v loop

m frames per sec. + loop

animator

CAPTURE GEMERATE

new key frame animation

pause

Preset output pixel dimensions:

1 viewport 2 viewports*
small 180 x 240 pixels 360 x 240 pixels
medium 360 x 480 pixels 720 x 480 pixels
large 720 x 960 pixels 1440 x 960 pixels

*The preset pixel width is doubled for 2 viewports.

5 Select type of animation file to be generated: GIF or
MP4 video.

Changing the number of frames per second (optional)
To define the number of frames Animator will insert
for each second of playback, modify the value in the
frames per sec. field. More frames per second will
result in smoother transitions, but increase the file size.
* The recommended value for GIF is 8 to 10 FPS (more
than 12 is not recommended).
» The recommended value for video is 24 FPS.

Changing the looping option (optional)

If the loop check box is selected (H), the animation
will loop continuously. If the loop check box is
unselected, the animation will play once and then stop.
This only applies to GIF animation.

6 Make sure a minimum of two key frames have been
specified and desired output settings are selected, then
click @& GENERATE animation.

{4 The Animator dialog box retains your specified
key frames and settings until you close the image.
You may change, for example, the number of open
viewports or the view mode from color (textured) to
gray (untextured), then generate a new animation.

4 Pre-op and simulated images in
synchronized 2-viewport animation
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Review and save a GIF animation

The GIF animation is displayed in a a floating Preview
dialog box.

Clicking the X in the upper right corner of the Preview
or Animator dialog closes the box.

Click @ to pause playback. The icon changes to .
Click @ to resume playback.

Click @ to stop playback. The animation starts at the
first frame when resumed.

Click @ to save the animation into the patient chart as
an Animated GIF Image with the file extension, “.gif”.

Review and save a video animation

The video animation is displayed ina a
floating window.

Click Il to pause playback. The icon
changes to .

Click P> to resume playback.

Click X in the upper right preview
corner to close animation ooy e
and display Preview

dialog box.

Click @ to save the animation into the
patient chart as a video.

Would you like to save this animation? {4 1f you close the Preview dialog box (GIF or video)
before saving, you will be prompted to save. To retain
the generated animation, click save.

save don't save
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6.8 SAVING THE SIMULATED OUTCOME

1 Click B save (top left corner of the screen) or press
Ctrl-S on your keyboard.

Save 2 The Save dialog opens with automatically generated
Ul namecs for the pre-op image with trimming and/or

landmarks and the simulated outcome image.

To preserve trimming and/or landmarks that have

v

Current simulation surface

i been applied to the pre-op image, make sure the
first checkbox is checked.

cancel

To preserve the simulated outcome as a 3D image
(.tom file), make sure the second checkbox is
checked.

If you wish to change a file name, highlight the
name and type a new name in the field.

3 Click save to save the pre-op (if checked) and
simulated 3D images into the patient chart.

{4 You will be prompted to save the simulated outcome
before you exit Body Sculptor.

Saving 2D images

Sculptor enables you to save a 2D version of any image
that appears on the screen into the patient chart.

When the patient chart is opened in Mirror software, 2D
images may be exported into PowerPoint presentations
or be printed for use during surgery.

(For more on printing and exporting 2D images, see
your Mirror User Guide.)

1 Make sure the orientation, zoom, and framing of the
images(s) on screen reflect the desired 2D image(s).

jhﬂ 2D (top left corner of the screen).
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3 Select desired image parameters:

DoznlE Constrain aspect ratio is recommended to avoid

Roberts, Laura

image distortion.

Lossless image compression:

Unchecked will produce a compressed
JPEG image with smaller file size and loss
of quality.

Checked will produce a PNG with larger
file size and sharper edges.

width (pixels) 1392

height {pixels) 1108

constrain aspect ratio

use lossless image compression Single image: If two or three views are displayed
Ii'bl"‘id‘g » on screen, and single image is unchecked, a
SOl ue ba round color
2D image of each view will be saved. If checked, a

single image of all views will be saved.

Solid blue background color: Check to save

2D image with blue background; uncheck to save
with the viewport background color selected in
Settings (dark gray/light gray/gradient/solid).

4 Click OK.

PRINTING REPORTS

1 Click the print tab at the top of the screen to open
Sculptor’s print dialog.

* Thumbnail representations of Body Sculptor’s report
templates are displayed in the left column. Click on a
e thumbnail to view a full size preview of that report.

' If the ) single print button is selected when
\ = B & print or & save PDF is clicked, only the
“current” report template—the one that is shown in

the full size preview—is printed/saved. It doesn’t
matter whether the thumbnail is checked or not.

VECTRA H2 User Guide [EEED



Chapter 6 Body Sculptor

o If the gl multiple print button is selected when
& print or 8 save PDF is clicked, only the
checked thumbnails are printed/saved. It doesn’t
matter which report is being currently previewed.

£4 The single/multiple selectors enable you to
identify certain report templates as your standard
set for Body Sculptor consultations while
keeping the standard set intact if a different
template, or only one of the templates, is
occasionally used.

Click the checkbox (J]) in the upper right corner of a
thumbnail to add that template to the report set. Click
a selected checkbox () to remove that template
from the report set.

The most recently viewed simulated outcome is
represented in the print reports by default. To print/
save a different simulation or post-op image, click the
arrow next to the image name at the top of the screen
and select the desired image from the drop down
menu.

If you wish your notes and recommendations to
appear on the printed report, select a notes-enabled
report template (e.g., 2 images, preop, front & oblique
notes). Click @ notes to add or edit your notes and
personalized recommendations for treatment.

clickzoom in clickzoom out
to see amagnified  to reduce the magnification
view of the preview of the preview

2 Click gg print to open the OS Print dialog and print a
paper report, or click & save PDF to save an electronic

version of the selected report(s).

3 To exit Sculptor’s print dialog and return to the

review screen, click (%) close (top right of screen).
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6.10 UPLOADING TO VIEWMYCONSULT.COM*

Body simulations can be uploaded to Canfield’s

secure patient portal, ViewMyConsult.com. Licensed
educational materials can also be made available for
your patient to review while logged onto the portal.

You may upload current scenarios (up to two) at the
end of the consultation, or select a previously saved
simulation from a patient chart.

To upload current simulation(s)

1 Click the
the screen.

UPLOAD upload tab at the top of

2 Complete the steps in Uploading simulations to
ViewMyConsult.com below.

To upload previously saved simulations

1 Open the patient chart that includes the images you
wish to upload to ViewMyConsult.com (see 2.2 Finding
a Patient Chart).

*Not available in every country. Only available to users with current
Support & Upgrade contract.
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2 Click to select the thumbnail for the first time point,
then Shift-click to select the corresponding simulation
(or Ctrl-click to select a discontiguous thumbnail).

4 Click the
the screen.

5 Complete the steps in Uploading simulations to

ViewMyConsult.com below.
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Uploading simulations to ViewMyConsult.com

1 Verify practitioner name and patient email address

Make sure the correct practitioner is selected.
(Click C' to refresh list, if needed.)

Make sure the patient’s email address is correct.

Re-enter the patient’s email address.

Patient Details Select Images (The pre-op image is automatically included)

Practtener | Nicholas Riviera MD e

Patent Emal | Jane.Doettemall. com

Confim Emal | Jane. Doz@enmall.com -«

Select availability of patient education materials

B¥; Bret Augmentaton B Breasc e
[ Breos Reskcuon

B Aodormocplsy B, tposicion

P¥4 Mommy Makeover [l estetc Vopnal surgery
E Enhancements For Men B¥s Ao and Thigh LA

¥ Buteodis Enhancement [ ramatic weight Loss:

AV m
m © fus Naturel Ory B inplart Information
¥4 Brow 1t VL] O i Only
¥ raceitc BV tose @ Au Naturel and Bkn(

The “Select availability of ;

patient education materials” 2 Select availability of patient education materials
pane appears only if you are i ]

licensed to use Electronic If you are licensed to use Electronic Procedural
Procedural Brochures from Brochures from ASAPS, a selection form appears

The American Society of

Aesthetic Plastic Surgery. beneath the Patient Details pane. Check the

materials you wish to make available to this patient
while logged into ViewMyConsult.com.

3 Select images to upload (if 2 scenarios are available)

Both scenarios are selected by default. Uncheck a
simulation if you do not wish to make it available.

Select the simulation to be displayed when the
portal is first opened. Simulation 1 is selected
by default.

4 Click [@ Next (upper right corner of screen).
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5 Authenticate

Make sure the correct Username is selected.
(Click C' to refresh list, if needed.)

Enter the password for the selected Username,
if requested.

Uploader Authentication

Username [Nicholas.Riviera@practice.com /
_/
»

password |

Upload Summary

Practitioner Nicholas Riviera MD
Patient Name Jane Doe

Patient Emall Jane.Doe@emal.com
Selected Images  pre-op, Simulation
Display Options

Assessment Options

™9 Consent form has been signed by patient

6 Review upload summary

Review the upload summary information. If a
change is needed, click [ back (upper right
corner of screen), make adjustments as needed,
then click u next.

7 Obtain patient consent

After the patient has signed the patient consent
form, click the check box next to Consent form
has been signed by patient.

8 Click [®] upload (upper right corner
of screen).

Consultation session submitted

The patient will be notified by e-mail when ready for viewin

9 Click OK in the confirmation
message. The previous consultation
screen is displayed.
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6.11 REVIEWING PREVIOUSLY CAPTURED IMAGES AND SIMULATIONS

Opening images in Comparison Mode

1 Open the patient chart that includes the images you
wish to review (see 2.2 Finding a Patient Chart).

2 Click to select the thumbnail for the first time point,
then Shift-click to select the second image (or Ctrl-click
to select a discontiguous thumbnail).

3 Clickopen in Comparison.

NOTE: Body Sculptor software will attempt to align the
two images. Pre-op and simulated outcome images will
align closely. Pre-op and post-op will not always align
closely. This may affect some comparison tools.

Reviewing related images in Comparison Mode

The view modes available in Comparison Mode are the
same as those in 0.5 Viewing the Simulated Outcome.

side-by-side
(default view)

morph between
the two

circumferential
measurements

superimposed

color surface by distance
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Side-by-side view mode in Comparison

The initial viewing option displays a side-by-side
comparison of the images. To return to this side-by-side
view at any time, click «)

Morph view mode in Comparison
To display a single image with a slider for morphing
between the two images, click »

Drag the slider bubble to display the original image, the
simulated outcome, or any point in between:

r i 1 If the second image is a simulated outcome based on
the first image,* then vector analysis arrows will be
available to show direction and amount of change.
To display the colored vector arrows, click

@ vector analysis. Click again to toggle off.

*Vector analysis is not available for post-op images.
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Drag the slider bubble to see the direction and amount
of change between the original image, the simulated
outcome, or any point in between:

Click @ to auto-animate the morph (with or without
VeCtor arrows).

D to quickly switch between time points.

Click one of the @@ buttons to decrease or increase the
size of the vector arrows.

first image opaque,
overlaid with the second
image, semi-transparent.
Click ) to toggle opacity
between the two images.

Color surface by distance view mode in Comparison

to generate a color-coded view of the volume
differences between the images. Blue represents the
greatest increased volume and yellow represents the
greatest decreased volume between the two images.
Intermediate values are represented by corresponding
intermediate colors.
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A scale along the left edge of the viewport shows the
amount of change associated with each color.

\\:rl-r;% '“'
|

Click @ texture to show normal skin
tone and texture; click again to toggle off.

N=cta '"'
|

Click o contours to reveal contour
lines; click again to toggle off.

Measuring the volume difference

1 Click &Y in the top bar.

/“\
2 Click in the image area and drag the \__/ brush to
define the area you wish to measure.
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3 Release the mouse button to view the measurement.

£4 Click and drag again to add to the defined area.
Each time the mouse button is released the
measurement is updated.

= {4 Right-click within the defined area to select
Reset (remove defined areas) or

Surface Area (display change in surface area,
instead of volume difference).

Circumferential measurements in Comparison

1 Click @ to display Circumference view mode.
A green ring is added at approximately the vertical
midpoint of each image. :

2 Click and drag rings to
the center of the region
you wish to measure.

3 Right-click on a ring to
open pop-up menu.

4 Sclect align to align the
rings at the same height.
Select 1, 3,5, or 7 slices to
change the number of
measurement rings.
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6.12 CUSTOMIZING BODY SCULPTOR

1 GENERAL tab

General

The text and logo fntered here will appear at the top of every

your practice name

—_—

Click preferences (top left corner of the screen) to
open the preferences dialog box or click [ setup from
the VECTRA home screen.

» Enter your name or the name of your practice as you
wish for it to appear at the top of every printed report.

* Enter your contact information, such as address,
phone number, website. This will appear at the top of
every printed report, below your practice name.

f4 The Practice Name field and the Contact Information
field can each contain one line of text. Print a test to
make sure your information fits the template.

* To add your logo to
the top of every printed

printed report.

‘ Plastic Surgery Center

| report, click select logo,

your contact information (all in one line) W

browse to the .png, .jpg or

[4 Wood Hollow Road / Parsippany, NJ 07054 USA / +1.973.434.1200

Background color for 3D images in printreport  [Jl] W

The text entered here will be superimposed over simulation images.

‘ jpeg you wish to use, click

\ Open. A thumbnail of your

‘ simulation only: actual surgical results will vary

-

Language
U.S. English [+]

Select desired appearance of the viewport background in Sculptor.

@ dark gray (defauk)

O light gray

@ gradient (defauk)

O sold

[ sound notification

[] Show patient name in export fie name

L] Show look up butd

Version 6.10.1 built Jul 07 2020 11:19

in patient chart (This optiodcould expose private patient information.)

"& logo appears in the box.

[~

Click to select a different
background color for 3D
images in printed reports
(default color is blue).

N

o If desired, modify or
delete the disclaimer
that is displayed over
simulations.

close

If desired, change the viewport background.
If desired, click to turn off sound notification.

If desired, select checkbox to show patient name in
export file name.

If desired, select checkbox to make the “look up”
button available in patient chart. /N This option could
expose private patient information.
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2 DATABASE tab

* Click on the Database tab if you wish to switch to a
/ different database.

|l - Each patient’s profile picture is
R | displayed in the Look Up Patient search
results. To hide profile pictures in search
results uncheck show profile picture
in the lower left corner or the dialog.

3 CAPTURE tab

Click on the Capture tab if you wish to

connected capture system

o change the connected capture system.

4 BREAST/BODY tab—workflow sequence

— Select or deselect the modules you

,/_§ wish to be displayed. These changes
EEE EE | take effect after you close and reopen
' " Sculptor.

2 et —If desired, select “crop stitched H2 torso
= oo T image” checkbox to automatically crop
VECTRA H2 torso images after they are
s mmmene | | stitched.

After you have made your selections,
click the close button to apply.

20 implants meet these criteria

20 implants meet these criteria

Version 6.10.1 bult Jul 07 2020 11:19
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6.13 EXITING BODY SCULPTOR

* To close Body Sculptor and display the VECTRA
patient chart, click the VECTRA logo in the upper left
corner of the screen or click the || in the upper
right corner of the screen.

* To close Body Sculptor and display the current image
in VECTRA Analysis Module, click a in the upper
left corner of the screen.

* To exit VECTRA software completely, click the
VECTRA logo from a patient chart to return to the
home screen, then
click gzl exit in the
lower right corner
of the screen.
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CHAPTER 7

Breast Sculptor®

7.1 GETTING STARTED

Breast Sculptor software assists the surgeon during
consultations by using the patient’s own 3D image to
communicate the potential of breast augmentation and/
or mastopexy. This software module quickly provides

a comparative review of several different implant
scenarios to guide the implant selection. In this way,
Breast Sculptor delivers more realistic and informative
consultations, helping to ensure mutually understood
expectations, ultimately leading to increased patient
satisfaction.

Open a 3D image in Breast Sculptor

A newly captured 3D breast image is automatically
displayed in Breast Sculptor software after processing
is complete (see Chapter 3: Preparing for Capture and
Finishing 3D Capture).

To open a previously captured image, open the
patient chart and double-click a 3D breast image
(see Chapter 2: The VECTRA Patient Chart).
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Breast Sculptor overview
A breast image is initially displayed in Breast Sculptor.
You may select Breast, Body, Education, Print, or
Upload by clicking the corresponding tab at any time.

Gt o O A

\=ckra

undo redo

adjust viewpoint buttons

view in VECTRA  puumm . n -
Analysis Module pid" ) S+ < O S ®x placeor adjust

landmarks [t]

preferences : C
save 2D image — [z] zoom
save 30 AN =1 g} 1] roll
exit to VECTRA [p] pan
Patient Chart ) [yl spin on Y-axis

[s] spin

keyboard shortcuts
in brackets [ ]

landmarks ' To automatically rotate an image
to a preset viewpoint, click one of
the rotate-to-view buttons.

To see the image(s) from .
any viewpoint at any mag- . Click one of the navigation buttons
nification. select one of the on the left side of the screen to

. L . sic select what you wish to do next.
adjust viewpoint buttons
CEZREES. <~
click within the image
and drag.

Rotating to the back of a 360°image Right-click a

front or front-oblique icon to rotate the torso to rear or
rear-oblique view. Alternatively, right-click in a viewport
to open the rotate-to-view button set with left-click
rear-view buttons.

m See Appendix E: Sculptor
Software Tips for keyboard

and mouse shortcuts.
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7.2 LANDMARKS

Breast Sculptor calculates breast measurements from
a set of points that may be placed automatically or
user-identified. If the place landmarks option is
checked in preferences, Breast Sculptor automatically
places the required points on the 3D breast image
before it is displayed.

Click the E landmarks navigation button on the
left side of the screen to adjust or place landmarks.
Identified landmarks are displayed as green dots
for review and adjustment, if needed. The landmark
adjustment tool is selected (top of screen).

Adjusting landmarks (optional)

1 Position the tip of the cursor arrow over a landmark.
The cursor changes to an Qf'j pointing finger hand when
it’s close enough to the landmark.

- 2 Click and drag (the cursor changes to a §™ grabbing
@ ﬁ‘i—hand) Release the mouse button when the landmark is
: in the correct position.

If you make a mistake, click (@] undo to move the
landmark to its previous position.

04 1n some cases the anatomy may be more distinct in
Shape (gray) mode. To see the image in Shape mode,
click B (located at the top of the screen). To see the
image in Natural photo mode (with normal skin color),

click a

T emEAST

sculptor

\=ck@a
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Rotating the image to inspect landmarks

* To automatically rotate an image to a preset viewpoint,
~— click one of the rotate-to-view buttons on the left side
of the screen.

* To see the image from any viewpoint at any
magnification, select one of the adjust viewpoint
buttons at the top of the screen,
then click within the image and drag. Click the
landmark adjustment button to resume moving
landmarks.

» With the adjustment tool selected, press and hold
the Alt key (on your keyboard) to temporarily switch
to Spin, then click within the image and drag
to rotate. Release the Alt key to resume using the
adjustment tool.

Resetting auto landmarks

To delete all of the previously set landmarks and have
Breast Sculptor software automatically identify and
place landmarks, click auto landmarks on the left
side of the screen.

Placing user-identified landmarks (optional)

1 Click delete landmarks (on the left side of the
screen) if you wish to delete all of the previously set
landmarks and have the software guide you through
each landmark location with instructions (words and
picture) on the left side of the screen.

\=ctra

A green dot shows that the landmark is

placed.

Updated instructions show the
next location to place a landmar

=
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\=cka

2 Position the tip of the cursor arrow over the
appropriate anatomical location as described on the left
side of the screen. Click once to place the landmark. As
each location is clicked, the image rotates automatically
to facilitate placement of the next landmark.

3 Repeat until each of the requested landmarks has
been placed. When the final landmark has been placed,
the image automatically rotates to frontal view.

4 Review landmark placement. If you wish to change
the position of a landmark, see Adjusting Landmarks
(previous pages).

TRIM IMAGE

If the crop image option is checked in preferences,
Breast Sculptor automatically crops the 3D breast image
before it is displayed.

Click the trim image navigation button on the left
side of the screen to remove unwanted parts of the
image or remove all cropping/trimming.
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f‘ﬁ e * Breast Sculptor automatically crops the 3D breast
image when you click the jli§ automatic crop tool.

P e
mm box cro 1]

* The @ box crop tool enables you to draw a
rectangular boundary box, adjust it, and delete
everything outside of the box.

* The (g select by lasso tool enables you to circle
unwanted parts of the image and delete them.

+ The [ select by points tool enables you to define
the area you wish to keep by clicking multiple points
on the image, then delete the unwanted areas leaving
a clean, smooth perimeter.

+ Click @] invert selection to reverse what is and
is not selected.

+ Click {5l to clear your selection without applying
or to undo crop.

* Click to apply the cropping or delete the
selected area.

* To remove all cropping/trimming, click reset.

Using the Select By Points tool
1 Click [§§ select by points.

2 Place the W cursor over the edge of the area you wish
to preserve, then click to place a point.

3 Continue to place points in a clockwise order around
the perimeter of the area you wish to preserve.

0% To temporarily enable
the Spin tool, hold down
the Alt key on the
keyboard while you
rotate the image.

4 Right-click the mouse
after placing the last point.
The area outside of the
perimeter is painted green?
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5 Click delete to remove the highlighted area.

Using the Box Crop tool
1 Click [ box crop.

2 Click and drag out a rectangle to define the area you
wish to keep. The boundary box you have drawn is
projected onto the three-dimensional surface.

£4 To adjust the size or position of the boundary box, click
an edge or corner of the box and drag to the desired
location.

3 Click crop (or right-click the mouse) to delete
everything outside of the box. If you wish to cancel this
operation, you may click [i{Silj cancel.

Using the Select By Lasso tool
1 Click (g select by lasso.

2 Place the %p cursor over the edge of an area you wish
to define, then click and drag around its perimeter.

3 Click delete (or right-click) to remove the
highlighted area.

04 To delete everything outside of the highlighted area,
first click @] invert selection, then click delete.

You may click deselect if you wish to start over.
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7.4 ASSESSMENT

Click the P&l assessment navigation button on the
left side of the screen. The first assessment mode is
displayed with measurements that help identify breast
asymmetries.

N=cka

The marker palette (top right
corner of screen) may be used to
add additional markups and/or
record notes that will be included
in the printed report (see section
7.9 Using Markers and

Adding Notes).

To display another assessment diagram, click its
name on the left side of the screen.

* Composite Measurements used for » Distance Measurement of lateral and
planning the simulated outcome. vertical asymmetries.
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* Projection Measurement of
projection asymmetry.

Chest wall shows chest wall
asymmetry and measures breast
volume difference.

Reflect shows the difference in
breast shape with a line representing
the reflected/mirror image
superimposed over the actual

breast image.

Compare displays three different
viewing perspectives of the same
image: front, right lateral, left lateral.
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* Symmetry helps to visualize asymmetries. The first viewport shows two right
sides: The right side of the body is flipped and joined to the normal right side. The
center viewport shows the normal image. The third viewport shows two left sides:
The left side of the body is flipped and joined to the normal left side.

» Oblique displays three viewing perspectives of the same image: right oblique,
front, and left oblique.
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7.5 SIMULATING A MASTOPEXY OUTCOME

1 Click the @ mastopexy navigation button on the left
side of the screen.

o
circumareolar

\N=cka

Cy—
r circumvert.

nverted-T

T | WP 2 Click one of the incision type buttons to
select desired incision type.

*

mastopexy

04 To select different incision
types for each breast (or none),
use the H Right and u Left —
segments of the desired incision
type buttons.

£%4 To deselect an incision type, click again on the
selected button or segment.
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Adjusting incision diagrams (optional)

Incision diagrams, which Breast Sculptor uses to
simulate the excising of skin, are displayed for review
and adjustment.

The diameter of the L
new areola may be =cka
adjusted by clicking
the (-) or (+) buttons
or by clicking and
dragging the handles
on the diagram.

The image may

be oriented to the
optimal viewpoint
for each adjustment
by clicking one of
the four mastopexy-
specific rotate-to-
viewpoint buttons.

A dot in a circle controls the location of the new
nipple/areola. Click and drag the corresponding
dot to adjust its position. The breast meridian line is
provided as a reference.

To adjust the incision, hover the cursor over the
diagram, then click and drag the highlighted point.

The diameter of the
new areola is displayed
on the left side of the
screen, and may be
adjusted by clicking the
= or buttons, or
by clicking and
dragging the diagram.

st

3 Once you are satisfied with the incision diagrams,
click the - view results navigation button on the left
side of the screen to initiate the simulation process,

or click the [l select implants navigation button to
simulate an augmentation outcome.
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7.6 |GG S'MULATING A REVISION OUTCOME

Click the . revision navigation button on the left side
of the screen.

BREAST

culptor
\i=ckra

To increase volume, drag the left slider
bubble up.

To distribute volume toward the upper
pole, drag the right slider bubble up.
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To distribute volume toward the lower
pole, drag the right slider bubble down.

To adjust breasts independently,
click the unlink button [g9).
A pair of amount of volume and
distribution of volume sliders
are displayed for each breast.

If you wish to make matching
adjustments on both sides, click the
link button @

Viewing results

Once you are satisfied with your adjustments, click the
K view results navigation button on the left side of
the screen.
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m SIMULATING AN AUGMENTATION OUTCOME

This section shows you how to use the Breast Sculptor Implant Selector chart.
Alternatively, you may pre-set the implant styles you wish to use and have them
automatically selected based on measurements and criteria you selected (see section
7.16 Customizing Breast Sculptor).

Click the il select implants navigation button on the
left side of the screen.

Implant selector overview

The Breast Sculptor implant selector is displayed with
implants that meet the selected criteria* highlighted
in gold.

Breast base width [ ar

data for each breast is [T
displayed at the top of
the implant selector.

Estimated cup size =
is displayed if show
bra size is checked
in preferences (see
7.16 _Customizing
Breast Sculptor).

Breast Shape
Optimizer

A button representing
the first scenario is
selected. (Second
scenario is disabled
until first scenario
implants are selected.) Filters (see following page)

Shading mode You may click the @ measurements button to display
the results of the calculations based on the landmarks
(click again to close).

*Breast Sculptor software calculates the distance between the medial and lateral landmarks and subtracts
the soft tissue pinch thickness value to find the optimal diameter. Based on selected filters (see following
page), the diameter closest to that number as well as the next 2 smaller and 2 larger are highlighted in
the implant selector. The default soft tissue pinch thickness value is user-definable (see 7.16 Customizing
Breast Sculptor), and initially is set at 16mm.
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68-270MP

Selecting implants

1 Filters: The implants displayed in the table are
filtered by type (round saline, round gel or shaped
cohesive gel), texture (textured or smooth), manufacturer,
profile, and height (shaped implants only) that you
select from the drop-down menus. The more choices
selected, the longer the table of available implants will
be. To shorten the list, deselect items.

If the desired filter drop-down is closed, click its
p arrow to display filtering options.

Click an item to select. The type color changes to gold
e and the selected item is outlined. (Click again if you
wish to deselect.)

Click the = arrow again to close the list (optional ).
Selected items appear next to their category name.

Your filtering selections are “sticky”—they will remain
the same until you change them.

2 By default, your selection is applied

to both breasts. Leave BOTH selected

to select the same size implant for both
breasts, or click RIGHT only or LEFT only
to select different implants.

0 To add an implant to one side only
and leave the other side without an
implant, click RIGHT only or LEFT only
before selecting an implant.

£4 Click a column head to sort the list by
this specification. Click the arrow above

68-300MP

the column head to toggle between

68-330MP

ascending and descending order.

68-360MP

68-380MP

3 Click the desired row of specifications
(style, volume, diameter, projection, etc.).
Your selections for each breast populate
the upper area of the implant selector box
and the estimated cup size is updated.
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The selected model number is displayed on the first
scenario button on the left side of the screen. The
appearance of the {g advance arrow indicates that the
results are ready to display.

4 Optional: 1f saline is selected for the implant type,
sliders for independently adjusting the fill of each
implant are enabled.

Ifyou'd like to erase Slide toward the right to increase the amount of fill or
all selections, click clear toward the left to decrease the amount of fill.

5 Activate Breast Shape Optimizer (optional) Breast
Shape Optimizer is an automatic refinement tool for
difficult pre-op cases where normal simulation results
don’t match expected outcome. Click the Breast Shape
Optimizer button in the side bar to display sliders for
left and right breast adjustments.

6 Apply Breast Shape Optimizer (optional) Click
and drag one or both sliders to increase or decrease
optimizer effect. Keep Bl link selected to optimize
both breasts equally; click to deselect E link for
asymmetrical adjustment. Optimization may also be
adjusted while viewing results.

7 Selecting a second scenario (optional) Once the
parameters for the first scenario have been selected,
the button representing scenario 2 becomes enabled.
Click the second scenario button and repeat steps 2
through 6 to simulate another augmentation outcome.

8 Viewing results Breast Sculptor automatically applies
the selections that you make to the 3D image of your
patient, then holds the information for up to two
scenarios until you are ready to reveal the simulated
outcome(s) by clicking the - view results navigation
button or the g advance arrow next to the scenario
you wish to show first.
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Repositioning implants (optional)

1 Click the |G reposition implants navigation button
on the left side of the screen if you wish to adjust the
position of the implants and/or nipples.

Breast Sculptor displays a translucent image of your
patient’s torso revealing the position of 3D models of
the implants you have selected.

Click the button for scenario 1 or 2 (if created) to
identify which implants you will be adjusting.

Click the radio button next to subglandular
placement or submuscular placement if you wish to
change the implant placement.

Adjusting the position of the implants (optional)

{4 To change the default implant height offset, see
7.16 Customizing Breast Sculptor.

L% You may adjust the position of each implant individually
or both implants in tandem by clicking and dragging.

1 Click & for individual adjustment or g linked (the
other implant mirrors the one you are moving).

= . 2 Place the cursor arrow
NEcka ~ | overanimplant.

: | The implant brightens,
indicating that it is
selected.

3 Click and drag.

Release the mouse button
when the implant is in

the correct position.
(NOTE: It may take a few
seconds for the model of
the implant to follow the
movement of your cursor.)

If you’d like to clear all of
your adjustments, click |-
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Adjusting the height of the nipples (optional)

1 Position the cursor over the nipple of the breast
to be adjusted. The landmark (green dot) will turn
bright green, indicating that the cursor is in the correct
position. (If gy linked is selected, both nipples will be
. highlighted, indicating that they will move in tandem.)

2 Click and drag the landmark upward the amount
desired. The distance moved is displayed next to the
landmark in millimeters.

The landmark can be moved straight up, not in any
other direction.

The landmark moves, not the nipple or breast—
the nipple height change is simulated during the
processing of the augmentation model.

Adjusting the other scenario (if created) (optional)

To adjust the position of implants and/or nipple height
for the other scenario, click its button on the left side of
the screen and repeat the steps above.

Viewing results

Once you are satisfied with your adjustments, click
the - view results navigation button on the left side
of the screen or the @) advance arrow next to the
scenario you wish to show first.

Breast Sculptor simulates the augmentation outcome(s)
and the 3D surgical model is displayed. You can make
additional minor adjustments while reviewing the
simulated outcome(s).
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7.8 VIEWING THE SIMULATED OUTCOME

Click the - view results navigation button on the left
side of the screen or the {g) advance arrow next to the
scenario you wish to show first (only available from
select implants or reposition implants screen).

To see the image from any viewpoint at Click to toggle

any magnification, select one of the adjust automatic rotation Shading mode
viewpoint buttons, then click within J on or off. buttons

the image and drag.

3 0 z kAT

To automatically \=cta
rotate an image to a
preset viewpoint, click
one of the rotate-to-
view buttons.

View mode selector

Scenario selector

OptiSizer controls
for incremental
implant change

Adjustment tools

Toggle Natural and Display summary of implant Display calculated breast
Dynamic shading modes ~ parameters (click @ to show/hide) ~ measurements (click @ to show/hide)

Shading modes
Click one of the shading mode buttons CJIEHED at the top of the screen to view
the image with alternate shading modes, or click the button in the lower left corner

of the screen to toggle | Natural and [ Enhanced mode.

&4 Vatural mode (the default view). The image retains
all of its photographic detail for a pleasing visual
representation. Use to show skin resurfacing procedures.

K3 znhanced mode. The image is skin colored, but with
reduced detail. This helps to show shape and anatomical
features under raked lighting and accentuates cleavage.

Shape (gray) mode. This solid colored image helps
to visualize shape and volume changes without the
distraction of skin tones.
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Breast Sculptor view modes

pre-op and simulated
side-by-side

single image morph
pre-op to simulation
(default view)

virtual bikini

simulated superimposed

breast shape optimizer
over pre-op

color surface by distance

+ Morph

The initial view is a single image with a slider for
morphing between pre-op and simulated outcome.
> Drag the slider bubble to display the original image,
the simulated outcome, or any point in between.

\=cha

The volume readout updates as you drag.

£4 To quickly toggle
between the original
image and the simulated
outcome, click the

e toggle button to the
right of the slider, or
click @ to auto-animate
the morph.

The button for the active scenario (left side of screen) is
outlined in blue with white text. Click the other scenario
button (if available) to make it active and compare its
simulated outcome with the pre-op.

To return to this single image morph view at any time,

click “
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+ Side-by-side

to view a side-by-side comparison of the pre-
op image and one or two simulated outcomes.

To view pre-op and two scenarios chck ol
The button for the
active scenario is
outlined in blue
with white text, and
its corresponding
image is underlined
in blue.

Clicking the other scenario button makes it active:
Its corresponding image is underlined in blue.
It is the only scenario affected by adjustments
(see Adjusting the Simulated Outcome in section 7.8).
It is the scenario compared to the pre-op when you
switch to a 2-image comparison mode.

Click il to return

To change the image in one

to two viewports. of the viewports (to compare

The active scenario the post-op, for example), click

appears alongside its name in the bottom bar

the pre-op. and select the desired image 1 sovd: post-op

from the pop-up menu.

« Virtual bikini

Click Q to view the image
with a virtual bikini applied.

To change the color of the virtual §
bikini, click one of the swatches —” |
below the view mode selector. :

To view the virtually clothed pre-op with
one or two scenarios, click il or il

To return to one view, select the desired scenario,

then click El
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» Superimposed
‘ Click “ to view the pre-op image overlaid with a
semi-transparent simulated outcome.

If you wish to compare the other scenario, click its
button on the left side of the screen.

Click @ to toggle between showing the two comparison
images opaque, the other one semi-transparent.

Click “ to generate a color-coded view of the
volume differences between the original image and

the simulated image. Gray represents unchanged areas,
blue represents the greatest increased volume, and
yellow represents the greatest decreased volume in the
simulated image. Intermediate values are represented
by corresponding intermediate colors. A scale along the
left edge of the viewport shows the amount of change
associated with each color.

Click e texture to show
normal skin tone and
texture; click again to
toggle off.

Click . contours

to reveal contour lines;
click again to toggle off.

Adjusting the simulated outcome (optional)

Breast Shape Optimizer is an automatic refinement tool
for difficult pre-op cases (e.g. tubular shape or small
ptotic breasts) where normal simulation results don’t
match expected outcome. Breast Shape Optimizer
may be applied during implant selection and/or while
viewing results.

1 Click 9 to display most recent Breast Shape
Optimizer adjustments for the current scenario.
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2 Click and drag one or both sliders to increase or
decrease optimizer effect.

Keep ﬂ link selected to optimize both breasts equally;
click to deselect giy link for asymmetrical adjustment.

al

Breast Shape Optimizer applied maximum optimizer applied

The OptiSizer buttons on the left side of the screen
provide a quick, easy way to change the implants of one
or both scenarios.

1 Click @ morph (with the slider is all the way to the
right), @@ side-by-side, or @ superimposed view
mode to enable adjustments.

2 Click the button representing the scenario you wish
to adjust, if it’s not already selected.

3 Select the parameter you wish to change (diameter,
projection or height).

4 Click the plus button to increase or the

&l minus button to decrease the selected parameter.
Breast Sculptor software applies the next size model in
the implant catalog to the selected scenario. The image,
model number, and file name update to reflect the
change each time you click.

implant height
(shaped implants only)

implant projection
implant diameter

NOTE: If the plus and/or minus button appears to be disabled
(@GED). you have reached the end of the range of
implants of this type. To make more extensive implant
parameter changes, click the [l select implants
navigation button on the left side of the screen.

& If you wish to create an additional scenario, rather than
modify an existing scenario, SAVE the current simulation
(see 7.11 Saving the Simulated Outcome) before clicking
the B8 select implants navigation button.
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To adjust breast position without leaving the view results
screen or altering the volume of the simulated outcome:

1 Click @ morph (with the slider is all the way to the
right), @@ side-by-side, or @ superimposed view
mode to enable adjustments.

2 Click the button representing the scenario you wish
to adjust, if it’s not already selected.

3 Click (@ to move only one breast or g to make the
other breast mirror the one you are moving.

4 Place the cursor over the area you wish to move
(the cursor changes to an {”j open hand). Click and
drag (the cursor changes to a ™ grabbing hand).
Release the mouse button when you are satisfied with
the adjustment.

To adjust the shape and volume of the simulated outcome
without leaving the view results screen:

1 Click » morph, m side-by-side, or

superimposed view mode to enable adjustments.
(In morph view mode, make sure the slider is all the
way to the right.)

2 Click the button representing the scenario you wish
to adjust, if it’s not already selected.

3 Rotate the image so that you can see the entire

area that you wish to warp (for example, one entire
breast or one nipple/areola). Usually frontal is the best
orientation, but for some adjustments (for example, the
slope of the upper pole) a lateral view is best.

4 Click g to begin using the freehand warp tool.
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5 Place the cursor () over the image, then click and
drag to define the region to be adjusted. Release the
mouse button when the boundary is complete.

6 Position the cursor near the part that you wish to
warp (the cursor changes to an {m) open hand), then
click and drag in the desired direction (the cursor
changes to a §™ grabbing hand). Release the mouse
button when you are satisfied with the adjustment.

{4 For a stronger effect, click inside the defined area and
drag. For a more subtle effect, click outside the defined
area and drag.

7.9 USING MARKERS AND ADDING NOTES

Sculptor’s color markers enable you draw colored lines
on the 3D image, useful for communicating with your
patient or adding treatment planning notes for future
reference. The marker palette is displayed in the upper
right corner of the screen.

1 Click a marker button ( ) to

select its color (pink, red, purple, blue, green, or black).
The button becomes highlighted ( [l and the cursor
changes to the selected color marker ().

2 Position the cursor over the desired start point for the
line, click and drag to draw a line on the surface of the
3D image, then release the mouse button.

* To draw with a different color, select one of the other
marker buttons.

* To erase the most recent stroke, click (g undo or
press Ctrl-Z on your keyboard.
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* To clear all recently drawn marker lines at once, click
& (1o toggle visibility, click @ then @)

A Erase all mark-ups before applying Body Sculptor’s
texture tools (resurface, clone or wrinkle).

The marked up image may be saved as a 3D or 2D
image and/or printed or saved in a Sculptor report.

To record your notes and recommendations, click
in the marker palette (upper right corner of screen).

Type in the box, then click OK. Content that you enter
in the notes box will appear on notes-enabled versions
of the printed report (see 7.13 Printing Reporls).

{74 Notes are only saved to the patient chart if you save
a notes-enabled report as a PDF.

7.10 CREATING A 3D ANIMATION

1 Click @ (bottom of the screen) to open Animator.

£ Click the Animator title bar and drag to reposition
the floating dialog box as needed.

2 Use adjust viewpoint buttons to

orient the image to the rotation and zoom desired for
the first frame of the animation.

3 Click & CAPTURE New Key Frame to save this view
as Key Frame 1.

animator

* A thumbnail of the key frame appears in the
: Animator dialog. If you wish to return the image to
CAPTURE GENERATE : . ‘ ) i
new key frame animation this orientation and zoom, click the thumbnail.

* Click the trash icon if you wish to delete this key
frame.

» Optional: Adjust the amount of time the animation
should pause at this key frame.
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4 Rotate and/or zoom the image to the next position,
and then click § CAPTURE New Key Frame to save
~A this view as Key Frame 2.

animator

* A second thumbnail appears in the Animator dialog.
GENERATE

i » Optional: Adjust the interval between key frames.

* Notice that the @ GENERATE animation button is
no longer disabled. A minimum of two key frames
must be specified to generate an animation.

PRLS Repeat step 4 until you have specified all the key frames
(s) interval you wish to include in your animation. Animator will
automatically insert the in between frames (“tweens”)
to make smooth transitions between the key frames.

£4 1f you would like the animation to loop back to
Key Frame 1 at the end, click the first thumbnail,
then click ) CAPTURE New Key Frame.

Saving key frames (optional)

If you plan to reuse a particular sequence, click save
after you have specified all the key frames you wish

to include in the template. Click clear if you wish to
delete all of the key frames and start over. Click load to
automatically generate a saved sequence.

Changing the pixel dimensions (optional)

Pixel dimensions determine how large the animation
appears on screen during playback. Increasing the pixel
dimensions also increases the size of the file. Smaller file
sizes are recommended for web or e-mail.

To change the pixel dimensions, select a preset size
by clicking the radio button next to small, medium

Output Settings or large (see table on following page), or modify the
smell width EEES— values in the width and/or height fields.

medium

key fram

= | E |
& large

® o het e Y When G| link is selected, changing one dimension
will automatically change the other dimension

to maintain the aspect ratio. When i link is
unselected, the aspect ratio may be modified.
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Output Settings

small width
medium
L

custom height

large

m frames per sec. + loop

animator

GENERATE
animation

i

pause

Preset output pixel dimensions:

1 viewport 2 viewports*
small 180 x 240 pixels 360 x 240 pixels
medium 360 x 480 pixels 720 x 480 pixels
large 720 x 960 pixels 1440 x 960 pixels

*The preset pixel width is doubled for 2 viewports.

5 Select type of animation file to be generated: GIF or
MP4 video.

Changing the number of frames per second (optional)
To define the number of frames Animator will insert
for each second of playback, modify the value in the
frames per sec. field. More frames per second will
result in smoother transitions, but increase the file size.
* The recommended value for GIF is 8 to 10 FPS (more
than 12 is not recommended).
» The recommended value for video is 24 FPS.

Changing the looping option (optional)

If the loop check box is selected (H), the animation
will loop continuously. If the loop check box is
unselected, the animation will play once and then stop.
This only applies to GIF animation.

6 Make sure a minimum of two key frames have been
specified and desired output settings are selected, then
click @& GENERATE animation.

{4 The Animator dialog box retains your specified
key frames and settings until you close the image.
You may change, for example, the number of open
viewports or the view mode from color (textured) to
gray (untextured), then generate a new animation.

4 Pre-op and simulated images in
synchronized 2-viewport
animation
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Review and save a GIF animation

The GIF animation is displayed in a a floating Preview
dialog box.

Clicking the X in the upper right corner of the Preview
or Animator dialog closes the box.

Click @ to pause playback. The icon changes to .
Click @ to resume playback.

Click @ to stop playback. The animation starts at the
first frame when resumed.

Click @b to save the animation into the patient chart as
an Animated GIF Image with the file extension, “.gif”.

Review and save a video animation

The video animation is displayed ina a
floating window.

Click Il to pause playback. The icon
changes to .

Click P> to resume playback.

Click X in the upper right preview
corner to close animation ARp—
and display Preview

dialog box.

Click @ to save the animation into the
patient chart as a video.

Sp— ("4 If you close the Preview dialog box (GIF or video)
before saving, you will be prompted to save. To retain
the generated animation, click save.

don't save
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7.11 SAVING THE SIMULATED OUTCOME

g

v

v

Save

Pre-op surface (with landmarks)

T

Current simulation surface

/

Alternate simulation surface

d

discarc

1 Click [ED save (top left corner of the screen) or press
Ctrl-S on your keyboard.

2 The Save dialog opens with automatically generated
names for the pre-op image with trimming and/or
landmarks and the simulated outcome image(s).

To preserve trimming and/or landmarks that have
been applied to the pre-op image, make sure the
first checkbox is checked.

To preserve the simulated outcome for one or
both scenarios as a 3D image (.tom file), make sure
the second and/or third checkbox is checked.

If you wish to change a file name, highlight the
name and type a new name in the field.

3 Click save to save the pre-op (if checked) and
simulated 3D images into the patient chart.

{4 You will be prompted to save the simulated outcome
before you exit Breast Sculptor.
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Saving 2D images

Sculptor enables you to save a 2D version of any image
that appears on the screen into the patient chart.

When the patient chart is opened in Mirror software, 2D
images may be exported into PowerPoint presentations
or be printed for use during surgery.

(For more on printing and exporting 2D images, see
your Mirror User Guide.)

1 Make sure the orientation, zoom, and framing of the
images(s) on screen reflect the desired 2D image(s).

2 Click 2D (top left corner of the screen).

Roberts, Laura

1892

FERER

1108

constrain aspect ratio

use lossless image compression

[ single image

solid blue background color

3 Select desired image parameters:

Constrain aspect ratio is recommended to avoid
image distortion.

Lossless image compression:

Unchecked will produce a compressed
JPEG image with smaller file size and loss
of quality.

Checked will produce a PNG with larger
file size and sharper edges.

Single image: If two or three views are displayed
on screen, and single image is unchecked, a

2D image of each view will be saved. If checked, a
single image of all views will be saved.

Solid blue background color: Check to save

2D image with blue background; uncheck to save
with the viewport background color selected in
Settings (dark gray/light gray/gradient/solid).

4 Click OK.
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7.12

EDUCATION CHECKLIST

1 Click the education tab at the top of the screen to
review limitations, risks and benefits with your patient.

Breast Sculptor’s Education Checklist module enables
you to review each customizable factor, one at a
time, with appropriate diagrams and measurements
displayed to help your patient understand the factors
that will influence the outcome of her procedure.

As you check off each item reviewed, it is added to a
printable summary report for your patient to sign.

a brief description of the current item appeatrs in the top bar

N=cka

Sculptor’s view tools are
readily available

| reviewed items are identified
with a checkmark

current item title is highlighted
item overview

viewport displays patient’s
torso with diagram and
measurements for visualizing
the current item

measurement numbers may
be hidden or displayed

individualized comments may
be entered for inclusion in the
summary report

2 Review the education item with your patient using the
3D image, measurements and diagrams for reference.

3 Click 4 reviewed (upper right corner of screen)
to view the next item, or click [gg skip if you wish to
proceed to the next item without adding the current
item to the education checklist summary.
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4 After the last item has been reviewed (or skipped), a
summary of the reviewed items is displayed. Click
close to close the Education Checklist module.

If print consent form on =& o=
exit is checked, the print e

dialog opens. Select print i

options and click Print. .
You can also print the iy E
education checklist later :

in the consultation (see r -
7.13 Printing Reports). e D

Customizing the education items

Click edit (right side of the screen, below the final
education item) to open the Education Checklist Editor
dialog.

select the initial
| _view angle for

available items
are listed in the

oLl title volume difference
first list on left; | S e = the 3D image
click an item et oy skmeifincn, ol displayed for
to review/edit o this item
. The current volume of your breasts is unequal. The size
its contents of your breasts will never match.

select from

enter/edit the available
title that appears + diagrams and
in the item content measurements

overview list
I\ enter/edit the

default font is —] statement for

16 point Arial; the top of the
RGB 144-144-144 i=f item page
; XX

click + toadd select an item,  select an item, then  click reset ifyou click close when
an item, then  then click—to  click up ordown  wish to reset the you're done

enter desired remove an item to change its order entire checklist to

title, view, of appearance defaults and lose

diagram, all changes

and content
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7.13 PRINTING REPORTS

1 Click the print tab at the top of the screen to open
Sculptor’s print dialog.

* Thumbnail representations of Breast Sculptor’s report
templates are displayed in the left column. Click on a
thumbnail to view a full size preview of that report.

o Ifthe m single print
button is selected when
& print or & save
PDF is clicked, only
the “current” report
template—the one that is
shown in the full size
preview—is printed/
saved. It doesn’t matter
whether the thumbnail
is checked or not.

4 Wood Hollow R¢

Personal Breast Sculptor report for: Le

o If the &l multiple print button is selected when
& print or 8@ save PDF is clicked, only the
checked thumbnails are printed/saved. It doesn’t

Pla matter which report is being currently previewed.

4 Wood Hollow R¢

T £4 The single/multiple selectors enable you to
identify certain report templates as your standard
set for Breast Sculptor consultations while
keeping the standard set intact if a different
template, or only one of the templates, is
occasionally used.

* Click the checkbox (Jl) in the upper right corner of a
thumbnail to add that template to the report set. Click
a selected checkbox () to remove that template
from the report set.

* The most recently viewed simulated outcome is
represented in the print reports by default. To print/
save a different simulation or post-op image, click the
arrow next to the image name at the top of the screen
and select the desired image from the drop down
menu.

sim.4.68-330MP
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 If you wish your notes and recommendations to
appear on the printed report, select a notes-enabled
report template (e.g., 2 images, preop & sim, oblique,
measure & notes). Click @) notes to add or edit your
notes and personalized recommendations
for treatment.

clickzoom in clickzoom out
to see a magnified to reduce the magnification
view of the preview of the preview

2 Click gg print to open the OS Print dialog and print a
paper report, or click & save PDF to save an electronic
version of the selected report(s).

3 To exit Sculptor’s print dialog and return to the
review screen, click (%) close (top right of screen).

7.14 UPLOADING TO VIEWMYCONSULT.COM*

Breast augmentation, mastopexy and revision
simulations can be uploaded to Canfield’s secure
patient portal, ViewMyConsult.com. Licensed
educational materials can also be made available for
your patient to review while logged onto the portal.

You may upload current scenarios (up to two) at the

end of the consultation, or select a previously saved
simulation from a patient chart.

*Not available in every country. Only available to users with current
Support & Upgrade contract.
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To upload current simulation(s)

1 Click the
the screen.

upload tab at the top of

2 Complete the steps in Uploading simulations to
ViewMyConsull.com below.

To upload previously saved simulations

1 Open the patient chart that includes the images you
wish to upload to ViewMyConsult.com (see 2.2 Finding
a Patient Chart).

2 Click to select the thumbnail for the first time point,
then Shift-click to select the corresponding simulation
(or Ctrl-click to select a discontiguous thumbnail).

3 Clickopen in Comparison.
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4 Click the
the screen.

N=cka

5 Complete the steps in Uploading simulations to
ViewMyConsult.com below.

Uploading simulations to ViewMyConsult.com

1 Verify practitioner name and patient email address

Make sure the correct practitioner is selected.
(Click C to refresh list, if needed.)

Make sure the patient’s email address is correct.
Re-enter the patient’s email address.

Patient Details

Practitond™ | Nicholas Riviera MD

Patient Email ‘ Iroberts@email.com

Confim Emai | Iroberts@email.com
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Practtoner | Nicholas Riviera MD

Patent Emal | Irobertsiemail.com

-|c

Confrm Emal | Irobertsiemall.com

Select avallability of patient education materfals

B Breast Augrientaton e
[ reost Reducton

B¥ Abdomnoplisty E Lipaaction
B¥% Mommy Makegver [l #sthet voonal surgery
[ Entancements For Men Il e ana Thioh L

¥ buncks Enhancement [ oramec weighe Loss

@ show Smulation 1 first 8 show Smulation 2 first

H

B Brow 1t B eyeid
B¥ roceitc B tose

The “Select availability of

© Au Naturel Oriy B trnplant Informaton
& Bicni Only.

@ hus Maturel and Bke

patient education materials” 2 Select availability of patient education materials

pane appears only if you are
licensed to use Electronic
Procedural Brochures from
The American Society of
Aesthetic Plastic Surgery.

If you are licensed to use Electronic Procedural
Brochures from ASAPS, a selection form appears
beneath the Patient Details pane. Check the
materials you wish to make available to this patient
while logged into ViewMyConsult.com.

3 Select images to upload (if 2 scenarios are available)

Both scenarios are selected by default. Uncheck a
simulation if you do not wish to make it available.

Select the simulation to be displayed when the
portal is first opened. Simulation 1 is selected by
default.

4 Select display options

Select Au Naturel to display nude images, select
Bikini to display images with virtual bikini. To
make both options available to the patient, leave
the default Au Naturel and Bikini selected.

Uncheck Implant Information if you do not wish
to display the size and shape of the implants.
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Breast Sculptor

5 Select assessment options (bottom of screen)

Uncheck Composite if you do not wish to make
the composite assessment diagram available.

6 Click f@ Next (upper right corner of screen).

7 Authenticate

Make sure the correct Username is selected.
(Click C to refresh list, if needed.)

Enter the password for the selected Username,
if requested.

Uploader Authentication

Username ‘Nicholas.Riviera@pract'\ce.com

passvord. |

Upload Summary

Practitioner Nicholas Riviera MD
Patient Name Laura Roberts

Patient Emai Iroberts@email.com

Selected Images  pre-op, Round 286cc, Round 397cc

Display Options  Au Naturel and Biini, display implant information
Assessment Options Composite

W consent form has been signed by patient

8 Review upload summary

Review the upload summary information. If a
change is needed, click [} back (upper right
corner of screen), make adjustments as needed,
then click [ next.

9 Obtain patient consent

After the patient has signed the
patient consent form, click the
check box next to Consent form
has been signed by patient.

10 Click (@] upload.

11 Click OK in the confirmation message. Conmitation session submitted

The previous consultation screen is displayed.
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7.15 REVIEWING PREVIOUSLY CAPTURED IMAGES AND SIMULATIONS

Opening images in Comparison Mode

1 Open the patient chart that includes the images you
wish to review (see 2.2 Finding a Patient Chart).

2 Click to select the thumbnail for the first time point,
then Shift-click to select the second image (or Ctrl-click
to select a discontiguous thumbnail).

3 Clickopen in Comparison.

NOTE: Breast Sculptor software will attempt to align the
two images. Pre-op and simulated outcome images will
align closely. Pre-op and post-op will not always align
closely. This may affect some comparison tools.

Reviewing related images in Comparison Mode

The view modes available in Comparison Mode are
similar to those in 7.8 Viewing the Simulated Outcome.

side-by-side
(default view)

morph between
the two

circumferential
measurements

superimposed

color surface by distance

Side-by-side view mode in Comparison

The initial viewing option displays a side-by-side
comparison of the images. To return to this side-by-side
view at any time, click m
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Morph view mode in Comparison
To display a single image with a slider for morphing
between the two images, click »

Drag the slider bubble to display the original image, the
simulated outcome, or any point in between:

i ] A ] 200N

If the second image is a simulated outcome based on
the first image,* then vector analysis arrows will be
available to show direction and amount of change.
To display the colored vector arrows, click

@ vector analysis. Click again to toggle off.

Click @ to auto-animate the morph (with or without
VeCtor arrows).

Click @ to quickly switch between time points.

Click one of the @@ buttons to decrease or increase the
size of the vector arrows.

*Vector analysis is not available for post-op images.
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Superimposed view mode in Comparison

I® to view the first image opaque,
overlaid with the second image, semi-
transparent.

Click e to toggle opacity between the
two images.

Color surface by distance view mode in Comparison

to generate a color-coded view of the volume
differences between the images. Blue represents the
greatest increased volume and yellow represents the
greatest decreased volume between the two images.
Intermediate values are represented by corresponding
intermediate colors.

A scale along the left edge of the viewport shows the
amount of change associated with each color.

N=cka ==

Click e texture to show normal skin
tone and texture; click again to toggle off.

\=cka H =

Click contours to reveal contour
lines; click again to toggle off.
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7.16 CUSTOMIZING BREAST SCULPTORl

1 GENERAL tab

General

The text and logo fntered here will appear at the top of every

your practice name

Click E@ences (top left corner of the screen) to

open the preferences dialog box or click [ setup from
the VECTRA home screen.

» Enter your name or the name of your practice as you
wish for it to appear at the top of every printed report.

* Enter your contact information, such as address,
phone number, website. This will appear at the top of
every printed report, below your practice name.

f4 The Practice Name field and the Contact Information
field can each contain one line of text. Print a test to
make sure your information fits the template.

L« To add your logo to

e the top of every printed

‘ Plastic Surgery Center

| report, click select logo,

your contact information (all in one line) W

browse to the .png, .jpg or

[4 Wood Hollow Road / Parsippany, NJ 07054 USA / +1.973.434.1200

Background color for 3D images in printreport  [Jl] W

The text entered here will be superimposed over simulation images.

‘ jpeg you wish to use, click

\ Open. A thumbnail of your

U.S. English [+]

Select desired appearance of the viewport background in Sculptor.

@ dark gray (defauk)

O light gray

@ gradient (defauk)

O sold

[ sound notification

[] Show patient name in export fie name

‘simulation only: actual surgical results will vary \ m logo appears in the bOX
Language

e Click to select a different
background color for 3D
images in printed reports
(default color is blue).

N

o If desired, modify or
delete the disclaimer

[] Show look up butth in patient chart (This optiocould expose private patient information.) . .
that is displayed over

Version 6.10.1 built Jul 07 2020 11:19

— simulations.

If desired, change the viewport background.
» If desired, click to turn off sound notification.

 If desired, select checkbox to show patient name in
export file name.

* If desired, select checkbox to make the “look up”
button available in patient chart. /A\ This option
could expose private patient information.
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2 DATABASE tab

¢ Click on the Database tab if you wish to switch to a
/ different database.

* Each patient’s profile picture is
E—— | displayed in the Look Up Patient search
results. To hide profile pictures in search
results uncheck show profile picture
in the lower left corner or the dialog.

3 CAPTURE tab

Click on the Capture tab if you wish to
change the connected capture system.

connected capture system
VECTRA H2

4 BREAST/BODY tab—workflow sequence

Sl s — Select or deselect the modules you

s /_§ wish to be displayed. These changes

' take effect after you close and reopen
y ' Sculptor.

5 BREAST/BODY tab—display & capture options

image softness factor Sclect “minimal”,
“moderate”, or “maximum” to
de-emphasize imperfections of the skin
by softening the texture for all breast
images.

mage texture to de-emphasiz imperfections of the

6 BREAST/BODY tab—adjustments & assessments

adjustments
3 v

« implant height offset Enter a value (mm) or use

—— the arrows if you wish to change the default implant
Specify default adjustment to implant height position height Oﬂ:set fOr round al’ld/OI‘ Shaped implaﬂts

round \mp\am mm

shaped \mp\an[ mm
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Breast/Body

adjustments &
assessments

implant height offset show/hide

automation

Specify default adjustment to implant height position. Checked items are shown; uncheck to hide.
round implant mm [A bra sze
shaped implant mm [ composte
[ distance
Soft tissue pinch thickness [ projection \
ey 7 s e (el e s s e v [ chest veal
select highlighted implants [ refect
[A symmetry
[ oblque

soft tissue pinch thickness Enter a value (mm) or
use the arrows if you wish to change the default soft
tissue pinch thickness which is used to identify which
implants are highlighted in the implant selector chart
(see 7.7 Simulating an Augmentation Qutcome).

show/hide Uncheck “bra size” if you wish to hide
estimated cup size in the implant selector. If you wish
to disable some or all of Breast Sculptor’s assessment
diagrams and modes (see 7.4 Assessment), uncheck
the corresponding name.

7 BREAST/BODY tab—automation

[ place landmarks
[ crop breast image
[ highiight implant range

TYPE

round saline

round gel

 If desired, select “crop
stitched H2 torso image”
checkbox to automatically

Breast/Body.

automation

L] crop stiched H2 torso image Crop VECTRA H2 torso

TYPE

shaded cohesivirgel round gel shaped cohesive gel

N\

images after they are
stitched.

Uncheck “place landmarks” if you wish to turn off
automatic placement of landmarks.

Uncheck “crop image” if you wish to turn oft
automatic cropping of breast images.

Uncheck “highlight implant range” if you do not
wish implants that meet the selected criteria to be
highlighted in the implant selector.
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¢ Preset implant option
If you wish to bypass the
e s s s step of selecting implants
I o | from the full chart,
e — s —— specify implant criteria
# 5‘ for one or two scenarios.
Breast Sculptor uses the
implant criteria you pre-
select combined with
20 implars meettese rera TS T R the patient’s breast meas-

urements to create two
scenarios for review.

Version 6.10.1 built Jul 07 2020 11:19

After you have made your selections, click the
close button to apply.

7.17 EXITING BREAST SCULPTOR

* To close Breast Sculptor and display the VECTRA
patient chart, click the VECTRA logo in the upper left
corner of the screen or click the |jgg in the upper
right corner of the screen.

* To close Breast Sculptor and display the current
image in VECTRA Analysis Module, click (8 in the
upper left corner of the screen.

* To exit VECTRA software completely, click the
VECTRA logo from a patient chart to return to the
home screen, then
click g exit in the
lower right corner
of the screen.
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VECTRA Analysis Module (VAM) Overview

The VECTRA Analysis Module may be accessed from
the VECTRA Patient Chart (see Chapter 2: The VECTRA
Patient Chart) or it may run as a module within Mirror®
imaging software (see 9.1 _The Mirror Patient Chart).

NOTE: The term “surface” refers to any 3D object,
image, or part of an image displayed in a viewport.

8.1 THE VECTRA ANALYSIS MODULE SCREEN

toolbars menus viewport Surface View Selectors master Surface View Selectors

(see section 8.2) (see 8.3-8.12) (see below) (see below)
AL B4 © @ A e X [, - e e—

|

Log wir}dow (data display) view\;/)orts
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Chapter 8 VECTRA Analysis Module (VAM) Overview

Surface View Selector

The Surface View Selector controls the selection
(whether the image is active) and visibility of the
open image. Each open image is controlled by its own
Surface View Selector.

A master Surface View Selector for each open image is
/— located at the top of the screen on the toolbar. Changes

[ Q in a master Surface View Selector will affect its image in
all viewports.

-

E’é Rhino - postop-1.tom

The visibility of the master Surface View Selector(s) is
controlled by checking or unchecking Preferences »
Show » v Surface View Selector.

The master Surface View Selector(s) may display the
name of the image (“surface”) next to or below the
image icon (see 8.12 The Preferences Menu, Surface
View Selector for more on hiding/displaying Surface
View Selector features).

A viewport Surface View Selector for each open image
is located in the upper left corner of each viewport if
¥ show selector in each viewport is checked
(Preferences » Surface View Selector » show
selector in each viewport). Changes in a viewport
Surface View Selector will affect only its image in that
viewport. When “show selector in each viewport” is

checked, the viewport selector(s) may be retracted or
extended by clicking the arrow next to the selector(s).

The left side of the Surface View Selector contains an
iconic representation of the image that it controls.
When it appears selected (pressed), the image is active.
When it appears deselected, the image is inactive and
activeimage inactiveimage  appears translucent in the viewport (if it is visible).

The right side of the Surface View Selector controls the

< visibility of its image. When the eye appears selected
(pressed), the image is visible. When the eye appears
deselected, the image is hidden.

G

visible image hidden image
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VECTRA Analysis Module (VAM) Overview

(Note: Animage cannot

selected/active image inactive visible image inactive hidden image be active if it is hidden.)

click to make the click to hide
image inactive the image

8.2 TOOLBARS

Horizontal toolbar buttons

import 3D object from directory location

snap grid to nearest 90° alignment

rock view

rotate viewport 1 back and forth continuously

view image with smooth shading

flat shading

view image with flat shading

wireframe

view image in wireframe

r_“.@

e smooth shading
r:.

f’

outline view

view image outline only

textured

view image with texture (looks like skin)

textured + lit

view image with texture + artificial light

untextured

view image only—no texture (looks like clay)

color by distance

view false color map (if created)

perspective

perspective (with depth) view

orthographic

orthographic (flat) view

1 viewport

show 1 viewport

2 viewports (vertical split)

show 2 viewports with vertical split

2 viewports (horizontal split)

show 2 viewports with horizontal split

4 viewports

show 4 viewports

6 standard views

generate 6 standard + 2 custom views

show axis grid

HEODEHOY "E@E@

turn on all axis grids (x, y, 2)
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EA highlight selected views outline selected images

@ * « - @ Dbrushsizeselector choose size of Area Selection brush

QL‘;I Face Sculptor® switch to Face Sculptor 3D aesthetic simulation
Qq@' Body Sculptor® switch to Body Sculptor 3D aesthetic simulation
(u_’j Breast Sculptor® switch to Breast Sculptor 3D aesthetic simulation

Viewport Extras toolbar buttons This set of buttons becomes available by
selecting Preferences » Show » v Viewport Extras.

side-by-side show one image in each of two viewports

@ synchronize viewports lock/unlock synchronization between viewports
c'é spin X spin point-of-view around X axis only

C‘% spinY spin point-of-view around Y axis only

C‘% spin Z spin point-of-view around Z axis only

Vertical toolbar buttons

% selectviews select image in viewport

i& spin spin point-of-view

'{é} pan pan point-of-view right, left, up, or down

Q@ zoom zoom point-of-view (increase/decrease magnification)
'{:]@ roll roll point-of-view

5@ dolly zoom move closer to image

;{% contrazoom zoom with perspective distortion

E\?j paint area selection select area by painting over the image

Eﬁj erase area selection subtract from selection by painting over selected area
[:S‘F open loop points draw a curved line by clicking a series of points

DSQ closed loop points select area by clicking points around its perimeter
@j’:_ select area by lasso select area by drawing a line around its perimeter

& erase area by lasso draw over selected area to subtract from selection

[:[n box crop draw a box and delete everything outside of it
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’gf’ﬁ] spin active surfaces spin image spatial orientation

'%'@ pan active surfaces pan image spatial orientation

Gjﬂ, roll active surfaces roll image spatial orientation

LE, place landmarks place landmarks on image

Ty select landmarks select placed landmarks (hold shift key for multiple)
fer circumference measure the circumference of a surface

Point-of-view

The direction from which the image is viewed.

The image retains its spatial orientation relative to
the axis grid as the point of view moves (see 8.70 The
Surface Menuw). Tools of this type move the axis grid
and the image, and are identified by an eye:

& b GG

Spatial orientation

The viewing direction remains the same and the image
moves relative to the axis grid (see 8.10 The Surface
Menut). This action changes the spatial orientation of

the image and will nullify registration of images if the
change is saved. Use only as directed and in the manner
described. Tools of this type are identified with a cube:

& @ O
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8.3 ABOUT THE MENUS

VECTRA Analysis Module (VAM) Overview

File Edit WView Landmarks Loops Area Surface Measure Scripts  Preferences  Sculptor  Help

8.4 THE FILE MENU

The following sections briefly describe all of the
commands that may appear in the main menus.

Many of the functions provided in the menus are also
available in the toolbars. Available keyboard shortcuts
are noted [in brackets].

Edit Wiew Landmarks Area Surface

Open Patient Chart...
[Ctrl + O]
(only if opened from Mirror)

Search for Patient...
[Ctrl + Q]
(only if opened from Mirror)

Search for Images...

Open Patient Chart... Ctrl+O

. Search for Patient... cirl
View the current ) iafs

patient’s chart in Mirror

Search for Images...

=]

] . |@ Import.
(see Mirror U§er Guide, - Ctrl+W
Chapter 7). Click 2
i . Save..
arrow in upper right S
port...
corner of the screen to Export PDF..
return to VAM. Save 2D Image(s)
Locate a patient record il
in Mirror’s Patient Open Image as a Flat Surface ...
Search tab (see Mirror Open Background Image...
User Guide, Chapter 7). RartiSeript
Click # arrow in -
I

upper right corner of
the screen to return to VAM.

Locate an image in Mirror’s Image Search tab (see

(only if opened from Mirror) Mirror User Guide, Chapter 7). Click % | arrow in upper

Import...

Close [Ctrl + W]

Save...

right corner of the screen to return to VAM.

Import 3D files (with suffixes .obj, .stl, .tsb, or .tom):
Browse to the desired file, select it, and click Open. The
image opens in VAM.

Close active image(s).

Opens a dialog box that enables the user to enter a new
name for an image that has been captured, imported, or
altered. A thumbnail with the new name will be added
to the open Patient Chart.
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Export...

Export PDF...

Save 2D Image(s)

Create Animation...

Open Image as
a Flat Surface...

Open Background
Image...

Run Script...

Exit

8.5 THE EDIT MENU

Exports the active image as a .tom file to the selected
directory location.

Exports the active image(s) as a 3D PDF file to the
selected directory location.

The current view in each viewport is saved as a two-
dimensional image in the currently open Patient Chart.

Opens the Animator dialog for creating an Animated
GIF Image with the file extension, “.gif”.

Opens a two-dimensional image (.png, .jpg, or .jpeg) as
a flat surface in the plane selected.

Opens a two-dimensional image (.png, .jpg, or .jpeg) as
the background/wallpaper for the viewport.

Enables the user to run pre-configured scripts.

Closes VECTRA Analysis Module and returns the user to
the patient chart.

‘u‘iew Landmarks Area Surface

&7 Undo: Viewpoint Zoom Ctrl+Z

Undo [Ctrl + Z]

Redo [Ctrl + Y]

Delete Selected Area

Delete Selected
Landmarks

Delete All Landmarks

Cx  Redo: Viewpeint Ctrl+Y
Undoes the last action
(in this example, undo
Viewpoint Zoom).

Delete Selected Area Del
Delete Selected Landmarks
Delete All Landmarks

Enables the user to redo the last action that was undone
(in this example, redo Viewpoint).

Deletes the area of the image that has been selected.

Deletes landmarks that have been selected.

Deletes all landmarks, regardless of whether they are
selected or not selected.
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8.6 THE VIEW MENU

Landmarks  Arez

%, Spin [S]

@ Zoom [Z]

%5, Pan [P]

@ Roll

Fit View

@ Snap View

“@ Rock View

% Spin 5
Spin, Pan, and Roll enable the user %, Zoom z
to change the point of view without %, Pan P
moving the image in relation to the @ ol
axis grld Fit View

6 Snap View

These tools move the image and the
grid; the image is locked in its spatial
orientation relative to the axis grid.

“a RockView

Shading

3

Texture 3

This operation is different from the Lighting ¢
Spin (Pan or Roll) Active Surfaces Specularity ¥
operation which moves the spatial P
orientation of the image in relation z:g:: :
to the axis grid (see 8.10 The Surface Pl s

Menu).

Rotates the image freely in any plane.
[Alt + left mouse button temporarily
enables the Spin tool. ]

Increases or decreases the magnification of the image:
Click in the image and drag up (to decrease) or down
(to increase), or rotate the scroll wheel on the mouse (if
your mouse has this feature).

Moves the image left, right, up, or down within the
viewport—x and y axes only. [Alt + right mouse
button temporarily enables the Pan tool.]

Rotates the image in the XY plane.

Changes the magnification of the image to the
maximum size that will fit within the Viewport.

Automatically moves/rotates the image to the nearest
90-degree alignment.

The image(s) in viewport 1 continuously rotate back
and forth (side to side) by approximately 45 degrees in
each direction. Click %5, Rock View (in the toolbar or
menu selection) to stop the rotation.
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Shading »

Texture »

Lighting »

@

¢
&

el

Smooth Shading—This is the default view. When
viewed in this mode, the image geometry is smoothed
to create a more aesthetically pleasing appearance.

Flat Shading—Displays the image as flat-sided
polygons representative of raw capture data.

Wire Frame—Displays the image as the geometric
triangles that comprise the image. This view may be
used to understand the image in greater detail.

Show Outline Only—Only the outline of the image is
displayed (to demonstrate contour lines).

Textured—This is the normal view, the image as
originally captured or imported. Skin color and texture
are visible.

Textured + Lit—Adds artificial lighting, such as
shadows or highlights, for a clearer view of targeted
areas. To change the lighting, use the Lighting options
explained in the next section.

Untextured—Removes color texture detail leaving an
image that visually represents the geometric data.

Color by Distance—Displays the results of the Color
Surface by Distance tool (see Using “Color Surface

by Distance” in section 10.1) if it has been previously
executed for the selected image(s).

This feature works in conjunction with Textured + Lit
(see above). Four Lighting options are available.*

classic—Adds artificial lighting as if one light is shining
on the image from the front, top, left side.

front 2 top light—Adds artificial lighting as if two
lights are shining on the image from the top. This is the
default light setting.

front light—Adds artificial lighting as if one light is
shining on the image from the front.

*Additional Lighting sources andy/or Specularity options may be defined as needed—
contact Canfield Scientific, Inc..
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Specularity »

Projection »

Distance »

o o

front top light—Adds artificial lighting as if one light is
shining on the image from the top.

vectra3face—Lighting used in Face Sculptor.
vectra3torso—Lighting used in Body/Breast Sculptor.
capture lighting—Lighting used when image was

captured.

This feature works in conjunction with Untextured
and Lighting (see above). Four Specularity options are
available.*

Matt—Displays the image in a matte finish. This is the
default specularity setting.

Slightly Shiny—Displays the image in a slightly shiny
finish.

Medium Shiny—Displays the image in a moderately
shiny finish.

Shiny—Displays the image in the maximum shiny
finish.

The image may be viewed with or without depth.
Perspective—Provides depth to the image.
Orthographic—Displays the image as if it were flat.
Two ways to zoom the user’s point of view in relation to
the image.

Dolly Zoom—Gives the effect of the viewer moving
closer to or farther from the image. To dolly zoom, click
in the image and drag up to move farther from the
image or drag down to move closer to the image.

Contra Zoom—Zooms the point-of-view with perspec-
tive distortion (the rear of the image remains in place
while the front of the image moves toward the viewer).

*Additional Lighting sources and/or Specularity options may be defined as needed—
contact Canfield Scientific, Inc..
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Axis Grid » HH Show Axis Grids [G]l—Display (or hide) the
three-dimensional axis grids for all planes.
Show XY Plane—Show/hide the grid in the XY plane.
v Show YZ Plane—Show/hide the grid in the YZ plane.
v Show ZX Plane—Show/hide the grid in the ZX plane.
Viewports » Five presets enable simultaneous display of different
images, or different views of the same image.
|:| 1 Viewport—A single viewport is displayed.
ED 2 Viewports—Two viewports are displayed side-by-side
vertically.
E 2 Viewports—Two viewports are displayed side-by-side
horizontally.
HH 4 Viewports—Four viewports within a 2 x 2 grid.
@ 6 Standard Views—Eight viewports within a 2 x 4 grid
(six standard views and two custom views).
8.7 THE LANDMARKS MENU i
Select »
Measurements are based on s :
. . Create Named Landmarks...
landmarks: significant user-
. . Delete Selected Landmarks
defined points on the image. L]
Project Selected Landmarks
Select » All—Select all landmarks. T
None—Deselect all landmarks. i:::’
Tools» - ®m Place Landmarks—Create auto-numbered landmarks.
[%0 Select Landmarks—Select previously created

landmarks. To select multiple landmarks, press and hold
the Shift key after the first landmark selection.

£ [Ctrl] toggles between selection and deselection

of landmarks, as well as between the placement of
landmarks and the deselection of landmarks.

For example, press the Ctrl key while using Place
Landmarks to deselect a previously placed landmark.
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Create Named
Landmarks...

Delete Selected
Landmarks

Delete All Landmarks

Project Selected
Landmarks

Display Coordinates

Opens the Named Landmarks window for placing
landmarks that are assigned and named according to a
preset list and are then used to generate a pre-defined
set of calculations.

Deletes landmarks that have been selected. (The same
command is available from the Edit menu.)

Deletes all landmarks, regardless of whether they are
selected or not selected.

Project selected landmarks onto a different image.

£ Landmarks can be properly projected only onto an

image that has already been registered to the image on
which the landmarks were created.

The values for the X, Y, and Z coordinates for all
selected landmarks are displayed in the Log window.

Show Show all previously hidden landmarks.
Hide Hide all landmarks.
8.8 THE LOOPS MENU roope ] Area Su
Tools 4
Show All
Tools» h&‘f Pick Multiple Points for Open Loop— Hide Al
Draw a smooth curved line by clicking Delete Al
a series of points.
th;j Pick Multiple Points for Closed Loop—Select a
smooth curved area by clicking points around its
add to selected area perimeter. Click counter-clockwise to select area inside,
subtract from selected area clockwise to select area outside of the perimeter. Then
replace selected area right-click and choose “add to selected area” to create a
save as loop marked area, or “subtract from selected area” to erase
reset this area from an existing marked area.
Show All Show all loops that have been saved with names.
Hide All Hide all loops that have been saved with names.
Delete All Delete all loops that have been saved with names.

VECTRA H2 User Guide [EFER



Chapter 8 VECTRA Analysis Module (VAM) Overview

8.9 THE AREA MENU

Surface  Measure  Preferer

Select +

Select )

Tools »

Tools »
All—Select all active image Copy Selected Area
areas. Delete Selected Area Del
Project Selected Area
Clear—Deselect all image Show
areas. Hide

Inverse—Inverse the selected areas: The areas of the
image that were not selected become selected and vice
versa.

Extend Using Landmarks—A selection method:
Click %, place landmarks and then click at several
points around the perimeter of the area you wish
to select. Select Area b Select p Extend Using
Landmarks. The landmark dots are connected and
filled in as a selection.

Reduce Using Landmarks—Subtract from the
selected area by defining a series of landmarks to create
the shape that should be deselected.

L4 1f the landmarks are placed in a clockwise order, the

area outside of the shape will be selected/deselected. If
the landmarks are placed in a counter-clockwise order,
the area inside of the shape will be selected/deselected.

Paint Area Selection—Select area by painting over the
image.

Erase Area Selection—Subtract from selection by
painting over selected area.

Select Area By Boundary—Select area by drawing its
boundary. Drawing in a counter-clockwise direction
selects the area inside of the shape. Drawing in a clock-
wise direction selects the area outside of the shape.

Erase Area By Boundary—Draw boundary of an area
to subtract from selection. Drawing in a counter-clockwise
direction subtracts the area inside of the shape. Drawing
in a clockwise direction subtracts the area outside of the
shape.
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£ [Ctrl] toggles between the Paint and Erase functions of
Area Selection, as well as between the Select and Erase
functions of Area By Boundary. For example, press the
Ctrl key while using Paint Area Selection to temporarily
switch to Erase Area Selection.

Copy Selected Area Create a new image from the selected area.
Delete Selected Area Remove the image within the selected area.
Project Selected Area Project a selected area onto a different image.

£ An area can be properly projected only onto an image
that has already been registered to the image on which
the area was created.

Show Show all previously hidden image area selections.

Hide Hide all image area selections.

8.10 THE SURFACE MENU Measure  Preferences  Scu
Tools 3

Tools» l; Select Views of Surfaces— Regtey Duferce.

i ithi i ; Find Symmet
Click within an inactive ind Symmetry

image to make it active; all
other open images become
inactive.

Flip Crientation

Stitch Surfaces

Fill Smallest Hole

+/- Volumes

Split at Plane 4
Reflect in Plane 3

£4 The next three tools (Spin
Active Surfaces, Pan Active
Surfaces, and Roll Active
Surfaces) move the image
relative to the axis grid while the point of view remains
the same.

Copy and Reflect in Plane 3

Reset Crientation and Position

This action changes the spatial orientation of the image
and will nullify registration of images if the change is saved.
(See section 8.6 The View Menu for tools that move the
point of view and not the image.)

The difference between View menu tools and Surface
menu tools becomes more apparent when the == Axis
Grid is visible (View » Axis Grid » Show Axis Grid):
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View / Spin:
The point of view
moves while the
image retains its
spatial orientation
relative to the grid.

Spin Active
Surfaces:

The image moves
relative to the axis
grid while the point
of view is fixed.

ﬁﬂ Spin Active Surfaces—Rotates the image freely in any
plane, independent of the axis grid.

g Pan Active Surfaces—Moves the image left, right,
up, or down within the viewport—x and y axes only—
independent of the axis grid.

GJ@ Roll Active Surfaces—Rotates the image in the XY
plane, independent of the axis grid.

Register Surfaces... Enables the user to register two or more images so that
they are aligned as closely as possible. This is useful
for visual image comparison and necessary for some
analytical processes.

Find Symmetry Enables the user to establish midline symmetry—useful
for evaluation and for registering two images.

Flip Orientation Enables the user to change the orientation of a surface
view from outside to inside, or from inside to outside.
£ The result is discernible only if Show Reverse in
Different Color is selected from the Preferences menu.

Stitch Surfaces Enables the user to create a volumetric shape by joining
(stitching) two surfaces together. This is useful for
measuring difference in volume between two registered
images, such as pre- and post-op.

Fill Smallest Hole Enables the user to fill gaps in the surface. The software
will identify the smallest hole in the surface and fill it.
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+/- Volumes

Split at Plane »

Reflect in Plane »

Copy and Reflect
in Plane »

Selecting this option a second time will cause the second
smallest hole to be filled. This process can be repeated
as many times as necessary to fill the holes in a surface.
NOTE: The filled surface will be untextured.

Allows the positive and negative volume components
to be separated from any closed, or solid model, surface
that has been generated using the Volume Between
Two Surfaces (difference model) tool, created using
advanced stitching techniques, or imported from a
directory location. This will result in the creation of two
surface models, one representing positive volumes and
one representing negative volumes.

Divides the image based on the selected plane and
reports the volume for each half in the Log window.

3 Landmarks—The plane is based on three
user-placed landmarks.

£ The order in which landmarks are placed determines

the values of the measurements.

X = 0—The plane is based on the zero-point of
the X-axis of the grid.

Y = 0—The plane is based on the zero-point of
the Y-axis of the grid.

Z = 0—The plane is based on the zero-point of
the Z-axis of the grid.

£ The term “In front of split” refers to positive values in

relation to the axis grid, and the term “Behind split”
refers to negative values in relation to the axis grid.

Reflects the image around the X, Y, or Z axis. The result
is a mirror image of the original.

A copy of the image is created and reflected around the
X, Y, or Z axis or a user-defined plane. The result is a
mirrored copy of the original image. The user may then
overlay the original with its reflection, or display the
two views side by side.
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Reset Orientation
and Position

Restores the original orientation and position of the
image as it was captured or last saved. If Spin, Pan,
and/or Roll Active Surfaces has been applied to
change the spatial orientation of the image, the image
will be reset to its original captured orientation and
position. (Selecting this menu item will have no effect
on Viewpoint Spin, Pan, or Roll.)

8.11 THE MEASURE MENU _ Preferences Scul.ptor
Distance 3
Distance » Straight Line Between Circumference at Plane
Landmarks—Measures the ingk

Circumference at Plane »

straight-line distance between
two landmarks regardless of the
surface topography.

3
[
Area 3
Volume 3

3

Color

Across Surface Between Landmarks—Measures
the shortest surface distance along a path defined by
landmarks.

Landmark to Surface—Measures the distance
between selected landmark(s) on one image and the
nearest point on a second active image.

Perimeter of Selected Area—Measures the perimeter
of a selected area, such as the perimeter of a lesion on a
patient’s skin.

Color Surface by Distance...—Calculates the
distances between two images and colors the images
according to the measurement data for visual feedback.
Numerical data for min., max., RMS, mean, and standard
deviation is also displayed. Useful for measuring
accuracy of registration and identifying regions of
dimensional difference. These regions can be selected
and then separated and further analyzed.

Circumference is measured at the cross-section

of a user-selected plane and selected image. Each
measurement is displayed in the Log window.
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Angle )

Area )

Volume »

3 Landmarks—The plane is defined by three
user-selected landmarks.

X, Y, or z=n—The plane is \J Select Plane @1
defined by a user-selected point
(n) along the selected axis

(x,Y, or z). [(measwe | [ cose |
The orientation of the image to

the grid will determine where

the cross-section will be created.

from 3 Landmarks—Measures the angle formed at
landmark 2 by landmarks 1 and 3 on the selected image.

of selection—Measures the area of the selected region.
of surface—Measures the area of active image(s).
Values are displayed in the Log window.

to Interpolating Surface—Uses a mathematical
algorithm to generate an independent interpolating
surface based on the selected area. The volume between
the interpolating surface and the original surface is then
calculated and reported in the Log window.

of Closed Surface—Measures the volume of an object
that is completely enclosed.

Between Two Surfaces (difference object)—
Measures the volume between two registered images
by calculating the volume between a selected area on
one image and the corresponding area on the other
(registered) image. A closed model of the difference
volume is created as a new image. The volume
difference (or closed model) volume is reported in the
Log window.

Between Two Surfaces (parallel projection)—
Measures the difference in volume between similar
areas on two different images, the second image being
projected parallel to a plane on the first.
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Color)»

8.12 THE PREFERENCES MENU

Measures and displays color for the # Textured
(normal skin-tone) view of the image.

Display RGB Values for Landmarks—Displays the
RGB (Red, Green, Blue) values at each landmark (dot).

Display Average RGB Values for Selected Area—
Displays the average of the values for each color (Red,
Green, Blue) for the selected area, as well as the size
of the selection (in pixels) and the standard deviation
within the sample.

Set White Point for CIE Measurements—Enables the
user to set the white point for CIE measurements .

Display Average CIE L*a*b* Value for Selected
Area—Displays the average of the values for each
aspect of the Lab color space for the selected area,
as well as the size of the selection (in pixels) and the
standard deviation within the sample.

Sculptor  Help

A Select Color

HEEEEEOEC

Custom colors

.
I

Background Colour...

Background Color...— [ Stk olan
Opens the Select COIOr ¥ Show Reverse in Different Colour
. . Reverse Surface Colour...
dialog box for changing o
h b Kk d | f Show Reverse in Wireframe
the background color o | @ Highlight Selected Views
the VIeWport- Surface View Selector >
Show +
Surface Color...—Opens Advanced v

the Select color dialog
box for changing the image color.

£ The image color is visible only when ¥ Untextured

view is selected.
Show Reverse in Different Color—Displays the

reverse (inside or rear) of a surface in a different color
from the outside (front).
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@

Surface View Selector »

Reverse Surface Color—Opens the Select color
dialog box for changing the color of the reverse (inside)
surface.

Show Reverse in Wireframe—Displays the reverse
(inside) of a surface in € Wireframe view.

Highlight Selected Views—Displays an outline
around the edge of the image.

Enables the user to customize the display of surface
view indicators on screen.

Surface View Selector » | showsurface names

Show 4 surface names below icons

Advanced 4 horizontal layout

v

show surface names displays the image name to the
right of the icon (rather than the icon only).

surface names below icons displays the image name
centered below its icon (rather than next to it).

horizontal layout displays the surface view
information horizontally across the top of the screen
(rather than stacked vertically). This option makes a
difference only if more than one image is open.

show selector in each viewport displays a separate
Surface View Selector in the upper left corner of each
viewport, enabling the user to show or hide images
separately for each viewport. This option makes a
difference only if more than one viewport is displayed.
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Show »

<.

Enables the user to customize availability of tools and
information on screen.

Show L2 Color Surface by Distance
Advanced LaNIRvS Log

Landmark List

v | Tools
v Mouse Tools
Draw Area Selection
v Brush Sizes
v | Viewport Extras
v Surface View Selector

Color Surface by Distance makes the Color Surface
by Distance dialog box visible.

Log makes the list of measurements and data visible.

Landmark List makes the Landmark List dialog box
visible.

Tools makes the toolbar at the top of the screen visible.
Mouse Tools makes the vertical toolbar visible.

Draw Area Selection makes additional selection tools
available in the vertical toolbar: k¢ select area by
boundary and % # erase area by boundary.

Brush Sizes makes the brush sizes drop down menu
visible at the top of the screen.

Viewport Extras makes additional toolbar buttons

available at the top of the screen: Eﬂ ’-‘é ""% "%

Surface View Selector makes the Surface View
Selector visible.
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8.13 NAVIGATING THE SOFTWARE

Software features are accessed by selecting commands
from the main menus or by clicking buttons on the
toolbars. Which commands are available depends upon
the current state of the program (whether any images
are open/selected, etc.).

Dialog boxes

Some commands (Open Patient Chart, for example)
cause a dialog box to appear. A dialog box allows you
to enter information, make selections or choose settings
for the current operation.

When settings and data in a dialog box appear as you
wish, you can execute the command by clicking a
button that is typically marked with a descriptive label
(Save, Import, etc.) or simply OK.

Most dialog boxes also contain a Cancel button.
Clicking Cancel closes the dialog box without
executing the command. Any data entered prior to
clicking Cancel is discarded.

Moving

Moving the mouse will cause the cursor (pointer) to
move on the screen.

Clicking

To “click”, move the mouse to position the cursor over
the desired area, then press and release the left mouse
button.

Right-clicking

To “right-click” press and release the right mouse button.
A right-click is used to select from a contextual pop-up
menu.
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8.14 THE FILING SYSTEM

File management occurs within a database that is
made up of individual patient records. Each patient
record contains data pertaining to that patient (name,
ID number, date of birth, etc.) along with images that
have been saved for that patient. Each image may
have additional data associated with it (image date,
procedure, etc.).

A SQL database is used to store the data. The images
and associated capture data are stored in individual
image directories. The system may be configured to
store the database and/or images on the local computer
or on a network server. The number of patient records
and images you can store in the database is primarily
dependent upon the capacity of the hard drive or
server.

8.15 CUSTOMIZING VECTRA ANALYSIS MODULE

You can move or close toolbars and sub-windows in
VECTRA Analysis Module. For example, you can detach
the Log window from the bottom of the frame and
make it float in front of the viewport anywhere on the
screen.

The viewport background color is customizable:
Select Preferences » Background Color... to open
the Select color dialog box. Select desired color and
click OK.

The color of & Untextured images is also
customizable: Select Preferences » Surface Color...
to open the Select color dialog box. Select desired
color and click OK.

£ Changes to toolbar or sub-window size or position,
background color, or image color will be retained when
you restart VECTRA Analysis Module.
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9.1 THE MIRROR PATIENT CHART

Finding and opening an existing patient record

1 Double-lick the @ Mirror icon on the Windows
desktop to open Mirror software.

2 Select File » Search for Patient, or click
the Patient Search tab on the right edge
of the screen.

3 If the fields are not empty,

click Clear search | Clear Search.

%“5“' I,;-wl fﬁwg 'I

e B €|
Clear Search 4{00% Patient Al | MNone | |sort by st name > MATCHES: 0 SELECTED: 0 =]

PATIENT DATA
LAST NAME FIRST NAME

Se) :/

Image Data
B

=
=1
2
=l
mn

AN SOCIAL SECLRITY.

Chart

~DATE OF BIRTH
FROM | o |

Enter search criteria
to display matching patients.

SEX RACE

IMAGE DATA

,/lmage Search\ / Patient Search \ / Chart \/lmage Dala\

IMAGE ATTRIBUTES
[ visa view

[ <selection list>

Lol
l<lelulolzlel=lolz |2 |r x|« [~ = |o|n |m o o

Image Search \/Patient Search
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Cear Search | T privacy

PATIENT DATA

Open Patient

FIRST NAME

| none | [sor by last name v

MDDLE

LAST NAME
%

MEN

[iaurd

DATE OF BIRTH

FROM

SEX RACE

h \/Patient Search \/ Chart \/image Data

IMAGE ATTRIBUTES

SOCIAL SECLAITY.
o

IMAGE DATA

Ll

\mage

il<lelHlelzlol=lolz|zln x|z =z ]a n|m|o o= >

MATCHES: 2 SELECTED: 1

Moore, Laura
MAN SSH:
DOE. SEXF  RACE.

Roberts, Laura
MAN. SSi:
DOB:1/8/1972 SEXF  RACE

4 Enter search criteria such as the
S~ patient’s name, date of birth, or
social security number. Thumbnail
images for patient(s) who fit the
criteria will be displayed.

5 Click once on a thumbnail

to select the associated patient

chart. The background changes to
— blue, confirming that the chart is

selected. To deselect a chart,

click on the thumbnail again.

6 To open the selected patient chart, select
File » Open Patient Chart or click _0pen patient | or just
double-click on the highlighted thumbnail.

Opening image(s) from within the Mirror chart

1 Click once on a thumbnail to select the associated
3D image. The frame color changes, confirming that the
image is selected.

Multiple images may be selected and opened at the
same time: To select an additional image, click on
its thumbnail. To deselect an image, click on the
thumbnail again.

raN| o @EEE

1))

=

naes

ECT)

o wmzon

>
ATIENT SUMMARY
= Goura Roberts.

esu:

vew
DOR 1/81972

- [

)4 b ) M) Vi it S By

PATIENTIMAGES: 20

Pavent Datals
Ei LY

2 To open the selected image(s), click  Open Images
or double-click on a highlighted thumbnail.
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- DOB: 1/8/1972 SEX: F
Modify
AGE DATA
|
bs i
cedure Date .
image Date
% sve
SELECTED PATE]
NAME:Laura Roberts
E -
- DOB: 1/8/1972
MAGE DATA
ATTRIBUTE
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Saving data from VAM’s Log window
into the Mirror patient chart

=== RA

PATIENT IMAGES:

Sendito Gallery A ] hone ]

Ev File Name
o Face pre-o
v Image Date
© 10/17/201

asi = 233335
Angle = 017638

= 154524
= 719501

Bpply Y Edilist

APPLIED IMAGE DATA

~ Image Date
© 10/17/2011

~11 Click 5ave&Cose |

1 Select File p Save..., enter a unique file name, and
click OK.

2 Click once inside the Log window (at the bottom of
the screen).

3 Right-click and select Select All from the pop-up
menu (or drag over data to select it).

4 Right-click and select Copy from the pop-up menu.
5 Select File » Open Patient Chart....

6 Click once on the corresponding thumbnail to select
it (the border turns blue to show that it’s highlighted.)

7 Right-click on the highlighted thumbnail and select
Edit Data to open the Edit Image Data window.

8 Select Notes from the Attribute drop-down menu.

Esl
9 Click in the Notes field. | =)
Type a descriptor for the -
data that you are adding, E! R
such as “Rhinoplasty e
measurements” or “Area =". . =
Right-click and select Paste S remamas - o

10 Nasofrontal Angle = 154.524
11 Tip Angle = 719561

APPLIED IMAGE Dé

Ev/ﬁm:';y
o Face prop trmmed
=7 Image Pate
o 7/2011
10 Cth Apply i _/

The Notes attribute is added to Applied Image Data.

from the pop-up menu.

The data that was copied
from VAM’s Log window
populates the Notes field.
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3D Image

2| 10172011 <open>

The data that you pasted

B\l

= Ll into Notes appears in the
I—I NANME: Laura Roberts
ssi Mirror Patient Chart.
File Name: /1072
Face pre-op trmmed /
Notes: Rhinoplasty measurements patient Detais
All distances below are reported in milimetres.
lv Patient Search Results x
1 Masal Bridge Length = 47.4538 MAGLE
2 Tip Projection = 24.221
3 Interahr Width - 16.5576 e s L
4 Interalar Base Width = 31.6308 - Float Cursor OVer
5 Coumela Lenth = 235112 e Eorpsts | h bnail
6 Stomion - Menton Height = 58.2749 IMAGE DATA
7 Intercanthal Width = 31.0178 t um nal to
8 Projection of Radix Nasi = 23.3335 .
‘ - display data.

]

30 Image,

=¥ Image Date
ioa 10/17/2011

NOTES

Rhinoplasty measurements

All distances below are reported in milimetres.

1 Nasal Bridge Length = 47.4538

2 Tip Projection = 24.221

3 Interalar Width = 16.5576

4 Interalar Base Width = 31.6308 12 Repeat for eaCh Open
5 Columelia Lenth = 2.25112

6 St - Manton Height = 58.2749 H

vt i S image.

Saving data from VAM’s Log window
into a Word or other text file

1 Select File p Save..., enter a unique file name, and
click OK.

2 Click once inside the Log window (at the bottom of
the screen).

3 Right-click and select Select All from the pop-up
menu (or drag over data to select it).

4 Right-click and select Copy from the pop-up menu.

5 Click within the destination document and press the
Ctrl and V keys to paste.
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9.2 VIEWING, SAVING AND CLOSING IMAGES IN VAM

Viewing multiple 3D images simultaneously in viewports

Five viewport presets (see Viewports in section 8.6)
enable simultaneous display of different images, or
different views of the same image. Multiple images will
initially open in a single viewport ([_]), superimposed.
To display images in more than one viewport, click a
viewport button in the toolbar ([1], H, B, i)

or select the desired preset from the View menu
(View » Viewports »).

All open images will
initially be active, visible,
and superimposed in
every viewport. Use the : il
viewport-specific Surface hm
View Selectors to
activate/deactivate and
show/hide images as
needed (see Surface View Selector in section 8.1).

Select “show selector in each
viewport” from Preferences

Comparing two 3D images side-by-side

This viewing method allows you to apply the
point-of-view tools to two viewports simultaneously to
review images side-by-side.

1 Select Preferences » Show » v Viewport Extras to
make the Viewport Extras toolbar available.

2 Click the [l Side-By-Side button in the Viewport
Extras toolbar. This will open two viewports with one
image active in the left viewport and the second image
active in the right viewport.

3 Click the [@] Synchronize button in the Viewport
Extras toolbar to lock synchronization between the two
viewports.

4 Use the point-of-view and texture tools to review the
images in tandem.
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Saving a modified 3D image

{4 IMPORTANT: Changes, edits, landmarks will not be
retained unless the image is saved.

1 Select File » Save....

Vit =5 2 Entera unique and descriptive file name in the
- Surface name dialog box.
L) {4 The file name should describe the session number,
Lok J [ el | the patient, and the status of the image. For example,

in the filename TP0.GG]J.reg, “TP0” identifies the
session number (TPO = time point zero, or baseline;
TP1 = time point one, or first follow up; etc.), “GGJ”
are the patient’s initials, and “reg” indicates that the
image is registered to the grid (if baseline) or to the
baseline image (follow up visits).

3 Click . The modified image is saved as a

separate 3D image in the patient’s chart and the original
3D image is preserved unchanged.

Closing a 3D image

1 Using the Surface View Selector (see Surface View
Selector in section 8.1), make sure the image you wish to
close is active and any other open images are inactive.

2 Select File » Close [Ctrl + W].
£4 1f the image has been modified and the changes have

VL, = notbeen saved, a prompt appears allowing
Surfac Face pre-op immed tom s been mosiees you e onee. | YOU tO discard the changes and close the
B fowthe modifications will be lost. ! K K
image (click OK) or keep the image open
so that you may save the changes (click

Cancel).

Are you sure you want to close this surface?
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9.3 REMOVING UNNEEDED FEATURES OR ARTIFACTS FROM AN IMAGE

Method 1 (good for quickly cropping an image)
1 Click the Dn box crop button in the vertical toolbar.

2 Place the # cursor at a corner of the area you wish
to keep, then click and continue to hold down the
mouse button.

B e,00¢ ] BPWE .& O Y ME@ 4 3 Dragoutarectangle to
the opposite corner of the

area you wish to keep and
release the mouse button.
The boundary box you
have drawn is displayed.

4 If you wish to adjust
the size or position of

the boundary box, click
an edge or corner of the
boundary box. The cursor
changes to Bl (edge) or
L& (corner). Drag to the
desired location.

5 Right-click the mouse to
delete everything outside
of the box.

6 Save the changes (see
Saving a modified 3D
image in section 9.2).
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Method 2 (good for creating a smooth perimeter)

1 Click the %4 Closed Loop Points button in the
vertical toolbar. /

J VAM - 20111014135837.tom
File Edit View Landmarks Loops fArea Surface Measure Scripts Preferences Sculptor Help

5 P.,007 PPYPY T DIDEBHE Fe (@ e -

2 Click to place a series
of points defining the
perimeter of the area place pointsina

you wish to preserve. ﬁj clockwise order
Q
K4 If the points are placed &
in a clockwise order, the i
area outside of the shape
will be selected. If the ij
points are placed in a hy
counter-clockwise order,

the area inside of the
shape will be selected.

00

3 After placing the last point, move the cursor away
from the point and right-click within the defined area.
Select “add to selected area” from the pop-up menu. The
selected area is painted green.

e % \ 7 %
4 # ~ '
PRNRBG R G - : L: BN et

£4 if the area you wish to 4 Select Edit b Delete Selected Area or press
preserve (rather than the Delete on your keyboard. The green area is
area you wish to remove)  deleted, leaving a smooth perimeter.

is painted green, select
Area » Select » Inverse.

&\éﬁuﬂw&" B

5 Save the changes (see Saving a modified 3D image in
section 9.2).
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Method 3 (good for removing discontinuous areas)

1 Select Area » Tools » %4 Paint Area Selection

or click the /4 Paint I
Area Selection button e i%ﬁ%‘?ﬂi
in the vertical toolbar. Copy Selcted Ares f | Ere Are Selecion

Delete Selected Area Del

l:d  Select Area by Boundary
[:4  Erase Area by Boundary

Project Selected Area
Show
20111014135837.tom Hide

File Sfdit View Londmarks Area Suface Measure Preferences Sculptor Help

ecs . WPYYWWIr DIEE®B F (@ -

2 Drag the brush over the
image (hold down the left
mouse button while
moving the mouse) to
select the areas you wish
to remove. The selected
areas will be painted a
contrasting blue-green
color.

{4 To change the size
of the brush, click on
a brush size in the
horizontal toolbar.

o ‘o

3 Select Edit » Delete Selected Area or press Delete
on your keyboard.

4 Save the changes (see Saving a modified 3D image in
section 9.2).

£4 NOTE: %4 Closed Loop Points or &, Lasso Select
may be used instead of the %4 Paint Area Selection
tool throughout the examples in this user guide.
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9.4 REGISTERING A BASELINE 3D IMAGE TO THE AXIS GRID

It is essential to register a baseline 3D image to the axis
grid. This establishes the permanent reference to which
all of the patient’s future images will be registered.

Establishing midline symmetry

Landmarks Area Surface Measure  Preferen
"f% Spin 5 rr, Tas @ﬁ“;g
= Zoom Z

4y, Pan P
%, Roll

Fit View
% Snap View
= RockView

oo

Shading
Texture
Lighting
Specularity

Projection

Distance
Axis Grid

Viewports v' | Show XY Plane

¥ | Show Y7 Plane
¥ | Show ZX Plane

e Show Axis Grids G

Ly

Area | Surface  Measure  Preferences

Select 4
Tools 4
Copy Selected Area

1 With a baseline 3D image open in a single viewport,
select View » Axis Grids » [# Show Axis Grids (or
type G). The X, Y, and Z planes will be displayed

in the viewport.

2 Select View » & Snap View or click the
{4 Snap View button in the horizontal toolbar.
This will square the grid to the nearest 90° increment.

3 Select Surface » Tools » #; Spin Active Surfaces
or click the #; Spin Active Surfaces button in the
vertical toolbar.

4 Spin the image until
it is bisected by the
vertical (Y) axis.

5 Click the %t/ Paint Area
Selection button in the
vertical toolbar.

6 Drag the brush over the image (hold down the left
mouse button while moving the mouse) to select the
entire front of the image.

7 Select Surface » Measure  Preferences  Scu
Find Symmetry. Tools r
This will cause the%A Register Surfaces...

to be automatically Find Symmetry

oriented to the vertical axis Flip Orientation s

through its center.

Sculptor  Help 8 Select Area » Select » Clear to
» / deselect the image area.
Clear I:}

Inverse
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Correcting image rotation

1 Select View » Viewports » [[] 2 Viewports
(vertical split) or click the [1] 2 Viewports button in the
horizontal toolbar.

2 Click the %, Spin button in the vertical toolbar
(or select View b %, Spin, or press the S key).

3 In the viewport on the right, rotate the grid and image
to obtain a lateral view.

== 4 Select View » & Snap
View.

5 Click the @4 Roll Active
Surfaces button in the
vertical toolbar.

6 Roll the image in the
right viewport so that it
is oriented to the vertical
grid lines.

Establishing front-to-back orientation for registration

1 Click the ¥, Pan Active Surfaces button in the
vertical toolbar.

2 Move the image in the right viewport until it is
centered on the main vertical axis line.

Saving the registered baseline image

1 Select File p Save... to open the Surface name
dialog box.

2 Enter a filename that includes “reg”, indicating that
the image has been registered (see Saving a modified

3D image in section 9.2).

3 Click OK. The registered baseline image is saved as a
separate 3D image in the patient’s chart.
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9.5 REGISTERING SUBSEQUENT 3D IMAGES TO THE BASELINE IMAGE

When comparing images (e.g., pre-op and post-op),

it is important to ensure that the images are registered
to each other. Typically, the original (first) image is
aligned to the grid and serves as the baseline image
(see 9.4 Registering a Baseline 3D Image to the Axis
Grid). All subsequent images are then registered to the
baseline.

There are two methods that may be used to register
follow-up images to a baseline image. It is possible, and
sometimes even desirable, to employ both registration
methods. This will help ensure precise registration.

Method 1: Using anatomical landmarks

1 Open a patient chart and select an image that needs
to be registered and the baseline image that has been
previously registered to the axis grid.

2 Open the two images in VECTRA Analysis Module:

VECTRA chart: click @ open in Analysis

Mirror chart: click  QpenImages | (or double-click
one of the thumbnails)

VECTRA Analysis will be launched and both images
will open, superimposed in one viewport.

£4 Work with only two images at a time to ensure optimal

computer performance and simplify the process.

3 Click the [J Side-By-Side button in the Viewport
Extras toolbar to put each image in its own viewport.
(If you don’t see [, select Preferences » Show »

¥ Viewport Extras.)

4 Use the [@] Synchronize button in the Viewport
Extras toolbar to toggle synchronization off.
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5 Use viewpoint %, Spin [S] to rotate the follow-up
image until its orientation is similar to the
baseline image.

Place landmarks.

Identify and mark anatomical landmarks outside of the
treatment area which are common to both images, such
as canthi, moles, or permanent scars.

£ For more on landmarks see the next section, 9.6 Using
Landmarks.

trea suface e prewencs s ] Select Landmarks » Tools » &, Place Landmarks,
b - ﬁ“ - ?ﬁ,ﬁ or click the %, Place Landmarks button in the vertical
TR e e toolbar.
2 Click once at an anatomical landmark on the
baseline image in the left viewport, then click at the
corresponding point on the follow-up image in the right
viewport. A numbered green dot appears at each click,

indicating that the landmark has been placed.

Corresponding landmarks on each image must have
the same identifying number. The software will auto-
matically assign “1” for the first click in each viewport,
“2” for the second click in each viewport, etc.

£ Use viewpoint %, Spin, %, Pan, &, Roll, and %, Zoom
to help you find and place appropriate landmarks.
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3 Repeat step 2 until four or more landmarks have
been identified and placed.

Messure  Preferences  Scu Register the images,

Tools

Register Surfaces...

&41 Once the landmarks have been placed, select Surface
» Register Surfaces.

Find Symmetry
Flip Orientation

T &= 2 Inthe Register Surfaces dialog box make the
Vot aatace: e following selections:
TPO.CM reg tom
S " Move this surface: [follow-up image]
— to fit this surface: [baseline image]
T3 Cnmmedion ___—Calculate alignment @ landmarks with
using: corresponding names
alculate alignment using: E . . . .
AR 3 Click[ o | The follow-up image is registered to
€ selected area on first surface the baseline image'
selected area on second surface
@ |andmarks with corresponding names
-

Save the registered follow-up image.

1 Select View » Viewports » [ ] 1 Viewport or click
the [ ] 1 Viewport button in the horizontal toolbar.

2 Use Surface View Selector (see Surface View
Selector in section 8.1) to hide the baseline image and
make sure the follow-up image is active.

3 Select File » Save... to open the Surface name
dialog box.

VECTRA H2 User Guide [PX11)



Chapter 9 Viewing and Manipulating Images in VAM

4 Modify the filename to include “reg”, indicating that
the image has been registered (see Saving a modified

3D image in section 9.2).
5 Click[ ok | The registered follow-up image is

saved as a separate 3D image in the patient’s chart.

Verify registration.

Perform Color Surface by Distance to verify the
registration. See Using “Color Surface by Distance” in
section 10.1.

Method 2: Using image contour

1 Open a patient chart and select an image that needs
to be registered and the baseline image that has been
previously registered to the axis grid.

2 Open the two images in VECTRA Analysis Module:
VECTRA chart: click g open in Analysis

Mirror chart: click ~ open Images | (or double-click
one of the thumbnails)

VECTRA Analysis will be launched and both images
will open, superimposed in one viewport.

£4 Work with only two images at a time to ensure optimal
computer performance and simplify the process.

3 Use Surface View Selector (see Surface View
Selector in section 8.1) to deactivate the baseline image
(it remains visible, but is displayed with low opacity)
and make sure the follow-up image is active (displayed
with full opacity).

4 Select Surface » Tools b #; Spin Active Surfaces
or click the #; Spin Active Surfaces button in the
vertical toolbar.

5 Rotate the follow-up image so that its orientation is
similar to the baseline image.
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W Register Surfaces

Move thisurface:

TPO.CM.reg.tom
TP3.Ch.trimmed.tom

Viewing and Manipulating Images in VAM

6 Use Surface View Selector to hide the follow-up
image and activate the baseline image.

7 Click the %/ Paint Area Selection button in the
vertical toolbar.

8 Drag the brush over the image (hold down the left
mouse button while moving the mouse) to select the
desired areas: bony or anatomically consistent areas
outside the treatment area.

04 1t is important to avoid areas impacted by treatment.

Register the images.
1 Select Surface b Register Surfaces.

2 In the Register Surfaces dialog box make the

to fit this surface: g

TPO.CM.reg.tom
TP3.CM.trimmed.tom

Colaiate dignment using: <

whole of both surfaces
) selected area on first surface

@ selected area on second surface

%) landmarks with corresponding names

E=a =)
following selections:
T Move this surface: [follow-up image]
to fit this surface: [baseline image]
Calculate alignment @ selected area on
using: second surface
3 Click[ ok .
The follow-up image is
registered to the baseline
image.

Save the registered
follow-up image.

1 Use Surface View
Selector (see Surface
View Selector in section 8.1) to hide the baseline image
and activate the follow-up image.

2 Select File » Save... to open the Surface name
dialog box.

3 Modify the filename to include “reg”, indicating that
the image has been registered (see Saving a modified

3D image in section 9.2).
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4 Click . The registered follow-up image is

saved as a separate 3D image in the patient’s chart.

Verify registration.

Perform Color Surface by Distance to verify the
registration. See Using “Color Surface by Distance” in
section 10.1.

9.6 USING LANDMARKS

Landmarks | Area

Landmarks are used for annotation, registration, and as
markers for taking measurements such as the distance
between two points over the image.

Moving the image while working with landmarks

As you place landmarks you may need to spin the image
to view previously hidden areas. To temporarily access
% Viewpoint Spin, press and hold the ALT key. The
cursor changes to 4, allowing you to rotate the image.
Release the ALT key, and the previous tool

(%, Place Landmarks or %, Select Landmarks)
becomes active again.

Creating auto-numbered landmarks

Measure Preferences  Sculptor 1 With at least one image open and

| Select

‘ Tools

‘ Create Mamed Landmarks...

Delete Selected Landmarks

v 5_,1 B8 =5 [ active, select Landmarks » Tools »
, |_|> | iPlice Landma;(sﬁ’ , Place Landmarks (or click

I'% Geleet Iandmmatks the %, Place Landmarks button in
s  the vertical toolbar).

2 Click once on an active image to place a landmark.

Each new landmark on the image is automatically
assigned a numeric label: “17, “2”, etc.

The new landmark is displayed in a bright green
color indicating that it is selected. (Deselected
landmarks are displayed in a dark green color).
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Creating named landmarks

A named landmark is identified by a label that describes
it’s location on the body. Named landmarks are placed
and named according to a preset list and are then used
to generate a pre-defined set of calculations.

Landmarks | Area  Surface Meas 1 With a 3D image open and active in VAM, select

Select Landmarks » Create Named Landmarks. The Named
Tools ,  Landmarks window opens on the right side of the
| screen.

Create Mamed Landmarks... |
Delete Selected Landmarks l

2 Select Landmarks » Tools » &, Place Landmarks
Delete &ll Landmarks

or click the %, Place Landmarks button in the vertical

toolbar.
= [ ]
3 Click to select the Name new landmarks check box.
Landrpérk List (-4
B A 4 Seclect the desired landmark set from the drop down
on tis surface : TPO.CMreg.tom menu. The abbreviation and full name for each of the
for s enalves: _ |Bueae landmarks in the set is displayed. The first landmark is
Landmark  Full N{ chin . .
sn i e highlighted, ready to be placed.
MMF() Medial Fadial Evaluation
MME() Medial I{:‘;:;':‘;Lel
lavicl orthognathic T4 :
8 5 Position the tip of the cursor arrow over the
N(F) Nipple RIS

appropriate anatomical location and click once to place
the landmark.

Alr) Areola (Right)

The corresponding landmark abbreviation
appears next to the placed landmark dot.

A checkmark appears next to the abbreviation
in the landmark list.

The next landmark in the list becomes highlighted.
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6 Once all of the landmarks in the set have been
placed, click Show Report to display the resulting
measurement data (mm) in the Log window at the
bottom of the screen.

ot
o .

7 See section 9.1, Saving data from VAM’s Log window
into the Mirror patient chart, or Saving data from VAM’s
Log window into a Word or other text file for how to
save the data from the Log window.

Selecting landmarks

A landmark needs to be selected (bright green) in
order to use it for measuring or for any other purpose
(deselected landmarks are dark green).

1 Select Landmarks » Tools » [%0 Select Landmarks
or click the %, Select Landmarks button in the vertical
toolbar.

2 Click once on a dark green landmark to select it.
The color will change to bright green, indicating that it
is selected.

If you click on a different landmark, it will become
selected and all others will become deselected.

To select multiple landmarks press and hold the Shift
key as you click landmarks.

To deselect a landmark press the Ctrl key as you click
a selected landmark.
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Deleting landmarks

Area Suface Meas 1 Select the landmark(s) you wish to delete (see

Select , | previous page).

Tools ’ 2 Select Landmarks » Delete Selected Landmarks.

Create Named Landmarks...
{4 To remove both selected and unselected landmarks,

Delete Selected Landmark
it itk select Landmarks » Delete All Landmarks.

Delete All Landmarks

Landmarks on multiple images

If more than one image is open, landmarks will be
placed on whichever image is currently active.

If more than one image is active, landmarks may be
placed on either image.

If active images overlap, landmarks will be placed
on the uppermost active image (the one in the
foreground).

Each image has its own list of landmarks, numbered
from 1 onward.

Viewing landmark coordinates

[Tondmarks | Area Surfsce Mess— Select Landmarks » Display Coordinates to display
| + | the x,y and z values for landmarks. The Log window
,  atthe bottom of the screen displays the label and

X, V, z coordinates for each landmark (whether
or not it is selected).

Select

Tools

Delete All Landrmarks
Project Selected Land
Display Coordinates
Show

Hide

nf) (15,984, 47.8593 54.3504)
)  (149951,49.0655,54.2077)
(0.57958,67.1081,69.7356)
(1.24643,52.7467,72.793)
(167693, 60,5637,55.7326)
51,54.6776,71.1102)
3

(13.4103,20, 2363, 74.0679)
(13,5284, 54,5613, 70.5115)
(5.50801,33.4097,75.5666)
(1.25304,5.52288,80.2)

Cf) (4952486556485, 2401
) (3.38959,8.56231,67.75%9)
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9.7 CREATING A 3D ANIMATION

animator

CAPTURE

frame

key frames: load

GENERATE

animation

GENERATE
animation

pause

save dear

1 Select File » Create Animation... to open Animator.

04 Click the Animator title bar and drag to reposition the

floating dialog box as needed.

2 Use viewpoint %, Spin, %, Pan, &, Roll, and/or
45 Zoom to orient the image to the rotation and zoom
desired for the first frame of the animation.

3 Click §) CAPTURE New Key Frame to save this view
as Key Frame 1.

* A thumbnail of the key frame appears in the
Animator dialog. If you wish to return the image to
this orientation and zoom, click the thumbnail.

¢ Click the trash icon if you wish to delete this key
frame.

* Optional: Adjust the amount of time the animation
should pause at this key frame.

4 Rotate and/or zoom the image to the next position,
and then click § CAPTURE New Key Frame to save
this view as Key Frame 2.

* A second thumbnail appears in the Animator dialog.
» Optional: Adjust the interval between key frames.

* Notice that the @ GENERATE animation button is
no longer disabled. A minimum of two key frames
must be specified to generate an animation.

Repeat step 4 until you have specified all the key frames
you wish to include in your animation. Animator will
automatically insert the in between frames (“tweens”)
to make smooth transitions between the key frames.

{4 1f you would like the animation to loop back to

Key Frame 1 at the end, click the first thumbnail,
then click ) CAPTURE New Key Frame.
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key frames; legd save dear

Output Settings

small width

medium
| 1

large -

custom height pixels

Output Settings

small width pixels

medium
| E |
large

heiah Y il
custom height

m frames per sec.
I; gif

Viewing and Manipulating Images in VAM

Saving key frames (optional)

If you plan to reuse a particular sequence,

click save after you have specified all the key frames
you wish to include in the template. If you wish to
delete all of the key frames and start over, click clear.
Click load to automatically generate a saved sequence.

Changing the pixel dimensions (optional)

Pixel dimensions determine how large the animation
appears on screen during playback. Increasing the pixel
dimensions also increases the size of the file. Smaller file
sizes are recommended for web or e-mail.

To change the pixel dimensions, select a preset size
by clicking the radio button next to small, medium
or large (see table on following page), or modify the
values in the width and/or height fields.

£ when Jl link is selected, changing one dimension
will automatically change the other dimension
to maintain the aspect ratio. When i link is
unselected, the aspect ratio may be modified.

Preset output pixel dimensions:

1 viewport 2 viewports*

small 180 x 240 pixels 360 x 240 pixels
medium 360 x 480 pixels 720 x 480 pixels
large 720 x 960 pixels 1440 x 960 pixels

*The preset pixel width is doubled for 2 viewports.

5 Select type of animation file to be generated: GIF or
MP4 video.

Changing the number of frames per second (optional)
To define the number of frames Animator will insert
for each second of playback, modify the value in the
frames per sec. field. More frames per second will
result in smoother transitions, but increase the file size.
* The recommended value for GIF is 8 to 10 FPS (more
than 12 is not recommended).
* The recommended value for video is 24 FPS.
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A,

CAPTURE

new key frame

preview

+ loop

video

GEMERATE
animation
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Changing the looping option (optional)

If the loop check box is selected (E), the animation
will loop continuously. If the loop check box is
unselected, the animation will play once and then stop.
This only applies to GIF animation.

6 Make sure a minimum of two key frames have been
specified and desired output settings are selected, then
click @ GENERATE animation.

L% The Animator dialog box retains your specified
key frames and settings until you close the image.
You may change, for example, the number of open
viewports or the view mode from color (textured) to
gray (untextured), then generate a new animation.

4 Pre-op and simulated images in
synchronized 2-viewport animation

Review and save a GIF animation

The GIF animation is displayed in a a floating Preview
dialog box.

Clicking the X in the upper right corner of the Preview
or Animator dialog closes the box.

Click @ to pause playback. The icon changes to .
Click @ to resume playback.

Click @ to stop playback. The animation starts at the
first frame when resumed.

Click @b to save the animation into the patient chart as
an Animated GIF Image with the file extension, “.gif”.
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Review and save a video animation

The video animation is displayed in a a
floating window.

Click |l to pause playback. The icon
changes to .

Click P> to resume playback.

Click X in the upper right preview
corner to close animation Open Aimation
and display Preview _
dialog box.

Click @ to save the animation into the
patient chart as a video.

{4 1f you close the Preview dialog box (GIF or video)
before saving, you will be prompted to save. To retain
the generated animation, click save.

save this animation?

don't save

VECTRA H2 User Guide @1



CHAPTER 10
Image Analysis

10.1 MEASURE AND COMPARE DISTANCES

Measuring the straight line distance
between two landmarks

1 Select two landmarks.

2 Select Measure b Distance p Straight Line Between
Landmarks.

0/ Mirror 3D Analysis

File FEdit View Landmarks Area Surface Preferences  Sculptor Help
E il |
S P, 0@ W

Distance | Straight Line Between Landmarks

Circumference at Plane  # | Across Surface Between Landmarks
Angle Landmark to Surface
Area Perimeter of Selected Area

Velume Color Surface by Distance...

The straight line distance between the selected landmarks
(in millimeters) is displayed in the Log window at the
bottom of the screen.

{4 Exactly two landmarks must be selected, but they don’t
have to be on the same image. You may use Straight
Line Between Landmarks to measure the straight line
distance from a landmark on one image to a landmark
on a different image.
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Measuring the distance across a surface

e,

o,
% \
b \

%, This tool measures the shortest surface distance along a

path defined by landmarks.
1 Select two or more landmarks.

2 Select Measure » Distance » Across Surface
Between Landmarks.

\Tj VAM - 20111014135837 tom

File Edit View Landmarks Area Surface Preferences  Sculptor Help
- | () <, & ) 8| Distance ¥ Straight Line Between Landmarks
P00 N g

Circumference at Plane  # Across Surface Between Landmarks
Angle 3

Landmark to Surface

Area 4 Perimeter of Selected Area

Volume 4 Color Surface by Distance...
3

Color

This generates a path
along the shortest surface
distance between the
landmarks (in the order
that they were selected).

The path length (mm) is displayed in the Log window.

The path may be deleted or saved in the same way as an
image.
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Measuring from a landmark to the
nearest point on another image

1 Place " (or select Ry ) alandmark on one image.

2 Select another image.

{4 Ensure there is one selected image with one or more
selected landmarks, and one selected image with
no selected landmarks. Any other open images should
be deselected.

3 Select Measure » Distance » Landmark to Surface.
The distance between the selected landmark(s) on the
first image and the nearest point on the second image is
displayed in the Log window.

Measuring the perimeter of a selected area

1 Select the area to be measured: Click '/ paint area
selection or & lasso select (in the vertical toolbar).
Drag over the area you wish to select with ¥4, or drag
around the perimeter of the desired area with ¢=.

L4 [Ctrl] toggles between the Paint and Erase functions of
Area Selection, as well as between the Select and Erase
functions of Area By Boundary. For example, press the
Ctrl key while using Paint Area Selection to temporarily
switch to Erase Area Selection.

Another method to select the area: Click %, place
landmarks and then click at several points around the
perimeter of the selection area. Select Area » Select

» Extend Using Landmarks. The landmark dots are
connected and filled in as a selection.

£ The accuracy of the selection determines the accuracy
of the perimeter measurement. To increase selection
accuracy, increase magnification: Click %, zoom, click
in the image, and then drag downward while holding
the left mouse button, or rotate the scroll wheel on your
mouse.
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Colour

@ whole of

this surface:

Color Surface by Distance -]

2 Select Measure » Distance » Perimeter of Selected
Area. The length of the perimeter of the selected area is
displayed in the Log window.

Using “Color Surface by Distance...”

X

) selected region of

TPO.CM.reg.tom
TP3.CM.reg.tom

A

by the distance to nﬁ surface:

TPO.CM.reg. tom
TP3.CM.reg, tom

|

N

Calculate distances

Distance statistics

Color Surface by Distance... provides visual feedback
and numerical data about the distance between two
images, enabling the user to verify image registration
and also identify regions of difference/change

(e.g., pre- and post-op) for comparison and analysis.

1 Open two registered images.

2 Use Surface View Selector (see Surface View
Selector in section 8.1) to hide the image that will be
compared to the baseline image and make sure the
baseline is active.

3 Select Measure » Distance » Color Surface by
Distance....

4 Make the following selections in the Color Surface
by Distance window:

Colour: @ whole of

“~_ . this surface: select the .tom for the baseline

image

—+ by the distance to this surface: select the .tom

for the comparison image

_~ 5 Click the Calculate distances button.

VECTRA Analysis software calculates the distances
between the two images and colors them according to
the color scale parameters.
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smulsice.tom
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Log window

Numerical data is displayed in the Distance statistics
section of the Color Surface by Distance window
and also in the Log window. Review the false color
map to determine accuracy of the registration. The
distance scale is located on the left side.

The color in untreated, anatomically consistent areas
should reflect the 0Omm point on the scale with only
slight variation. The color in treated area(s) should
indicate a clear +/- change in image projection.

The color scale parameters may be adjusted to
demonstrate image differences more clearly:

1 Enter the desired min/max (in mm) in the
Optional Color Scale Adjustment fields.

2 Click the Adjust Color Scale button to apply.
Standard recommended values are min = -7, max = 7.
Adjust as necessary to demonstrate image differences.
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Untreated, anatomically consistent areas that are
not close to the 0Omm point on the scale indicate
poor registration. This could result from selecting
imprecise landmarks, numbering landmarks
incorrectly, or a change in physical anatomy due to
treatment or patient positioning.

To return to the standard image view select View »
Texture » ® Textured or click ®¥ Textured in the
top toolbar.

To view the false color map again select View »
Texture » @ Colored by Distance or click
W Colored by Distance in the top toolbar.

£4 To compare two regions of interest, first select the

region in the baseline image, then select “selected
region of” instead of “whole of”.

10.2 MEASURE AND COMPARE CIRCUMFERENCES

Using “Circumference At Plane” method

1 Open a patient chart and select the images to be
analyzed in VECTRA Analysis (including registered
baseline):

VECTRA chart: click gl open in Analysis
Mirror chart: click ~ Open Images | (or double-click

one of the thumbnails)

VECTRA Analysis will be launched and both images
will open, superimposed in one viewport.

2 Use Surface View Selector (see Surface View
Selector in section 8.1) to deactivate the follow-up image
and make sure the baseline is active.

3 SelectLandmarks » Tools » “®Place Landmarks

(or click the %, Place Landmarks button in the vertical
toolbar).
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4 Place 3 landmarks (see 9.6 Using Landmarks)
to define the plane or course of the circumferential
measurement.

5 Use Surface View Selector to activate the follow-up
image (keep the baseline active).

6 Sclect Landmarks » Project Selected Landmarks.
The landmarks on the baseline image are projected
onto the follow-up image.

7 Select Landmarks » Select » All.

8 Select Measure » Circumference At Plane )

3 Landmarks. The circumference of each image is
calculated and displayed in the Log window (bottom
of screen).

B¢ O0EEE %0 ¢ - - 0 B (el @ - [ =F=E 000
T Basan

9 With the baseline as the only active image, select
File » Save... and click OK to retain the landmarks for
analysis of future time-points.

10 See section 9.1, Saving data from VAM's Log window
into the Mirror patient chart, or Saving data from VAM's
Log window into a Word or other text file for how to
save the data from the Log window.
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Using tape measure and perimeter method

1 Open a patient chart and select the images to be
compared in VECTRA Analysis:

VECTRA chart: click gl open in Analysis

Mirror chart: click ~ gpenImages | (or double-click
one of the thumbnails)

VECTRA Analysis will be launched and both images
will open, superimposed in one viewport.

2 Click the [[J Side-By-Side button in the Viewport
Extras toolbar to put each image in its own viewport.
(If you don’t see [, select Preferences » Show »

¥ Viewport Extras.)

3 Click the &= Circumference button in the vertical
toolbar.

4 Select the region you wish to measure:

* Click on the first image at the desired height of
measurement. A green ring is added and the
circumferential measurement of a horizontal slice
of the body at this height is displayed to the
left of the ring.

=3 el 1 15T Sk EESF0 @ -0 HESSS A.h‘"'"'m‘ ==--4-=.-w..m..¢uh,

* Click on the second image at the corresponding
location to place a measurement ring.
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5 Right-click on a green ring to add slices (green rings)
20mm apart, above and below the initial slice. Select the
number of slices from the pop-up menu.

LT R =g %0 B -0 BRssy (B meemis Bemanas goa

Circumferential measurements
are displayed to the left
of each slice.

The volumetric measurement of the cylinder created by the uppermost
and lowermost slices is displayed to the right.

erase the selected ring

add more rings spaced 20mm apart

*Perimeter measures the true circumference of the
surface, like a sticky string faithfully following all of the
contours of the designated slice.

Tape measure spans the concave surfaces, like an actual
tape measure held taut around the designated slice.
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10.3 MEASURE AND COMPARE ANGLES

1 Place three landmarks on an active image to identify
the angle that will be measured, or select three
previously placed landmarks.

The angle formed at landmark 2 by landmarks 1 and
3 will be measured.

Exactly three landmarks must be selected.

See 9.6 _Using Landmarks for more on placing and
selecting landmarks.

2 Select Measure » Angle » from 3 Landmarks.

The value for the specified angle is calculated and
displayed in the Log window.

10.4 MEASURE AND COMPARE AREA

1 Open two registered images.

2 Use Surface View Selector to deactivate one image
(see Surface View Selector in section 8.1).

3 Select the area to be measured: Click 5 lasso select
(in the vertical toolbar) and drag (hold down the left
mouse button) around the perimeter(s) of the area(s)

to be measured. Alternatively, click k 4 paint area
selection and drag over the area you wish to select.

£4 [Ctrl] toggles between the Paint and Erase functions of
Area Selection, as well as between the Select and Erase
functions of Lasso Select. For example, press the Ctrl
key while using Lasso Select to temporarily switch to
Lasso Erase.

Another method to select the area: Click %, place
landmarks and then click at several points around the
perimeter of the selection area. Select Area » Select »
Extend Using Landmarks. The landmark dots are
connected and filled in as a selection.
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4 Use Surface View Selector to activate the other
image.

5 Select Area » Project Selected Area.
The corresponding area on the second image will

become selected

6 Select Measure b Area ) of Selection.
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The value for the specified area is calculated for each
of the images and displayed in the Log window.

To calculate the area of each entire image, select
Measure » Area » of Surface—useful for comparing
selected area to total area.

7 Select File » Save... and click OK if you wish to
retain the selection(s) for future analysis.

8 See section 9.1, Saving data from VAM’s Log window
into the Mirror patient chart, or Saving data from VAM's
Log window into a Word or other text file for how to
save the data from the Log window.
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10.5 MEASURE AND COMPARE VOLUME

Using Volume » to Interpolating Surface

Allows the image to be measured against a system-
generated reference image. This is useful for obtaining
a general reference volume from a single time point
(e.g., pre-operative breast patient) when a second image
(post-treatment) is not yet available.

{4 NOTE: The calculated volume does not represent
the actual volume as measured against the actual
subsurface anatomical structure but may serve as a
useful planning tool.

1 Open a single image.

% 2 Identify the area for which you wish to determine the
' volume: Click '/ paint area selection or &, lasso
select (in the vertical toolbar). Drag over the area you
wish to select with %/, or drag around the perimeter of

the desired area with ¢=.

{4 Include area slightly beyond the boundaries of the
target when making the selection.

3 Select Measure » Volume » to Interpolating
Surface. A new reference image is generated (with its
own Surface View Selector and the name, “Interpolating
Surface”). The volume difference between the original
and interpolating surfaces is reported in the Log window.

\Tj VAM - 20111014135837 tom

File Edit View Landmarks Area Surface

L)
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4 To save the interpolating surface to the patient chart
for future analysis deactivate the original image and
select File » Save... and click OK.

5 See section 9.1, Saving data from VAM’s Log window
into the Mirror patient chart, or Saving data from VAM’s
Log window into a Word or other text file for how to
save the data from the Log window.

Using Volume » of Closed Surface

Allows the volume measurement of any closed surface
(solid model) that has been generated using Volume »
Between Two Surfaces (difference object), created
using advanced stitching techniques, or imported from
a directory location.

1 Open or import a closed surface.

2 Select Measure » Volume » of Closed Surface.
The volume of the closed surface is calculated and
reported in the Log window.

3 See section 9.1, Saving data from VAM's Log window
into the Mirror patient chart, or Saving data from VAM’s
Log window into a Word or other text file for how to
save the data from the Log window.

Using Volume » Between Two Surfaces (difference object)
1 Open two registered images.
2 Use Surface View Selector to make sure the only

active image is the baseline (see Surface View Selector in
section 8.1).

3 Identify the area for which you wish to determine
volume difference: Click '/ paint area selection or
5 lasso select (in the vertical toolbar). Drag over the
area you wish to select with %/, or drag around the
perimeter of the desired area with ¢=.
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4 Use Surface View Selector to activate the other
image.

5 Select Measure » Volume ) Between Two Surfaces
(difference object). A new closed surface (with its
own Surface View Selector and the name “volume”) is
created depicting the difference in volume. The volume
difference (volume of the difference object) is reported
in the Log window.
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The difference object may be viewed in isolation or in
multiple viewports, and manipulated in the same ways
as any other image.

6 Deselect the original images and select File b Save...
and click OK if you wish to save the difference object to
the patient’s chart.

7 Repeat step 6 for the image with the area selection

(typically pre-treatment image) if you wish to retain the
defined area for analysis against future images.
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8 See section 9.1, Saving data from VAM’s Log window
into the Mirror patient chart, or Saving data from VAM’s
Log window into a Word or other text file for how to
save the data from the Log window..

Using Volume » Between Two Surfaces (parallel projection)
1 Open two registered images.
2 Use Surface View Selector to make sure the only

active image is the baseline (see Surface View Selector in
section 8.1).

3 Select the area to be measured: Click 5, lasso select
and drag (hold down the left mouse button) around the
area to be measured.

4 Use Surface View Selector to activate the other
image.

5 Select Area » Project Selected Area.
The corresponding area on the second image will
become selected.

6 Sclect Measure » Volume » Between Two Surfaces
(parallel projection). The volume difference between
the areas selected on the two images will be calculated
and reported in the Log window at the bottom of the
screen.

7 Select File » Save... and click OK if you wish to
retain the selection(s) for future analysis.

8 See section 9.1, Saving data from VAM’s Log window
into the Mirror patient chart, or Saving data from VAM's
Log window into a Word or other text file for how to
save the data from the Log window.
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Installing and Configuring the Software

A.1 INSTALLING THE SOFTWARE

NOTE: If you purchased a computer with your
VECTRA H2 system, the software is already installed.
Follow these software installation instructions if you
are using a computer that was not supplied by Canfield
along with the VECTRA H2 system.

System requirements

Before installing the software on a computer not
supplied by Canfield, ensure that it meets the minimum
specifications listed below.

Operating system: Windows 10 Professional, 64 bit
(recommended) NOT SUPPORTED: Windows Home
Edition or Windows VISTA

Processor: 2.2Ghz Quad Core i5, 7th Gen or higher
(Intel i7 7th Gen or higher, recommended)

System memory (RAM): 16 GB or greater
Minimum 1 GB available disk space for installing
application

Minimum 1 TB available disk space recommended
for data

Graphics card: 1 GB dedicated memory minimum

(2 GB highly recommended)

- Dedicated nVidia or AMD card (nVidia highly
recommended)

- Driver: latest available

- 3.0 or later Open GL

USB Ports: 2 dedicated ports (USB 2.0)
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Display: 1920 X 1080 (4K monitors not currently
optimized)

Microsoft Security Essentials anti-virus software
recommended

Wired printers (recommended for speed)

1 Gbps Ethernet connection for networking — Wi-Fi
not supported

Two software installation flash drives are included with
the VECTRA H2 camera system: Mirror and VECTRA
software on one, and Calibration Files on the other.
The Calibration Files are specific to your camera.
Expect the software installation process to take
approximately 20 minutes.

Installation 1: Mirror software

Follow the steps below to install Mirror software on a
single computer or on multiple computers that are not
connected by a network.

1 Run Windows Update to ensure that you are running
the most current version of the operating system.

2 Log on to the computer with a user account that has
local administrative access privileges.

3 Close any programs that may be running on the
computer.

4 Temporarily disable any antivirus software.

5 Insert the software installer flash drive into an available
USB port on your PC.

6 Open the Windows Start Menu.
7 Click Computer to see connected drives.
8 Double click CANFIELD SW to open the flash drive.

9 Double click Start.
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10 Click to select Mirror software installation.
11 Click Install.

12 When the InstallShield welcome screen appears, click
Next to proceed with installation.

13 Read the Software License Agreement. If you agree
to the terms of the License Agreement, select “I accept
the terms of the license agreement” and click Next to
continue with software installation. If you select “I do
not accept the terms of the license agreement,” the
Setup program will close.

14 Installation Type Click to select the setup type that
best suits your needs, then click Next.

) STAND-ALONE - Install the application, Microsoft SQLServer and the Web Portal service.

@ WORKSTATION (Client) - Install application and configure to get data from network server.

@ SERVER - Computer is on a network. Install application and manage the license and databa

15 Select Features For installation on a stand-alone PC,
make sure “Microsoft SQL Server Express” is checked.

+ “Apple iPad Support” should be checked, if you
have purchased this option.

[ 5ecurity Reports

Microzoft SUL Server Express 20012
[¥] &pple iPad Support
[V]WigwbyConsult Service

* “ViewMyConsult Service” should be checked to
enable uploads to Canfield’s secure patient portal.

After confirming that correct items are checked/
unchecked, click Next.

16 A summary of installation details appears. If you
wish to review or change any settings, click Back. If
you are satisfied with the settings, click Next to begin
copying the program files to the computer’s hard drive.

17 InstallShield Wizard Complete If prompted, click
the radio button next to “Yes, [ want to restart my
computer now”. Click Finish. Proceed with VECTRA
software registration and installation.
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Installation 2: Canfield Connect® registration

After the Mirror software installation is complete, follow
the steps below to register and install VECTRA software.

You are required to register your Product Key in order
to use your Canfield software.

An internet connection is required to complete the
Canfield Connect Registration.

1 Open the Windows Start Menu.

2 Click Computer to see connected drives.

3 Double click CANFIELD SW to open the flash drive.
4 Double click Start.

5 Click to select VECTRA software installation.

ing this Canfield Imaging Soluti

6 Click Install.

7 Click Continue in the Canfield
Connect® Registration dialog,.

rted
qetting S0
8 Locate your VECTRA Product Key

in the white Getting Started box ————»

that came with your system.

é}c#ﬂfigw

TN (B

The Product Key consists of a unique
string of 16 characters.

9 Enter the Product Key, then click Continue.
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Email Address

* Registration

nicholasrivieradibestpractice.com

First Name

Last Name

Connect® Registration

admingviewmy

10 Enter the email address of your “Super Admin”.

This user will manage general Company information,
user privileges, the product recommendations library,
and other account features via the Canfield Connect
website.

Canfield Connect® Registration

Click Continue.

11 Verify the email
address, then click
Continue.

12 Complete the information requested in the “Finish
setting up your Company” screen, then click Continue.

13 Verify your information, then click Continue.

Canfield Connect Registration is complete when the
“Registration Successful” screen is displayed.

14 Activate the ViewMyConsult® option by completing
the steps below, or click Exit in the “Registration
Successful” screen.

ViewMyConsult is an option included with an active
Canfield Care Agreement, enabling the upload of
patient consultation photos, analysis and treatment
recommendations to a secure, interactive web portal,
and providing patients with remote access. To activate
ViewMyConsult:

1 Click the big blue button in the “Registration
Successful” screen to download the Terms of Use
Agreement.
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com.
Do e emnonmu e o _=

2 Complete the agreement form and return the signed
form to Canfield Scientific at admin@uiewmyconsult.

3 Press the Alt and Tab keys on the keyboard to return
to the Canfield Connect Registration screen.

4 Click Exit in the “Registration Successful” screen, and
complete the VECTRA software installation.

Installation 3: VECTRA software

1 When the InstallShield welcome screen appears, click
Next to proceed with installation.

2 Read the Software License Agreement. To accept
the terms of the License Agreement, select “I accept
the terms of the license agreement” and click Next to
continue with software installation. If “I do not accept
the terms of the license agreement” is selected, the
Setup program will close.

3 Click Next in the first “Installation options” window.

4 Select the appropriate implant library if using Breast

Sculptor.

Completing the VECTRA Software
Suite Setup Wizard

Setup has finished installing VECTRA Software Suite on yéur
computer. The application may be launched by selectip§ the
installed icons,

Click Finish to exit Setup.

[ view User Guides

5 Click Install.
- 6 Click Finish to exit Setup.
7 Remove the software installation

flash drive and proceed with
calibration file installation.
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Installation 4: Calibration files

After the Mirror and VECTRA software installations are
complete, follow the steps below to install the VECTRA
H2 Calibration Files for your camera.

Success ﬁ

Successfully updated the H2 calibration files.

- o x

® 1 Insert the Calibration files flash drive
into an available USB port on your PC.

2 Open the Windows Start Menu.

3 Click Computer to see connected
drives.

4 Double click H2 Calib Files to open
the flash drive.

5 Double click Run H2CalibrationlInstaller.exe.

6 After the files are copied over, click OK in the
“Success” window.

7 Remove the flash drive.

Installation is complete.

Set VECTRA H2 as the capture system

1 Click the g set up button in the lower right corner
of the VECTRA home screen.

2 Select the Capture tab and make sure

¥~ VECTRA H2 is selected in the drop-down menu.

3 Click close.

Once the Mirror, VECTRA and Calibration Files software
has been installed, you can start to capture 3D images
with the VECTRA H2 (see Chapter 3 and Chapter 4).
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A.2 CONFIGURING THE PRODUCT RECOMMENDATIONS LIBRARY

An internet connection is required for first time users to
configure and update the Product Recommendations

Library.
() CANFIELD Connect After completing the Canfield Connect Registration
process, you are ready to configure the product
Ageless Assthetics library. The product library is accessible by selecting
the Library tab in CanfieldConnect.com, or from the
Analytics VECTRA home screen:

1 Click & setup at the bottom right of the VECTRA
home screen.

Patients

Employees 2 Click to select the Face tab, then click to select the
analysis & product library tab.

Delegations

§ Library

update product
recommendations

Version 6.10.1 built Jul 07 2020 11:19

3 Click the update product recommendations
button.

aaaaaaaaaaa

<—+ —— 4 Sign in to Canfield Connect.

If your login is associated with multiple companies
IR | (or practices), the system provides a list of associated
© companies and prompts you to select one.
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Assigning Product Availability

() CANFIELD Connect’

— o« To begin the product library setup,
select Library from the left of the

Canfield Connect home screen. The

Product Availability tab is selected.

= Allergan

= Alma Lasers

W\ select a product within _—
e the brand. The list expands L.

To select a brand:

1 Scroll through the product list to find the desired
brand, or begin typing the brand or product name into
the FILTER box.

2 Click on the brand name, or click on the 4 sign to

Selection UNAVAILABLE at these locations.
+ Ageless Aesthetics

Selection UNAVAILABLE at these locations
Ageless Office.
© Cantral
© Southeast

Selection UNAVAILABLE at thess locations

to display the available ———— 7 e o
product names. B

Py —

3 After selecting a brand or product,
the Selection UNAVAILABLE at these
locations and Selection AVAILABLE
at these locations boxes appear at the
bottom of the screen.

_—

Selection AVAILABLE at these locations.

By default, the selection will show as

UNAVAILABLE at all company locations.
Click on the 4 sign next to the region name to view all
locations within the region.

NOTE: Only one brand or product can be selected at a
time.

To make the product or brand selected available at a
location:

1 Click to select the name of the region or a location
4-—4““‘" within that region.

s 2 Click > to move the region or location
[ 0 the AVAILABLE box. To move all

ot locations from UNAVAILABLE to
*  AVAILABLE, click >>.
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The brand or product selected is now available at that
location.

Repeat this selection process for all brands and products
available at the region and/or its associated locations.

To move a location to the UNAVAILABLE box,
click € or click €< to move all locations to the
UNAVAILABLE box.

If one or more products within a brand are
AVAILABLE at a region or location, the selected
brand name appears as AVAILABLE at these
locations even though not all products within that
brand are AVAILABLE.

To make all products within a brand AVAILABLE
at a location after already making one or more

of the products available, make the brand name
UNAVAILABLE at the location and then move the
brand to the AVAILABLE column. All products
within the brand name will now be available at that
location.

Reviewing Brands by Location

The Brands by Location
tab allows you to view
the brands, associated
manufacturer, and date
on which a brand was last
modified in the product
library database.

() CANFIELD Connect

Ageless Aesthetics

Product Avallabillty Drands by Location

Aug 22,2018 Dac 12,2017

Any brands exclusive to your company are identified by
a “Yes” in the EXCLUSIVE column.

See Creating a New Brand below for additional
information on EXCLUSIVE products.

Click on the header of any column to sort the
brands by the information within that column.
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To see which brands are active for a specific region or
location:

ECANFIELDConnect  poccesmme s @ = 1 Tn the VIEW BY
Ageless Aesthecies Library Product Avallabillty MW\ LOCATION ﬁeld, CliCk

e R 7 onthe|v.
i ﬂ/ 2 Click to select the name

p— of a region or location.

#% Analylics

A Patients

Employces

Brands available at that region or location appear on the
screen.

To see if a specific brand is active for the region or
location selected, begin typing the name of the brand
in the FILTER BY field.

e o brands that contain the
letters specified.
Ageless Office

20 Skin Health, Inc. Apr28 2014 Dec 12, 2017 m

NOTE: The VECTRA product library includes non-
exclusive brands and products provided by our brand
partners. These brands and products can be made
AVAILABLE or UNAVAILABLE at your locations, but
cannot be edited or removed from the library.

=

() CANFIELD Connect , wee 8- we Lhe screen displays the

E Employees

Creating a New Brand

To add a brand to the product library that is not

included with the VECTRA software, add an exclusive
wase brand on the Brands by

Location screen.

() CANFIELD Connect mo osnwosrn RFv s

Ageless Aesthetics

Library Produc Avollabiley

A Analytics

1 Click on the New Brand
button.

A Patients

2 Type the Brand Name and Manufacturer.

7 3 Select language from the drop down menu, if desired.
. // 4 Click Add New Brand.
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o = The exclusive brand is
added to the Brands by
Location screen and
“Yes” appears in the
EXCLUSIVE column.

) CANFIELD Connect

Ageless Aesthetics

Library

A Analylics

L Patients

husiy cushv Jul A7
Atergon Alesgan Oct3 2013 Api 11,2018 n
obagi Obagi Medical 0ut3, 2013 Ape 12,2018 n

The View button is for
viewing brand information
only, except for EXCLUSIVE brands, which have an Edit
button to modify Brand Name and/or Manufacturer.

Reviewing Products by Location

.............. e The Products by
Location tab allows you
to view the products,
—— associated brands and
i ' B manufacturers, and dates

ANFIELD Connect

ies3 Aesthetics

Librar y Product Avallabilky  Brands by Location

Analytics

Patients

JanB. 2018

Diogatons 4 on which the products
: were modified in the
\ product library database.

Any products exclusive to your company are identified
by a “Yes” in the EXCLUSIVE column.

See Creating a New Product below for additional
information on EXCLUSIVE products.

Click on the header of any column to sort the
products by the information within that column.

To see which products are active for a specific region
or location:

ANFIELD Connect bk Oombuars e Saow 1 In the VIEW BY
R ) e o [ LOCATION ficld, click
Anaytcs ’ : B o B on the |v .

B MAME:  MAMUFACTURENZ LASTMODIFIED:  EXCWUSVE:  ACTIONS

2 Click to select the name
of a region or location.

Products available at that region or location appear on
the screen.
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To see if a specific product is active for the region or
location selected, begin typing the name of the product
in the FILTERl BY field.

ANFIELD Caliiect AT MEE oY peme The screen displays the
products that contain the
letters specified.

Product Avallabiliny Brands by Location Products by Lozation Categaries

Pationts
.....

Employees

Creating a New Product

To add a product to the product library that is not
available in the product library within the VECTRA
software, add an exclusive product on the Products by
Location screen. There are two ways to create a new
product.

Creating a New Product—Method 1:

Copy Existing Product Entry to create an exclusive
product that is similar to a product that already exists on
the Products by Location screen.

E@ Copy to the right

* of the product.

The “Private Copy of Existing Product” dialog

appears.

Product Name

[ skin Brigntening Program (Private Copy)

Brand

2 Edit the Product Name.
|20 skin Healtn ‘\Jﬂ

3 Click in the Brand field. A list of all available
e S S umwm brands appears. Select a brand.

without the use of hydroquinone and retinol.

4 Edit the Description and Special Usage

Instructions as needed.

\ <« |

Loge — 5 Select language from the drop down menu, if
- " desired.

Purchase Link

‘ <———— 6 Enter a purchase link, if desired.
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7 Click on Select New Image to upload an
image (jpg or png file) of the product.

i 8 Modify the Selected CATEGORIES as necessary.
- i See the Reviewing Categories by Group section
[ st emmae | below for more information on Categories.

/_\ Use the scroll bar to the right of the available

purpese category list to view and select all categories.

Current Image

Feature
Supplement

Facial Mist
Body Care
Makeup Removal

Acne Cleanser

Texture

Ctrl-Click to select more than one category at a
time.

BrowmeRg

Treatment
Dull Skin Tone
Melasma

Click > to move the category to the Selected
field or < to move the category back to the

Available ficld.

\ Repeat as necessary.
9 Click Add New Product.

Peel

Scrub Dark Spots / Uneven Skin Tone +

The new product is added to the Products by Location
screen and “Yes” appears in the EXCLUSIVE column.

33 Awsthetics

Library

Product Availabiiny Erands by Location Products by Location Categories

Analylics

Patients

Employees

Delegations

Creating a New Product—Method 2:
Create New Product Entry

1 Click on the New Product button.

Product Name

[ <« 2 Type the Product Name.

e — 3 Click in the Brand field. A list of all available
~ brands appears on the screen. Select a brand.

4—'— 4 Type ashort Description and Special Usage
Instructions in their respective fields as needed.

Special Usage Instructions

\ el | 5 Select language from the drop down menu,
) if desired.

Car e

6 Enter a purchase link, if desired.

\ “« ]
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Appendix A

Installing and Configuring the Software

7 Click on Select New Image to upload an

CATEGORIES
Available

Selected

image (jpg or png file) of the product.

Purpose
Supplement
Facial Mist
Treat & Repair
Body Care
Makeup Removal
Cleanser
Acne Cleanser
Peel
Scrub

8 Assign one or more CATEGORIES to the
product.

+ Use the scroll bar to the right of the available
category list to view and select all categories.

Add New Product

A

+ Ctrl-Click to select more than one category ata
time.

 Click > to move the category to the
Selected field.

* Repeat as necessary.
9 Click Add New Product.

The new product is added to the Products by Location
screen and “Yes” appears in the EXCLUSIVE column.

53 Aesthetics

Library

Product Avallability Erands by Loeation

Analylics

Patients

Delegations

Skin Brightanes NeoStrata - NeoStreta
SPF25 Enighten

NOTE: The View button is for viewing product
information only, except for EXCLUSIVE products,
which have an Edit button to modify product
information as necessary.
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Appendix A Installing and Configuring the Software

Reviewing Categories by Group

Categories are used for more efficient browsing of
the products when selecting recommendations in a
VECTRA consultation.

"/ The Categories tab allows
Ageless Aesthetics Ub[ary Product Availability Brands by Location Products by Location You to Vlew Category
names by group.

) CANFIELD Connect

A Analylics

L Patients
Bady Ay 22, 2016

Conrect Aug 22, 2016

Hydrate & Protect Aug 22, 2016

W Library joctatios Aug 22, 2016

Click on the header of any column to sort the
categories by the information within that column.

Category information is defined by the system and
""""""""""" cannot be modified.

To view the categories within a specific category group:

Click on the CATEGORY GROUP drop-down at the top
of the screen and select a group.

22,2008

Skin
22,2016

The category names within
the group appear on the
screen.

A Analylics

A Patients

Aug 72, 7016
E Employess
By Stin Type g 72 2016 Dec 12. 2017 [ oo

& Delegations
N Shin Trpe Aug 22,2016 Osc 12,2007 [ veu |

To find a specific category

# Analytics

T ;n.m. urs oxpens ....q: m,m.., . name’ begln typlng the
- Ermoiorses Fat Reuction Treamment Aup 22. 2016 Dec 12, 2017 Ve name Of the Category in
& Delepatons PSSy e vawan = the FILTER BY field.

\— The screen displays the category names that contain the
letters specified.

NOTE: Category is pre-set for brand partner products

and cannot be modified. To Edit Categories for exclusive
products, go to the Products by Location tab.
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APPENDIX B
Camera Settings and Maintenance

B.1 DELETING IMAGES FROM THE SD CARD

1 Rotate the power switch (top of
the camera) to ON.

2 Press the MENU button on the
back of the camera to display the
menu screen.

Navigate by using the curved
buttons around the SET button
on the back of the camera.

For navigating the menus:

Oy = <«
AF = »
WB = a
2™ =V

3 Press € or P to select IEI PLAY1 in the menu screen
(to the right of the ) SHOOT menus).

4 Press ¥ or A to select Erase images, then press SET.
5 Choose Select and erase images, Select range, All
images in folder, or All images on card, then press

SET and proceed with the corresponding section below
to erase images.
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Appendix B

Camera Settings and Maintenance

Select and erase images

1 Press B or € to view the images on the card.
Press SET to select the current image to erase.
As images are selected, the number next to the fif] icon
in the upper left corner of the screen updates.

2 Press the [[[| delete button on the back of camera to
erase selected images.

3 Press P to select OK in the Erase selected images
screen, then press SET.

Select range

1 Press b, €, ¥ or A to set the first image in the range
you wish to erase. Press SET.

2 Press », 4, ¥ Or A to set the last image in the range
you wish to erase. Press SET. Blue check marks appear
in each selected image and the number of selected
images is displayed next to the m icon.

2 Press the {Tﬂ delete button on the back of camera to
erase the selected range of images.

3 Press » to select OK in the Erase selected images
screen, then press SET.

All images in folder

1 Press ¥ or A to select the folder you wish to erase,
then press SET.

2 Press » to select OK in the Erase selected images
screen, then press SET.

All images on card

Press » to select OK, then press SET.

{4 From any screen, press the MENU

button on the back of the camera
to step back to previous screen.
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Appendix B Camera Settings and Maintenance

B.2 CHARGING CAMERA BATTERIES

1 Attach the battery securely to the charger that came
with the VECTRA H2 camera as shown.

2 Flip out the battery
charger’s prongs
and insert the prongs
into a power outlet.

The CHARGE light glows ' .
amber while charging,

then the FULL light glows
green when fully charged.

charging fully charged

3 Locate the battery compartment door release on the
rear of the camera. Slide left to pop open the door.

4 Insert each battery,
making sure the

' locking tab secures
the battery in place.

5 Close the battery
compartment door.

To remove batteries: Slide the door release left, then
push right on the locking tab until the battery pops out.
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Appendix B Camera Settings and Maintenance

B.3 LCD SCREEN ROTATION

The LCD screen on the camera may be
rotated for a better view of the target
area, if desired.

B.4 CAMERA SETTINGS

When using the H2 in tethered mode (3.1 Preparing
for Tethered Capture), VECTRA capture software
automatically uses the appropriate settings. But if you
are capturing to an SD card (3.2_Preparing for Capture
to SD Card), Make sure
the settings displayed on o
the back of the camera are

as follows: M - 1200« F10 =200
M (manual mode) "3,4..1..0..1..2.13
1/200 (shutter speed) % FE &
1ISO 200 0 O 00
RAW (image file format) (@)= [ 861]
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Data Back-up

File

Open

Open file location

E;' Run as administrator

Capture

i\

IMPORTANT: Failure to properly back up your digital
images and client records subjects you to potential loss
of data. Canfield Scientific accepts no responsibility or
liability for lost or damaged data.

Canfield recommends you consult a qualified IT
professional to assist you in developing a back-up plan.
An IT professional should install and configure the
necessary equipment and software, and train the staff
member designated to perform back-ups.

Canfield’s VECTRA software is a highly reliable
program that will function predictably under ordinary
circumstances. However, problems may occur as a
result of power surges, disk failure, viruses or other
damaging events that could render your database
inaccessible or unstable. For this reason, it is essential
that you regularly create back-up copies of your data
and images so that you can restore the database if you
experience a problem.

Method 1. Use Mirror Backup to create a backup copy of
the Mirror database on your local drive.

Image View Shape Draw Tools Options

&

/

i Mirror-MirrorDatabase Mode: Administrator

1 Right-click the @ Mirror icon on the Windows
desktop and select Run as administrator to open
Mirror software in Administrator mode.

2 Select Options »
4~ Set Database Options...

from the top menu tabs.
Set Program Options...

Set Database Opticns... 2
Set Tool Options...
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Appendix C

Data Back-up

3 In the Database List tab, select the desired database
and click the Backup button.

Database Options - User

,. Databass List | Hair Database List i Field Formats | Options | Authorization I

C:\Program Data'\Carfield\Databases\MimorDatabase',

MimorDatabase:

Restore I

Database to be opened at program start
(M\rrorDatabase C:\ProgramDataCanfield"Databases  MimorDatabase®, C\ProgramData\Canfie]  Scheduler
Set Startup Database I
Create Database.. | Destroy Database ... | Convert to SEL |

Mirror’s utility proceeds to back up the Mirror database
to an easy-to-access location on your local drive.

Mirror Professional

Database ‘MirrorDatabase’ backed up successfully to the following folder:

Please remember this is your data (patient/dient information) back up only,

'C:\ProgramData\Canfield\Databases\Badkup'

% 4 When the Mirror backup
process is finished, a
dialog box provides the

— paths to database backup

your patient images need to be backed up separately. and image files locations

The location of the patient images are in the following fid/ Note the locations then
C:'ProgramData\Canfield\Databases\MirrorDatabase| ’

click OK.

o]

Default database backup and image file locations:

Database backup: C:\ProgramData\Canfield\Databases\Backup\

Image files: C:\ProgramData\Canfield\Databases\MirrorDatabase\

AN

5 Use your backup solution to copy the files from
both locations (database backup and image files) to
external backup storage. Include the directories and all
associated subdirectories.

IMPORTANT: The back up process is not complete until
the database backup and image files have been copied
to external backup storage. Make sure the image files
are copied in addition to the database backup.
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Appendix C Data Back-up

Method 2. Advanced back up plan: IT professional backs
up the data directly, without using Mirror’s backup utility.

The practice IT resource should be directed to include

the directories (and all associated subdirectories) listed

below as part of the established back up procedures or

as a separate, regularly scheduled procedure.

The default database and image file locations are:
Database: C:\Program Files\Microsoft SQL Server\MSSQL11.CANFIELD
Image files: C:\ProgramData\Canfield\Databases\MirrorDatabase\

To determine the location of the Mirror database and
Mirror image files, complete the following steps.

e 1 Rightclick the @ Mirror icon on the Windows

Opeay ke Bocalion / desktop and select Run as administrator to open

551 Mirror software in Administrator mode.
G Run as administrator

2 Select Options b Set Database Options... from the
top menu tabs.
@ Mirror-MirrorDatabase Mode: Administrator
File Capture Image View| Shape Draw Tools Options
wl -T; %l @ | Set Program Options...
Set Database Options...
Set Tool Options...

Set Systern Options...
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Appendix C Data Back-up

3 In the Database List tab, select the desired database
and click the Edit button.

Database Options - User

» Database List | Hair Database List I Field Formats | Options | Puthorization I

MimorDatabase C:\ProgramData\Carfield \Databases\MirorDatabase',

rDatabaseto be opened at program start ]

4 The Database Information dialog displays the name
of the server where the database is located. Find and
access the displayed se}'ver.

Database Information *
Database Type |SQL rver j

Database:

I MirrorDatabase

Server:

| DOMAINNAME\USERPC | | Reload servers |

5 Open File Explorer on this server and navigate to
C:\Program Files\Microsoft SQL Server\MSSQL11.CANFIELD
Select this directory to back up Mirror database files.

6 The Database Information dialog also displays the
directory path for the Mirror image files.

Server:

| DOMAINNAME\USERPC =] | Relnad Servers |

Path to jmage files:

Browse... |

[~ Share this database

Select this directory to back up Mirror image files.
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Appendix C Data Back-up

& IMPORTANT: Image files are crucial for complete
backup.

* Iftheimage data is stored on the network, that directory
location must also be included in the back-up process.

 If there more than one database, all operations above
should be performed for each database.

» If VECTRA was installed in client server configuration,
the backup process should include all machines where
VECTRA software is installed.
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Uploading 3D Images to MirrorMe3D

VECTRA 3D images can be uploaded directly to MirrorMe3D for printing color
3D models of the images. 3D images are uploaded using a secure FTP site.

To add this capability to your VECTRA software, please contact Canfield or your
Canfield representative.

1 Click to select the 3D image(s) you wish to upload for
3D printing. Shift-click to select multiple thumbnails, or
Ctrl-click to select multiple discontiguous thumbnails.

2 Click [ upload to 3D printing. (This button is only

\ Vectra Uploader — o x | available if a 3D image is selected.)
Form  Settngs 3 Complete the Vectra Uploader form. (Physician
et R and practice information is auto-filled for subsequent

Physicizn Name . . . .
hysiian Emai uploads until modified or removed. Patient ID is

Practie/Company required each time.)
patient >

- 4 Click OK. A bar is displayed as the i
— 1€ progress bar 1s displayed as elmage(s)

are uploaded to MirrorMe3D.

v “| 5 When the “Upload successful” message is displayed,
i ] “"'““5““““””"‘ﬁ“9“““”’””““"”’“"“&“/ click OK, Alt-Tab to bring your browser window to the
ok front, and log into the MirrorMe3D portal.
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Sculptor Software Tips

Keyboard and mouse shortcuts

Quickly change between preset views Right-click in a
viewport to open the rotate-to-view button set at the
point of click. These mimic the views in the top left
corner of the screen.

Undo Press Ctrl-Z on your keyboard to undo the most
recent action.

Change magnification by rotating the scroll wheel on
your mouse. To zoom in, move the wheel towards you.
To zoom out, move the wheel away from you.

Double-click zoom Double-clicking anywhere on an
image will zoom into that spot.

Temporarily change to the & Spin tool Press and
hold the Alt key on the keyboard while you click and
drag the image using the left button on the mouse.

Temporarily change to the g8 Pan tool Press and hold

the Alt key on the keyboard while you click and drag
the image using the right button on the mouse.
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Appendix E Sculptor Software Tips

Image viewing buttons at the top of the screen
(These buttons are context sensitive, not always available.)

Rotate the image around the Y (vertical) axis Click the
Y-spin tool to spin the image left and right while
maintaining the X and Z axes.

Auto-rotate the image around the Y (vertical) axis Click
the Auto-spin tool to spin the image from side to
side without using the mouse to drag.

Alternate shading modes ({CIEAED

a Natural photo mode (the default view). The
image retains all of its photographic detail for a
pleasing visual representation. Use to show skin
resurfacing procedures.

n Dynamic photo mode. The image is skin colored,
but with reduced detail. This helps to show
shape and anatomical features under raked
lighting.

To toggle NI Natural and [EJESS Enhanced

(Dynamic) mode, click the button in the lower left
corner of the screen.

Shape (gray) mode. This solid colored image
helps to visualize shape and volume changes
without the distraction of skin tones.
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Appendix E Sculptor Software Tips

View Results

Superimposed view mode

Q (Face Sculptor) or » (Breast/Body Sculptor)

View the pre-op image overlaid with a semi-transparent
simulated outcome. Click 9 (center, bottom of the
screen) to toggle between showing the pre-op or
simulated image opaque.

simulation only: actual surgical results will vary

preop

Morph view mode

@ (Face Sculptor) or “ (Breast/Body Sculptor)

View a single image with a slider for morphing between
the original image, the simulated outcome, or any point
in between.

To snap back and forth between the original image and
the simulated outcome, click the 9 toggle button to the
right of the slider.

To auto-animate the morph from original to simulated
outcome, click @@.

Combine the @ auto-animate morph and auto-spin
features to show the total simulation while continuing
the consultation discussion.
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Support Information

Technical support

Technical support is available at 1-800-815-4330. Hours
of support are from 6:00 a.m. EST to 8:00 p.m. EST
Monday-Friday.

Warranty/repair

A one-year warranty is provided on VECTRA parts.
Your warranty is automatically extended for one year
if you have purchased our annual support and upgrade
contract.

Should our technical support technicians determine
that a part must be returned for service, a Return
Merchandise Authorization number will be provided
to you. In addition, a replacement part and a shipping
carton will be mailed to you within two business days.
Information on packing and shipping will be included.

Our shipping address is: Canfield Scientific, Inc.
4 Wood Hollow Road
Parsippany, NJ 07054 USA

Canfield Scientific (US):
support@canfieldsci.com
+1-973-434-1201
+1-800-815-4330 (toll-free in US, Canada, Mexico)

Canfield Scientific (Europe):
support@canfieldsci.com

+49 (0) 521 329 8560
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